© 2019 Xerox Corporation. All rights reserved. Xerox®, Xerox and Design®, VersaLink®, FreeFlow®, SMARTsend®, Scan to PC Desktop®, MeterAssistant®, SuppliesAssistant®, Xerox Secure Access Unified ID System®, Xerox Extensible Interface Platform®, Global Print Driver®, and Mobile Express Driver® are trademarks of Xerox Corporation in the United States and / or other countries.
Adobe®, Adobe PDF logo, Adobe® Reader®, Adobe® Type Manager®, ATM™, Flash®, Macromedia®, Photoshop®, and PostScript® are trademarks or registered trademarks of Adobe Systems, Inc.
Apple®, Bonjour®, EtherTalk™, TrueType®, iPad®, iPhone®, iPod®, iPod touch®, AirPrint® and the AirPrint Logo®, Mac®, Mac OS®, and Macintosh® are trademarks or registered trademarks of Apple Inc. in the U.S. and other countries.
Google Cloud Print™ web printing service, Gmail™ webmail service, and Android™ mobile technology platform are trademarks of Google, Inc.
HP-GL®, HP-UX®, and PCL® are registered trademarks of Hewlett-Packard Corporation in the United States and/or other countries.
IBM® and AIX® are registered trademarks of International Business Machines Corporation in the United States and/or other countries.
McAfee®, ePolicy Orchestrator®, and McAfee ePO™ are trademarks or registered trademarks of McAfee, Inc. in the United States and other countries.
Microsoft®, Windows Vista®, Windows®, Windows Server®, and OneDrive® are registered trademarks of Microsoft Corporation in the United States and other countries.
Mopria is a trademark of the Mopria Alliance.
Novell®, NetWare®, NDPS®, NDS®, IPX™, and Novell Distributed Print Services™ are trademarks or registered trademarks of Novell, Inc. in the United States and other countries.
PANTONE® and other Pantone, Inc. trademarks are the property of Pantone, Inc.
SGI® and IRIX® are registered trademarks of Silicon Graphics International Corp. or its subsidiaries in the United States and/or other countries.
Sun, Sun Microsystems, and Solaris are trademarks or registered trademarks of Oracle and/or its affiliates in the United States and other countries.
UNIX® is a trademark in the United States and other countries, licensed exclusively through X/ Open Company Limited.
Wi-Fi CERTIFIED Wi-Fi Direct® is a trademark of the Wi-Fi Alliance.
Connecting to a Wireless Network ................................................................. 35
Initial Printer Setup ......................................................................................... 45
Configuring AirPrint ......................................................................................... 46
Configuring Google Cloud Print ................................................................. 46

Installing the Software ..................................................................................... 48
Operating System Requirements .................................................................. 48
Installing the Print Drivers for a Windows Network Printer ....................... 48
Installing the Print Drivers for a Windows USB Printer ......................... 49
Installing the Drivers and Utilities for Macintosh OS X ......................... 49
Installing Drivers and Utilities for UNIX and Linux .................................. 50
Installing the Printer as a Web Service on Devices ................................... 50

More Information ............................................................................................ 52

3 Customize and Personalize ........................................................................... 53

Customize and Personalize Overview ............................................................ 54
Customizing or Personalizing the Home Screen ........................................ 55
Hiding or Showing an App on the Home Screen ....................................... 55
Rearranging Apps on the Home Screen ....................................................... 55
Customizing or Personalizing the Apps ......................................................... 56
Customizing or Personalizing the Feature List .......................................... 56
Saving Presets................................................................................................. 56
Removing App Customization using the Control Panel ............................. 57

4 Xerox® Apps .................................................................................................. 59

Xerox® App Gallery ......................................................................................... 60
Xerox® App Gallery Overview ...................................................................... 60
Creating a Xerox® App Gallery Account .................................................. 60
Logging into your Xerox® App Gallery Account ........................................ 61
Installing or Updating an App from the Xerox® App Gallery .................. 61

Device .............................................................................................................. 63
Device Overview ............................................................................................. 63
About .............................................................................................................. 64
Supply Status ................................................................................................. 64
Billing and Usage Counters ......................................................................... 65
Reset to Factory Defaults ............................................................................. 66
Remote Services............................................................................................... 66

Jobs .................................................................................................................. 67
Jobs Overview ................................................................................................. 67
Managing Jobs ................................................................................................. 67
Managing Special Job Types ....................................................................... 68
Managing Jobs Using the Embedded Web Server ....................................... 70

USB ................................................................................................................. 72
USB Overview ................................................................................................. 72
Printing from a USB Flash Drive ................................................................. 72
Printing from a USB Flash Drive Already Inserted in the Printer ............. 73

@PrintByXerox ................................................................................................. 74

Xerox® VersaLink® C600 Color Printer
User Guide
@PrintByXerox Overview .................................................................................. 74
Printing with the @PrintByXerox App............................................................ 74

5 Printing............................................................................................................. 75

Printing Overview............................................................................................ 76
Selecting Printing Options................................................................................ 77
  Print Driver Help............................................................................................... 77
  Windows Printing Options .............................................................................. 77
  Macintosh Printing Options ........................................................................... 79
  UNIX and Linux Printing ............................................................................... 79
  Mobile Printing Options .............................................................................. 81
Printing Features............................................................................................... 83
  Viewing, Printing, or Deleting Jobs ............................................................... 83
  Printing Special Job Types .......................................................................... 83
  Selecting Paper Options for Printing ............................................................ 84
  Scaling............................................................................................................ 85
  Printing on Both Sides of the Paper .............................................................. 85
  Print Quality.................................................................................................. 86
  Image Options ............................................................................................... 86
  Image Shift .................................................................................................... 86
  Color Adjustments ......................................................................................... 86
  Printing Mirror Images ............................................................................... 87
  Printing Multiple Pages to a Single Sheet ................................................... 87
  Printing Booklets ......................................................................................... 88
  Selecting Finisher Options .......................................................................... 88
  Selecting Mailbox Options ......................................................................... 89
  Using Special Pages .................................................................................... 89
  Printing Watermarks for Windows ............................................................... 90
  Orientation .................................................................................................... 91
  Printing Banner Pages ................................................................................. 92
  Selecting Job Completion Notification for Windows .................................. 92
Using Custom Paper Sizes............................................................................... 93
  Printing on Custom Paper Sizes ................................................................. 93
  Defining Custom Paper Sizes ..................................................................... 93

6 Paper and Media ............................................................................................ 95

Paper and Media Overview.............................................................................. 96
Supported Paper ............................................................................................... 97
  Recommended Media .................................................................................... 97
  Ordering Paper .............................................................................................. 97
  General Paper Loading Guidelines ............................................................ 97
  Paper That Can Damage Your Printer ........................................................ 97
  Paper Storage Guidelines .......................................................................... 98
  Supported Paper Types and Weights ............................................................ 98
  Supported Paper Types and Weights for Automatic 2-Sided Printing .......... 99
  Supported Standard Paper Sizes ................................................................. 99
  Supported Standard Paper Sizes for Automatic 2-Sided Printing .............. 100
A Specifications ................................................................. 175

Configurations and Options ........................................ 176
   Available Configurations ........................................ 176
   Standard Features .................................................. 176
   Options and Upgrades ............................................ 177

Physical Specifications .................................................. 178
   Weights and Dimensions ........................................ 178
   Standard Configuration ......................................... 178
   Configuration with Optional Finisher ....................... 178
   Configuration with Optional 4-Bin Mailbox .................. 179
   Height Measurements for Configurations ................. 179
   Total Space Requirements without Options ............... 182
   Clearance Requirements ..................................... 182

Environmental Specifications ....................................... 185
   Temperature ......................................................... 185
   Relative Humidity ............................................... 185
   Elevation ............................................................ 185

Electrical Specifications ............................................. 186
   Power Supply Voltage and Frequency ....................... 186
   Power Consumption .............................................. 186

Performance Specifications ......................................... 187
   Print Speed .......................................................... 187

B Regulatory Information ............................................... 189

Basic Regulations ...................................................... 190
   United States FCC Regulations .................................. 190
   Canada ..................................................................... 190

Paper Tray Will Not Close ........................................... 152
Condensation Has Formed Inside the Printer .................. 152

Paper Jams ................................................................. 153
   Locating Paper Jams ............................................... 153
   Minimizing Paper Jams ......................................... 153
   Clearing Paper Jams .............................................. 155
   Troubleshooting Paper Jams .................................... 162

Print-Quality Problems ............................................... 165
   Controlling Print Quality ....................................... 165
   Paper and Media .................................................... 165
   Solving Print-Quality Problems ................................ 166

Getting Help ............................................................ 172
   Viewing Warning Messages on the Control Panel ....... 172
   Viewing Current Errors on the Control Panel ........... 172
   Using the Integrated Troubleshooting Tools .............. 172
   Online Support Assistant ...................................... 172
   Helpful Information Pages ...................................... 172
   More Information about Your Printer ....................... 173
Safety

This chapter contains:

- **Notices and Safety** ................................................................. 10
- **Electrical Safety** .................................................................. 11
- **Operational Safety** .............................................................. 13
- **Maintenance Safety** ............................................................ 15
- **Printer Symbols** ................................................................. 16
- **Environmental, Health and Safety Contact Information** ............. 18

Your printer and the recommended supplies have been designed and tested to meet strict safety requirements. Attention to the following information ensures the continued safe operation of your Xerox printer.
Notices and Safety

Read the following instructions carefully before operating your printer. Refer to these instructions to ensure the continued safe operation of your printer. Your Xerox® printer and supplies are designed and tested to meet strict safety requirements. These include safety agency evaluation and certification, and compliance with electromagnetic regulations and established environmental standards.

The safety and environment testing and performance of this product have been verified using Xerox® materials only.

Note: Unauthorized alterations, which can include the addition of new functions or connection of external devices, can affect the product certification. For more information, contact your Xerox representative.
Electrical Safety

General Guidelines

**WARNING:**

- Do not push objects into slots or openings on the printer. Touching a voltage point or shorting out a part could result in fire or electric shock.
- Do not remove the covers or guards that are fastened with screws unless you are installing optional equipment and are instructed to do so. Power off the printer when performing these installations. Disconnect the power cord when removing covers and guards for installing optional equipment. Except for user-installable options, there are no parts that you can maintain or service behind these covers.

The following are hazards to your safety:

- The power cord is damaged or frayed.
- Liquid is spilled into the printer.
- The printer is exposed to water.
- The printer emits smoke, or the surface is unusually hot.
- The printer emits unusual noise or odors.
- The printer causes a circuit breaker, fuse, or other safety device to activate.

If any of these conditions occur, do the following:

1. Power off the printer immediately.
2. Disconnect the power cord from the electrical outlet.
3. Call an authorized service representative.

Power Cord

Use the power cord supplied with your printer.

- Plug the power cord directly into a properly grounded electrical outlet. Ensure that each end of the cord is connected securely. If you do not know if an outlet is grounded, ask an electrician to check the outlet.

**WARNING:** To avoid risk of fire or electrical shock, do not use extension cords, power strips, or power plugs for more than 90 days. When a permanent outlet receptacle cannot be installed, use only one factory-assembled extension cord of the appropriate gauge for each printer or multifunction printer. Always adhere to national and local building, fire, and electrical codes regarding length of cord, conductor size, grounding, and protection.

- Do not use a ground adapter plug to connect the printer to an electrical outlet that does not have a ground connection terminal.
- Verify that the printer is plugged into an outlet that is providing the correct voltage and power. Review the electrical specification of the printer with an electrician if necessary.
- Do not place the printer in an area where people can step on the power cord.
Safety

- Do not place objects on the power cord.
- Do not plug or unplug the power cord while the power switch is in the On position.
- If the power cord becomes frayed or worn, replace it.
- To avoid electrical shock and damage to the cord, grasp the plug when unplugging the power cord.

The power cord is attached to the printer as a plug-in device on the back of the printer. If it is necessary to disconnect all electrical power from the printer, disconnect the power cord from the electrical outlet.

Emergency Power Off

If any of the following conditions occur, power off the printer immediately and disconnect the power cord from the electrical outlet. Contact an authorized Xerox service representative to correct the problem if:

- The equipment emits unusual odors or makes unusual noises.
- The power cable is damaged or frayed.
- A wall panel circuit breaker, fuse, or other safety device has been tripped.
- Liquid is spilled into the printer.
- The printer is exposed to water.
- Any part of the printer is damaged.
Operational Safety

Your printer and supplies were designed and tested to meet strict safety requirements. These include safety agency examination, approval, and compliance with established environmental standards. Your attention to the following safety guidelines helps to ensure the continued, safe operation of your printer.

Operational Guidelines

- Do not remove any trays when the printer is printing.
- Do not open the doors when the printer is printing.
- Do not move the printer when it is printing.
- Keep hands, hair, neckties, and so on, away from the exit and feed rollers.
- Covers, which require tools for removal, protect the hazard areas within the printer. Do not remove the protective covers.
- Do not override any electrical or mechanical interlock devices.
- Do not attempt to remove paper that is jammed deeply inside the printer. Switch off the printer promptly and contact your local Xerox representative.

**WARNING:**

- The metallic surfaces in the fuser area are hot. Always use caution when removing paper jams from this area and avoid touching any metallic surfaces.
- To avoid a tip hazard, do not push or move the device with all the paper trays extended.

Ozone Release

This printer produces ozone during normal operation. The amount of ozone produced is dependent on copy volume. Ozone is heavier than air and is not produced in amounts large enough to harm anyone. Install the printer in a well-ventilated room.

For more information in the United States and Canada, go to www.xerox.com/environment. In other markets, please contact your local Xerox representative or go to www.xerox.com/environment_europe.

Printer Location

- Place the printer on a level, solid, non-vibrating surface with adequate strength to hold its weight. To find the weight for your printer configuration, refer to Physical Specifications.
- Do not block or cover the slots or openings on the printer. These openings are provided for ventilation and to prevent overheating of the printer.
- Place the printer in an area where there is adequate space for operation and servicing.
- Place the printer in a dust-free area.
- Do not store or operate the printer in an extremely hot, cold, or humid environment.
- Do not place the printer near a heat source.
- Do not place the printer in direct sunlight to avoid exposure to light-sensitive components.
Safety

- Do not place the printer where it is directly exposed to the cold air flow from an air conditioning system.
- Do not place the printer in locations susceptible to vibrations.
- For optimum performance, use the printer at the elevations specified in Elevation.

Printer Supplies

- Use the supplies designed for your printer. The use of unsuitable materials can cause poor performance and a possible safety hazard.
- Follow all warnings and instructions marked on, or supplied with, the product, options, and supplies.
- Store all consumables in accordance with the instructions given on the package or container.
- Keep all consumables away from the reach of children.
- Never throw toner, toner cartridges, drum cartridges, or waste cartridges into an open flame.
- When handling cartridges, for example toner and such, avoid skin or eye contact. Eye contact can cause irritation and inflammation. Do not attempt to disassemble the cartridge, which can increase the risk of skin or eye contact.

⚠️ **Caution:** Use of non-Xerox supplies is not recommended. The Xerox Warranty, Service Agreement, and Total Satisfaction Guarantee do not cover damage, malfunction, or degradation of performance caused by use of non-Xerox supplies, or the use of Xerox supplies not specified for this printer. The Total Satisfaction Guarantee is available in the United States and Canada. Coverage could vary outside these areas. Please contact your Xerox representative for details.
Maintenance Safety

- Do not attempt any maintenance procedure that is not specifically described in the documentation supplied with your printer.
- Clean with a dry lint-free cloth only.
- Do not burn any consumables or routine maintenance items. For information on Xerox® supplies recycling programs, go to www.xerox.com/gwa.

**WARNING:** Do not use aerosol cleaners. Aerosol cleaners can cause explosions or fires when used on electromechanical equipment.

When installing the device in a hallway or similar restricted area, additional space requirements can apply. Ensure that you comply with all workspace safety regulations, building codes, and fire codes for your area.
## Printer Symbols

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Warning Symbol" /></td>
<td>Warning: Indicates a serious hazard that can result in death or serious injury if not avoided.</td>
</tr>
<tr>
<td><img src="image" alt="Hot Warning Symbol" /></td>
<td>Hot Warning: Hot surface on or in the printer. Use caution to avoid personal injury.</td>
</tr>
<tr>
<td><img src="image" alt="Warning Symbol" /></td>
<td>Warning: Wait for the printer to cool for the specified time before touching the fuser.</td>
</tr>
<tr>
<td><img src="image" alt="Caution Symbol" /></td>
<td>Caution: Indicates a mandatory action to take in order to avoid damage to the property.</td>
</tr>
<tr>
<td><img src="image" alt="Caution Symbol" /></td>
<td>Caution: To avoid damage to the property, be careful not to spill toner when handling the waste cartridge.</td>
</tr>
<tr>
<td><img src="image" alt="Do not touch Symbol" /></td>
<td>Do not touch the part or area of the printer.</td>
</tr>
<tr>
<td><img src="image" alt="Do not touch Symbol" /></td>
<td>Do not touch.</td>
</tr>
<tr>
<td><img src="image" alt="Do not expose Symbol" /></td>
<td>Do not expose the drum cartridges to direct sunlight.</td>
</tr>
<tr>
<td><img src="image" alt="Do not burn Symbol" /></td>
<td>Do not burn the toner cartridges.</td>
</tr>
<tr>
<td><img src="image" alt="Do not burn Symbol" /></td>
<td>Do not burn the waste cartridge.</td>
</tr>
<tr>
<td>Symbol</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td><img src="https://via.placeholder.com/150" alt="Image" /></td>
<td>Do not burn the drum cartridges.</td>
</tr>
<tr>
<td><img src="https://via.placeholder.com/150" alt="Image" /></td>
<td>Do not use folded, creased, curled, or wrinkled paper.</td>
</tr>
<tr>
<td><img src="https://via.placeholder.com/150" alt="Image" /></td>
<td>Do not use inkjet paper.</td>
</tr>
<tr>
<td><img src="https://via.placeholder.com/150" alt="Image" /></td>
<td>Do not use transparencies or overhead projector sheets.</td>
</tr>
<tr>
<td><img src="https://via.placeholder.com/150" alt="Image" /></td>
<td>Do not reload paper previously printed on or used.</td>
</tr>
</tbody>
</table>

For details about all the printer symbols that appear on your printer, refer to the *Printer Symbols* guide at [www.xerox.com/office/VLC600docs](http://www.xerox.com/office/VLC600docs).
Environmental, Health and Safety Contact Information

For more information on Environment, Health, and Safety in relation to this Xerox product and supplies, contact:

- United States and Canada: 1-800-ASK-XEROX (1-800-275-9376)
- Europe: EHS-Europe@xerox.com

For product safety information in the United States and Canada, go to www.xerox.com/environment. For product safety information in Europe, go to www.xerox.com/environment_europe.
Getting Started

This chapter contains:

- Parts of the Printer .......................................................... 20
- Power Options .................................................................... 24
- Accessing the Printer ......................................................... 26
- Introduction to Apps .......................................................... 27
- Information Pages ............................................................ 28
- The Embedded Web Server ............................................... 30
- Installation and Setup ....................................................... 33
- Connecting the Printer ...................................................... 34
- Installing the Software ..................................................... 48
- More Information ............................................................ 52
Parts of the Printer

Front View

1. Tray 2, Optional 550-Sheet Feeder
2. Tray 1
3. Bypass Tray
4. Front Door
5. Power/Wake Button
6. Control Panel
7. Output Tray
8. Output Tray Extension
9. Right-Side Door

Internal Parts

1. Front Door
2. Toner Cartridges
3. Transfer Belt
4. Drum Cartridges
5. Waste Cartridge
6. Cleaning Rod
7. Right-Side Door
Rear View

1. Transfer Roller
2. Fuser
3. Rear Door
4. Wireless Network Adapter Port Cover
5. Left-Side Cover, Access to optional Productivity Kit
6. USB Port Type A
7. USB Port Type A
8. Ethernet Connection
9. FDI Port
10. Power Connector

Options

Finisher
Mailbox

Control Panel

The control panel consists of a touch screen and buttons you press to control the functions available on the printer. The control panel:
• Displays the current operating status of the printer.
• Provides access to printing features.
• Provides access to reference materials.
• Provides access to Tools and Setup menus.
• Prompts you to load paper, replace supplies, and clear jams.
• Displays errors and warnings.
• Provides the Power/Wake button used for powering on or powering off the printer. This button also supports the power-saver modes, and blinks to indicate the power status of the printer.

<table>
<thead>
<tr>
<th>Item</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>NFC Area</td>
<td>Near Field Communication (NFC) is a technology that enables devices to communicate when they are within 10 cm (4 in.) of each other. Use the NFC area to obtain a network interface or to establish a TCP/IP connection between your device and the printer.</td>
</tr>
<tr>
<td>2</td>
<td>Touch Screen Display</td>
<td>This area of the screen displays information and provides access to printer functions and applications.</td>
</tr>
<tr>
<td>3</td>
<td>Administrator Logon</td>
<td>This is the location where the system administrator can log in using the system administrator password.</td>
</tr>
<tr>
<td>4</td>
<td>Home Button</td>
<td>This button provides access to the Home menu for access to printer features.</td>
</tr>
</tbody>
</table>
### Power/Wake

This button serves several power-related functions.

- When the printer is off, this button powers on the printer.
- When the printer is on, pressing this button displays a menu on the control panel. From this menu, you can choose to enter Sleep mode, restart, or power off the printer.
- When the printer is on, but in a low-power or Sleep mode, pressing this button wakes the printer.
- When the printer is powered on, holding this button for 5 seconds powers off the printer.

This button also blinks to indicate the power status of the printer.

- When the light blinks slowly, the printer is in Low Power or Sleep mode.
- When the light blinks fast, the printer is powering down, or exiting a low-power mode.

### Status LED

This light blinks blue or amber to indicate printer status.

- **Blue**
  - Blinks once slowly to acknowledge a successful Authentication request.
  - Blinks once slowly for a Copy or Print job initiated at the control panel.
  - Blinks twice slowly for Fax or Print job received from the network.
  - Blinks fast while the printer is powering up, or to signal detection of a Wi-Fi Direct connection request.

- **Amber**
  - Blinks to indicate an error condition or warning that requires your attention. For example, an out-of-toner condition, a paper jam, or out of paper for the current job.
  - The printer status LED also blinks amber to indicate a system error, which typically is associated with an error code.
Power Options

The Power/Wake button is a single multifunction button on the control panel.

- The Power/Wake button powers on the printer.
- If the printer is already powered on, the Power/Wake button can be used to:
  - Restart the printer
  - Enter or exit Sleep mode
  - Enter or exit Low-Power mode
- The Power/Wake button also flashes when the printer is in low-power mode.

Powering On the Printer or Exiting Low-Power or Sleep Mode

To power on the printer, or to exit Low-Power mode or Sleep mode, press the Power/Wake button.

Note:

- The Power/Wake button is the only power button on the printer.
- The printer exits Low-Power mode or Sleep mode automatically when it receives data from a connected device.
- When in Low-Power mode, or Sleep mode, the touch screen is powered off and unresponsive. To wake the printer manually, press the Power/Wake button.

Caution: Do not plug or unplug the power cord while the printer is powered on.
Restarting, Placing in Sleep Mode, or Powering Off the Printer

At the printer control panel, press the Power/Wake button.

1. To restart the printer, place the printer in Sleep Mode, or power off the printer.

2. Select an option.
   - To restart the printer, touch Restart.
   - To place the printer in Sleep Mode, touch Sleep.
     In Sleep Mode, the touch screen goes dark and the Power/Wake button flashes.
   - To power off the printer, touch Power Off.
   - If the printer does not respond to a single press of the Power/Wake button, then press and hold the button for 5 seconds. A Please Wait message appears as the printer powers down. After 10 seconds, the touch screen goes dark and the Power/Wake button flashes until the printer powers down.

⚠️ Caution: Do not unplug the power cord while the printer powers down.
Accessing the Printer

Logging In

Logging in is the process by which you identify yourself to the printer for authentication. If authentication is set, to access printer features, you log in with your user credentials.

Logging In at the Control Panel

1. At the printer control panel, press the **Home** button.
2. Touch **Log In**.
3. Type the User Name using the keypad, then touch **Enter**.
4. If prompted, enter the password, then touch **Enter**.

   **Note:** For more information on logging in as system administrator, refer to the *System Administrator Guide* at [www.xerox.com/office/VLC600docs](http://www.xerox.com/office/VLC600docs).

5. Touch **OK**.

   **Note:** To access each password-protected service, enter the User Name and password.

Smart Card

When a Common Access Card system is installed on your Xerox device, access to the printer requires the use of a Smart Card. There are several models of card readers that are compatible with your device. To access the printer, insert the pre-programmed identification card into the reader, or place your card on the reader. If extra security credentials are required, enter the login information at the control panel.

For more information about configuring a Common Access Card system on your device, refer to the *Xerox® VersaLink® Common Access Card System Configuration Guide* at [www.xerox.com/office/VLC600docs](http://www.xerox.com/office/VLC600docs).
Introduction to Apps

Xerox Apps are a gateway to the features and functions of your device. Standard Apps are already installed on the device and appear on the Home screen. Some Apps are installed as standard, but hidden the first time you use the device. When you log in, the Apps configured for your personal account appear on the control panel. You can download more Apps for your device from the Xerox® App Gallery. For more information, refer to Xerox® App Gallery.
Your printer has a set of Information Pages that you can print. These pages include configuration and font information, demonstration pages, and more.

The following Information Pages are available:

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuration Report</td>
<td>The Configuration Report provides printer information including installed options, network settings, port setup, tray information, and more.</td>
</tr>
<tr>
<td>Billing Summary Report</td>
<td>The Billing Summary Report provides information about the device and a detailed listing of the billing meters and sheet counts.</td>
</tr>
<tr>
<td>Supplies Usage Report</td>
<td>The Supplies Usage Report provides coverage information and part numbers for reordering supplies.</td>
</tr>
<tr>
<td>PostScript Font List</td>
<td>The PostScript Font List provides a printout of all PostScript fonts that are available on the printer.</td>
</tr>
<tr>
<td>PCL Font List</td>
<td>The PCL Font List provides a printout of all PCL fonts that are available on the printer.</td>
</tr>
<tr>
<td>Demonstration Print</td>
<td>Demonstration Print provides a demonstration of the current print-quality settings.</td>
</tr>
<tr>
<td>Startup Page</td>
<td>The Startup Page provides basic printer configuration and network information.</td>
</tr>
<tr>
<td>Job History Report</td>
<td>The Job History Report provides retained information on previous print jobs, including the date, time, job type, document name, output color, paper size, number of pages, and results. The status of a maximum of 20 jobs prints on the Job History Report.</td>
</tr>
</tbody>
</table>

Printing Information Pages

1. At the printer control panel, press the Home button.
2. Touch Device → About → Information Pages.
3. To print an information page, touch the needed page.
4. To return to the Home screen, press the Home button.
Configuration Report

The Configuration Report provides product information including installed options, network settings, port setup, tray information, and more.

Printing the Configuration Report

1. At the printer control panel, press the **Home** button.
2. Touch **Device** → **About** → **Information Pages**.
3. Touch **Configuration Report**.
4. To return to the Home screen, press the **Home** button.
The Embedded Web Server

The Embedded Web Server is the administration and configuration software that is installed in the printer. It allows you to configure and administer the printer from a Web browser. The Embedded Web Server requires:

- A TCP/IP connection between the printer and the network in Windows, Macintosh, UNIX, or Linux environments.
- TCP/IP and HTTP enabled in the printer.
- A network-connected computer with a Web browser that supports JavaScript.

Accessing the Embedded Web Server

At your computer, open a Web browser. In the address field, type the IP address of the printer, then press Enter or Return.

Finding the IP Address of Your Printer

To install the print driver for a network-connected printer, it is often necessary to know the IP address of your printer. Also, the IP address is used to access the settings of your printer through the Embedded Web Server. You can view the IP address of your printer on the control panel or on the Configuration Report.

Note: To view the TCP/IP address on the control panel, wait until the printer has been on for 2 minutes. If the TCP/IP address is 0.0.0.0, or begins with 169, it indicates a network connectivity issue. However, if Wi-Fi is set as the primary Ethernet connection, 0.0.0.0 is displayed as the IP address for the printer.

Viewing the IP Printer Address on the Control Panel

To view the IP address of the printer on the control panel:

1. At the printer control panel, press the Home button.
2. Touch Device → About.
3. Record the IP address from the display.
4. To return to the Home screen, press the Home button.

Obtaining the Printer IP Address from the Configuration Report

To obtain the printer IP address from the Configuration Report:

1. At the printer control panel, press the Home button.
2. Touch Device → About → Information Pages.
   The IP address appears in the Connectivity section of the Configuration Report for IPv4 or IPv6.
4. To return to the Home screen, press the Home button.
Certificates for the Embedded Web Server

Your device includes a self-signed HTTPS certificate. The device generates the certificate automatically during device installation. The HTTPS certificate is used to encrypt communications between your computer and the Xerox device.

Note:

- The Embedded Web Server page for your Xerox device can display an error message that the security certificate is not trusted. This configuration does not lessen the security of the communications between your computer and the Xerox device.

- To eliminate the connection warning in your Web browser, you can replace the self-signed certificate with a signed certificate from a Certificate Authority. For information on obtaining a certificate from a Certificate Authority, contact your Internet Service Provider.

For information on obtaining, installing, and enabling certificates, refer to the System Administrator Guide at www.xerox.com/office/VLC600docs.

Downloading the Configuration Report from the Embedded Web Server

From the Embedded Web Server, you can download and save a copy of the Configuration Report to your computer hard drive. Use Configuration Reports from multiple devices to compare software versions, configurations, and compliance information.

To download a copy of the Configuration Report from the Embedded Web Server:

1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then press Enter or Return.

   Note: For details about obtaining the IP address of your printer, refer to Finding the IP Address of Your Printer.

2. To download the Configuration Report scroll to the bottom of the page, then, in the Quick Links section, click Download Configuration Report.

   Note: If this feature does not appear, log in as a system administrator.

The document is saved automatically as an XML file in the default download location on your computer hard drive. To open the Configuration Report, use an XML viewer.
Using the Remote Control Panel Feature

The Remote Control Panel feature in the Embedded Web Server allows you to access the printer control panel remotely from a Web browser.

Note: To access the Remote Control Panel, first enable the feature. For details, contact your system administrator or refer to the System Administrator Guide at www.xerox.com/office/VLC600docs.

To access the Remote Control Panel feature:

1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then press Enter or Return.

   Note: For details about obtaining the IP address of your printer, refer to Finding the IP Address of Your Printer.

2. In the Quick Links area, click Remote Control Panel.

   Note: If the Remote Control Panel option is not displayed or fails to load, contact your system administrator.

3. To restrict other users from accessing the device control panel when you are connected remotely to the device, click the Lock Device Control Panel option.

   Note: If a local user attempts to access the control panel while the device control panel is locked, the control panel does not respond. A message appears on the control panel, confirming that the control panel is locked and the device is being controlled remotely.

4. To enable remote access to the device control panel, click Request Session. The remote control panel sends a request to the local control panel.

   - If the local control panel is inactive, the remote control panel session is activated automatically.
   - If a local user is active on the device, a Remote Session Request message appears on the local control panel. The local user chooses to accept or deny the request. If the request is accepted, the remote control panel session is activated. If the request is denied, a Request Denied message appears in the Embedded Web Server.

   Note: If the system administrator requests a remote session, if the request is denied, an option to override the local session is displayed.
Installation and Setup

For reference:
- **Installation Guide** packaged with your printer
- Online Support Assistant at [www.xerox.com/office/VLC600docs](http://www.xerox.com/office/VLC600docs)

Installation and Setup Overview

Before you print, ensure that your computer and the printer are plugged in, powered on, and connected. Configure the initial settings of the printer, then install the print driver software and utilities on your computer.

You can connect to your printer directly from your computer using USB, or connect to a network using an Ethernet cable or wireless connection. Hardware and cabling requirements vary for the different connection methods. Routers, network hubs and switches, modems, Ethernet cables, and USB cables are not included with your printer and must be purchased separately. Xerox recommends an Ethernet connection because it is typically faster than a USB connection, and it provides access to the Embedded Web Server.

For more information, refer to the *[System Administrator Guide](http://www.xerox.com/office/VLC600docs)*.

Selecting a Location for the Printer

1. Select a dust-free area with temperatures from 10–32°C (50–90°F), and relative humidity 10–85%.

   **Note:** Sudden temperature fluctuations can affect print quality. Rapid heating of a cold room can cause condensation inside the printer, directly interfering with image transfer.

2. Place the printer on a level, solid, non-vibrating surface with adequate strength to hold the weight of the printer. The printer must be horizontal with all four feet in solid contact with the surface. To find the weight for your printer configuration, refer to *[Weights and Dimensions](http://www.xerox.com/office/VLC600docs)*.

3. Select a location with adequate clearance to access supplies and to provide proper ventilation. To find the clearance requirements for your printer, refer to *[Clearance Requirements](http://www.xerox.com/office/VLC600docs)*.

4. After positioning the printer, you are ready to connect it to the power source and computer or network.

Opening the Output Tray Extension

To provide better support for your prints, open the Output Tray Extension. For printing on longer paper, lengthen the Output Tray Extension by pulling out the extender until it stops.
Connecting the Printer

Selecting a Connection Method

You can connect the printer to your computer using a USB cable, Ethernet cable, or wireless connection. The method that you select depends on how your computer is connected to the network. A USB connection is a direct connection and is the easiest to set up. An Ethernet connection is used to connect to a network. If you are using a network connection, it is important to understand how your computer is connected to the network.

Note: Hardware and cabling requirements vary for the different connection methods. Routers, network hubs, network switches, modems, Ethernet cables, and USB cables are not included with your printer and must be purchased separately.

USB

If you connect the printer to one computer and do not have a network, use a USB connection. A USB connection offers fast data speeds, but typically not as fast as a network connection.

Note: To access the Embedded Web Server, a network connection is required.

Network

If your computer is connected to an office network or home network, use an Ethernet cable to connect the printer to the network. You cannot connect the printer directly to the computer. A connection through a router or network switch is required. An Ethernet network can be used for one or more computers and supports many printers and systems simultaneously. An Ethernet connection is typically faster than USB and allows you direct access to the settings of the printer using the Embedded Web Server.

Wireless Network

If your environment includes a wireless router or wireless access point, you can connect the printer to the network with a wireless connection. A wireless network connection provides the same access and services as a wired connection. A wireless network connection is typically faster than USB and allows direct access to the settings of the printer using the Embedded Web Server.

Connecting to a Computer Using USB

To connect using USB, you need one of these operating systems:

- Macintosh OS X version 10.10 and later.
- UNIX and Linux: Your printer supports connection to various UNIX platforms through the network interface.

To connect the printer to the computer using a USB cable:

1. Connect the B end of a standard A/B USB 2.0 or USB 3.0 cable to the USB Port on the back of the printer.
2. Connect the A end of the USB cable to the USB port on the computer.
3. If the Windows Found New Hardware Wizard appears, press Cancel.
4. Install the print driver.

**Connecting to a Wired Network**

1. Ensure that the printer is powered off.
2. Attach a Category 5 or better Ethernet cable from the printer to the network or router socket. Use an Ethernet switch or router, and two or more Ethernet cables. Connect the computer to the switch or router with one cable, then connect the printer to the switch or router with the second cable. Connect to any port on the switch or router except the uplink port.
3. Attach the power cord, then plug in the printer and power it on.
4. Set the network IP printer address, or set up the printer for automatic printer IP detection. For more information, refer to the System Administrator Guide at www.xerox.com/office/VLC600support.

**Connecting to a Wireless Network**

A wireless local area network (WLAN) provides the means to connect 2 or more devices in a LAN without a physical connection. The printer can connect to a wireless LAN that includes a wireless router or wireless access point. Before connecting the printer to a wireless network, the wireless router must be configured with a service set identifier (SSID) and any necessary credentials.

- **Note:** Wireless networking is available only on printers with the optional Wireless Network Adapter installed.

**Configuring the Printer for a Wireless Network**

- **Note:** Before you configure wireless network settings, install the Xerox® Wireless Network Adapter Kit.

If you purchased and installed a Wireless Network Adapter Kit, you can connect the device to a wireless network. If the device is connected to a wired network, you can configure wireless networking at the device, or use the Embedded Web Server. For details on configuring wireless network settings, refer to the System Administrator Guide at www.xerox.com/office/VLC600docs.

- **Note:** After the Wireless Network Adapter is installed, remove it only as necessary. For information on removing the adapter, refer to Removing the Wireless Network Adapter.
Installing the Wireless Network Adapter

The optional Wireless Network Adapter plugs in to the back of the printer. After the adapter is installed, and wireless networking is enabled and configured, the adapter is able to connect to a wireless network.

To install the Wireless Network Adapter:

1. Power off the printer.

2. To remove the Wireless Network Adapter Port Cover, press down on the latch, then pull the cover away from the printer.

3. Remove the packaging from the Wireless Network Adapter.

4. To install the Wireless Network Adapter, follow the procedure defined on the instruction sheet provided with the Wireless Network Adapter.

   **Note:** Pulling on the adapter can damage it. Once installed, remove it only as needed, and as directed in the Wireless Network Adapter removal instructions.
5. Power on the printer.

6. Configure the Wi-Fi Settings from the front panel or through the embedded web server if the printer is connected via ethernet. For more information, refer to Resetting Wireless Settings.

Removing the Wireless Network Adapter

1. Power off the printer.

2. To unlatch the left-side cover, slide the handle away from the printer, then swing the handle toward the rear of the printer.
Getting Started

3. To remove the cover, slide it toward the back, then away from the printer.

4. Reach into the printer and push the release lever toward the front of the printer. Hold the release lever in this position and gently pull the Wireless Network Adapter away from the printer.

   ![Diagram of cover removal]

   **Note:** Do not use force to pull on the Wireless Network Adapter. If the latch is released properly, the adapter pulls out easily. Pulling on a secured adapter can damage it.

5. To reinstall the Wireless Network Adapter Port Cover, insert the bottom tab into the small slot. Gently press the port cover against the back of the printer until it latches into place.

   ![Diagram of port cover reinstallation]
6. Place the left-side cover into place, then slide it toward the front of the printer.

7. To latch the cover, swing the handle toward the front of the printer, then push the handle in until it clicks into the locked position.
8. Connect the printer to your computer with a USB cable or to a network using an Ethernet cable.


Connecting to a Wi-Fi Network at the Control Panel

To connect to a Wi-Fi network at the control panel:

1. At the printer control panel, press the **Home** button.

2. Log in as administrator. For details, refer to the **System Administrator Guide** at www.xerox.com/office/VLC600docs.

3. Touch **Device → Connectivity → Wi-Fi**.

4. To enable the Wi-Fi feature, touch the enable toggle button.

5. To connect automatically to an existing Wi-Fi network:
   a. In the list of available Wi-Fi networks, touch the required network.
      
      **Note:** If the required Wi-Fi network is not listed, or if the required network uses WPS, configure the connection manually. For details, refer to step 6.
   b. If needed, to log in to the network, type the password.
   c. To select a Wi-Fi frequency band, touch **Wi-Fi Band**, then select an option.
      
      **Note:** The Wi-Fi frequency band is set to AUTO by default.
   d. Touch **OK**.

6. To connect manually to a Wi-Fi Network:
a. Touch **Manual Setup**.
b. In the first field, type a name for the Wi-Fi network, then touch **Enter**.
c. Touch **Network Type**, then select an option.
d. Touch **Security**, then select an option.
e. Touch **Wi-Fi Protected Setup (WPS)**, then select an option.

   - **Note:** For a WPS setup with a Push Button Connection (PBC), select **PBC**.
f. Touch **OK**.

### Configuring the Primary Network at the Control Panel

You can set the primary network connection type at the device control panel.

- **Note:**
  - A Primary Network setup is required only if the optional Wi-Fi network connection kit is installed and enabled.
  - By default, without a Wi-Fi network connection, the primary network is set to Ethernet. When the kit is installed and enabled, the device acquires two network connections. One network connection is primary, and the other network connection is secondary.
  - The following features are available only over the primary network connection:
    - IPsec
    - SMTP
    - SNTP
    - WSD scan
    - Scan to SFTP, Scan to SMB, Scan to Email
    - LDAP
    - UPnP discovery
    - ThinPrint
    - EIP Web Service
  - If you remove the Wi-Fi network connection module, the primary network connection is set to Ethernet.

To configure the primary network at the control panel:

1. At the printer control panel, press the **Home** button.
3. Touch **Device → Connectivity → Primary Network**.
4. Select the appropriate network connection type for the device.
5. To apply the changes and restart the device, at the prompt, touch **Restart Now**.
Resetting Wireless Settings

If the printer was previously installed in a wireless network environment, it could retain setup and configuration information. To prevent the printer from attempting to connect to the previous network, reset the wireless settings.

To reset the wireless settings:

1. At the printer control panel, press the Home button.
2. Touch Device → Connectivity → Wi-Fi.
3. Touch the network selection that you want to reset.
4. Touch Forget This Network.
5. At the prompt, touch Forget & Reboot.

Connecting to a Network with a Wi-Fi Protected Setup

Wi-Fi Protected Setup (WPS) is a network standard for setting up a wireless network. The WPS protocols enable you to set up devices in a secure wireless network without having wireless networking experience. With a WPS-certified router, you can use tools in the router and the printer to connect the printer to the network. To use the tools, ensure that the wireless router is configured properly and is compliant with the WPS.

- Push Button Connection (PBC) is the easiest way to connect the printer to a wireless network. It automatically connects when you push a button on the router and on the printer. After the router and printer exchange information, the printer accepts the security and configuration information from the router and connects to the network. The PBC is a moderately secure way to connect the printer to the network. You do not need to enter any information to make the network connection.
- PIN (Personal Identification Number) automatically connects the printer to a wireless router using a common PIN. The printer generates and prints a PIN for use in the setup process. When you enter the PIN into the router, the router broadcasts network information using the PIN. When both devices recognize the PIN, the router provides the security and configuration information to the printer, which uses it to connect to the network.

Connecting to a WPS Wireless Network Using the PBC Method

To connect to a Wi-Fi Protected Setup (WPS) wireless network using the Push-Button Connection (PBC) method:

Note: Before you install the device, ensure that the wireless router is configured properly and is connected to the network.

1. At the printer control panel, press the Home button.
2. Touch Device → Connectivity → Wi-Fi.
3. If Wi-Fi is Off, turn it on.
   a. To toggle Wi-Fi from Off to On, touch the Wi-Fi toggle button.
   b. To activate your Wi-Fi setting changes, press the Home button.
   c. At the prompt, touch Restart Now.
   d. After the printer restarts, touch Device → Connectivity → Wi-Fi.
5. Touch **Wi-Fi Protected Setup (WPS)**.

   - **Note:** If Wi-Fi Protected Setup (WPS) is not visible, at the top of the screen, touch **Manual Setup**.

6. Touch **PBC**.

7. Touch **OK**.

8. On the wireless router, press the **WPS** button.

   - **Note:** If the wireless router does not have a physical PBC button, use your computer to select the virtual button in the router control panel. For more information, refer to your router documentation.

   The router broadcasts setup information for 120 seconds.

9. To activate your Wi-Fi setting changes, restart the printer.
   a. Press the **Home** button.
   b. At the prompt, touch **Restart Now**.

10. After the printer restarts, wait two minutes, then to get the network information that includes the IP address, print a Configuration Report. For more information, refer to **Printing the Configuration Report**.

11. At the printer control panel, press the **Home** button.

12. If Wi-Fi is Off, turn it on.
   a. Touch **Device→Connectivity→Wi-Fi**.
   b. To toggle Wi-Fi from Off to On, touch the **Wi-Fi** toggle button.
   c. To activate your Wi-Fi setting changes, press the **Home** button.
   d. At the prompt, touch **Restart Now**.

   - **Note:** The following steps can vary with different router manufacturers. For more information, refer to your router documentation.

13. At your computer, open the wireless router control panel, then select **Add WPS Client**.

14. Select **PIN Method**. The wireless router control panel opens to a dialog box ready for the PIN number.

15. At the printer control panel, touch **Device→Connectivity→Wi-Fi**.

16. Touch **Manual Setup**.

17. Touch **Wi-Fi Protected Setup (WPS)**.

   - **Note:** If Wi-Fi Protected Setup (WPS) is not visible, at the top of the screen, touch **Manual Setup**.

18. Touch **PIN**.

19. Record the PIN from the screen, then touch **OK**.

   - **Note:** The printer continues to advertise for 120 seconds. If the printer does not locate the wireless router within 120 seconds, the connection attempt stops.

   The printer starts advertising using the displayed PIN Code.
20. At your computer, in the wireless router control panel Client PIN Code field, enter the PIN code, then click **Next**.

The printer communicates with the wireless router to resolve setup and configuration information. When the printer has the correct information, it connects to the router and restarts with the proper setup and configuration information.

If the router does not connect with the printer within 120 seconds, the connection attempt stops.

21. After the printer restarts, wait 20 seconds, then to get the network information that includes the IP address, print a Configuration Report. For more information, refer to **Printing the Configuration Report**.

### Connecting to a WPS Wireless Network Using the PIN Method

To connect to a Wi-Fi Protected Setup (WPS) wireless network using the PIN method:

- **Note:** Before you install the printer, ensure that you connect and configure the wireless router for the network.

1. At the printer control panel, press the **Home** button.

2. If Wi-Fi is Off, turn it on.
   a. Touch **Device → Connectivity → Wi-Fi**.
   b. To toggle Wi-Fi from Off to On, touch the **Wi-Fi** toggle button.
   c. To activate your Wi-Fi setting changes, press the **Home** button.
   d. At the prompt, touch **Restart Now**.

- **Note:** The following steps can vary with different router manufacturers. For more information, refer to your router documentation.

3. At your computer, open the wireless router control panel, then select **Add WPS Client**.

4. Select **PIN Method**. The wireless router control panel opens to a dialog box ready for the PIN number.

5. At the printer control panel, touch **Device → Connectivity → Wi-Fi**.

6. Touch **Manual Setup**.

7. Touch **Wi-Fi Protected Setup (WPS)**.

- **Note:** If Wi-Fi Protected Setup (WPS) is not visible, at the top of the screen, touch **Manual Setup**.

8. Touch **PIN**.

9. Record the PIN from the screen, then touch **OK**.

The printer starts advertising using the displayed PIN Code.

- **Note:** The printer continues to advertise for 120 seconds. If the printer does not locate the wireless router within 120 seconds, the connection attempt stops.
10. At your computer, in the wireless router control panel Client PIN Code field, enter the PIN code, then click Next.

The printer communicates with the wireless router to resolve setup and configuration information. When the printer has the correct information, it connects to the router and restarts with the proper setup and configuration information.
If the router does not connect with the printer within 120 seconds, the connection attempt stops.

11. After the printer restarts, wait 20 seconds, then to get the network information that includes the IP address, print a Configuration Report. For more information, refer to Printing the Configuration Report.

Connecting to Wi-Fi Direct

You can connect to your printer from a Wi-Fi mobile device, such as a tablet, computer, or smartphone, using Wi-Fi Direct. Wi-Fi Direct is disabled by default.

Note: Wireless networking is available only on printers with the optional Wireless Network Adapter installed.

Connecting with Wi-Fi Direct from Your Mobile Device

To connect with Wi-Fi Direct, follow the directions provided with your mobile device.

Initial Printer Setup

Before installing the printer software, verify that the printer is set up correctly. Setup includes enabling the optional features and assigning an IP address for the Ethernet network connection. The installation wizard starts automatically the first time the printer is powered on. The installation wizard prompts the system administrator to configure the following settings:

• Language
• Network Connection
• Proxy Server Setup
• Date and Time
• Measurements
• LDAP Settings
• Apps Setup
• Security Settings

For more information on configuring the printer settings, refer to the System Administrator Guide at www.xerox.com/office/VLC600docs.
Configuring AirPrint

AirPrint® is a software feature that allows you to print from wired or wireless Apple iOS-based mobile devices and Mac OS-based devices without the need to install a print driver. AirPrint-enabled printers allow you to print directly from a Mac, an iPhone, iPad, or iPod touch. You can use AirPrint to print from a wired device or a wireless device without using a print driver.

Note:

- Not all applications support AirPrint®.
- Wireless devices must join the same wireless network as the printer.
- For AirPrint to function, both IPP and Bonjour® (mDNS) protocols must be enabled.
- The device that submits the AirPrint job must be on the same subnet as the printer. To allow devices to print from different subnets, configure your network to pass multicast DNS traffic across subnets.
- The Mac OS device must be Mac OS 10.10 or later.
- AirPrint-enabled printers work with all models of iPad, iPhone (3GS or later), and iPod touch (third generation or later), running the latest version of iOS.

1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then press Enter or Return.

   Note: If you do not know the IP address for your printer, refer to Finding the IP Address of Your Printer.

2. In the Embedded Web Server, click Home → Connectivity.

   Note: If this feature does not appear, log in as a system administrator.

3. For Mobile Printing, click AirPrint.

4. To enable AirPrint, click the Enable toggle button.

   Note: AirPrint is enabled by default when IPP and Bonjour® (mDNS) are both enabled.

   - To change the printer name, in the Name field, enter a new name.
   - To enter a location for the printer, in the Location field, enter the location of the printer.
   - To enter a physical location or address for the printer, in the Geo-Location field, enter the geographic latitude and longitude coordinates in decimal form. For example, use coordinates such as 45.325026, -122.766831 for a location.

5. Click OK.

6. To activate your changes, at the prompt, click Restart Now.

Configuring Google Cloud Print

Google Cloud Print allows you to print documents that are stored in the cloud without using a print driver.

Before you begin:
• Set up a Google email account.
• Configure the printer to use IPv4.
• Configure Proxy Server settings as needed.

To configure Google Cloud Print:
1. At your computer, open a Web browser. In the address field, type the IP address of the printer,
   then press Enter or Return.

   Note: If you do not know the IP address for your printer, refer to Finding the IP Address of
   Your Printer.

2. In the Embedded Web Server, click Home → Connectivity.

3. For Mobile Printing, click Google Cloud Print.

4. To enable Google Cloud Print, click the Enable toggle button.

5. Click OK.

6. Restart the printer, then wait 2 minutes for the printer to connect.

7. Refresh your Web browser, then for Mobile Printing, click Google Cloud Print.

8. Click Printer Registration.

9. Click Register.

   A printer registration page prints.

10. To register the printer, in your Web browser, type the URL provided, or use your mobile phone to
    scan the barcode.

    After the printer is registered, a confirmation status window appears.

11. To access the Google Cloud Print feature, in your Google account, click Manage Your Printer.

    Note: The default printer name appears in this format: Model name (MAC address).
Installing the Software

Before installing driver software, verify that the printer is plugged in, powered on, connected correctly, and has a valid IP address. The IP address usually appears in the upper, right corner of the control panel. If you cannot find the IP address, see Finding the IP Address of Your Printer.

Note: If the Software and Documentation disc is not available, download the latest drivers from www.xerox.com/office/VLC600drivers.

Operating System Requirements

- Macintosh OS X version 10.10 and later.
- UNIX and Linux: Your printer supports connection to various UNIX platforms through the network interface.

Installing the Print Drivers for a Windows Network Printer

1. Insert the Software and Documentation disc into the appropriate drive on your computer. If the installer does not start automatically, navigate to the drive, and double-click the Setup.exe installer file.
2. Select your printer model.
3. Click Install Drivers.
4. Select Install Print Driver.
5. At the License Agreement, click I Agree.
6. From the list of discovered printers, select your printer.

   Note: When installing drivers for a network printer, if your printer does not appear in the list, click the IP Address or DNS Name button. In the IP Address or DNS Name field, type the IP address of your printer, then click Search to locate and select your printer. If you do not know the IP address of the printer, refer to Finding the IP Address of Your Printer.

7. Click Next.
8. If needed, you can name your printer by typing a name in the Queue Name field.
9. Select a Print Driver.
10. Click Install.
11. If needed, set the printer as the default printer.

   Note: Before selecting Share Printer, contact your system administrator.

12. To complete the installation, click Finish, then click Close.
Installing the Print Drivers for a Windows USB Printer

1. Insert the Software and Documentation disc into the appropriate drive on your computer. If the installer does not start automatically, navigate to the drive, and double-click the Setup.exe installer file.

2. Click Install Software.

3. At the License Agreement, select I Agree, then click Next.

4. To install the printer support software, select Software, then click Next.

5. In the Software and Documentation window, clear the check box for any unnecessary options.

6. Click Next.

7. To complete the installation, click Finish.

Installing the Drivers and Utilities for Macintosh OS X

1. Insert the Software and Documentation disc into the appropriate drive on your computer.

   Note:
   If the Software and Documentation disc is not available, download the latest drivers from www.xerox.com/office/VLC600drivers.

2. Open Xerox® Print Drivers 3.xx.x.dmg/.pkg as needed for your printer.

3. To run Xerox® Print Drivers 3.xx.x.dmg/.pkg, double-click the appropriate file name.

4. When prompted, click Continue.

5. To accept the license agreement, click I Agree.

6. To accept the current installation location, click Install, or select another location for the installation files, then click Install.

7. If prompted, enter your password, then click OK.

8. From the list of discovered printers, select your printer, then click Next.

9. If your printer does not appear in the list of discovered printers:
   a. Click the Network Printer Icon.
   b. Type the IP address of your printer, then click Continue.
   c. Select your printer in the list of discovered printers, then click Continue.

10. If your printer was not detected, verify that the printer is powered on and that the Ethernet or USB cable is connected properly.

11. To accept the print queue message, click OK.

12. Select or clear the Set Printer as Default and Print a Test Page check boxes.

13. Click Continue, then click Close.

Adding the Printer

For networking, set up your printer using Bonjour® (mDNS), or connect using the IP address of your printer for an LPD/LPR connection. For a non-network printer, create a desktop USB connection.

For reference:
Getting Started

Adding the Printer Using Bonjour
To add the printer using Bonjour®:
1. From the computer Applications folder or from the dock, open System Preferences.
2. Click Printers & Scanners.
   The list of printers appears on the left of the window.
3. For the list of printers, click the Plus icon (+).
4. At the top of the window, click the Default icon.
5. Select your printer from the list, then click Add.

   Note: If your printer is not detected, verify that the printer is powered on and that the Ethernet cable is connected properly.

Adding the Printer by Specifying the IP Address
To add the printer by specifying the IP address:
1. From the computer Applications folder or from the dock, open System Preferences.
2. Click Printers & Scanners.
   The list of printers appears on the left of the window.
3. Under the list of printers, click the Plus icon (+).
4. Click IP.
5. From the Protocol list, select the protocol.
6. In the Address field, enter the IP address of the printer.
7. In the Name field, enter a name for the printer.
8. From the Use list, choose Select a driver to use.
9. From the printer software list, select the print driver for your printer model.
10. Click Add.

Installing Drivers and Utilities for UNIX and Linux
For more information on installing print drivers and utilities for UNIX and Linux, refer to UNIX and Linux Printing.

Installing the Printer as a Web Service on Devices
Web Services on Devices (WSD) allows a client to discover and access a remote device and its associated services across a network. WSD supports device discovery, control, and use.
Using the Add Device Wizard to Install a WSD Printer

To install a WSD printer using the Add Device Wizard:

1. At your computer, click **Start**, then select **Devices and Printers**.
2. To launch the Add Device Wizard, click **Add a Device**.
3. In the list of available devices, select the one you want to use, then click **Next**.
   
   **Note:** If the printer you want to use does not appear in the list, click the **Cancel** button. Add the WSD printer manually using the Add Printer Wizard.
4. Click **Close**.

Using the Add Printer Wizard to Install a WSD Printer

To install a WSD printer using the Add Printer Wizard:

1. At your computer, click **Start**, then select **Devices and Printers**.
2. To launch the Add Printer Wizard, click **Add a Printer**.
3. Click **Add a network, wireless, or Bluetooth printer**.
4. In the list of available devices, select the one you want to use, then click **Next**.
5. If the printer you want to use does not appear in the list, click **The printer that I want is not listed**.
6. Select **Add a printer using a TCP/IP address or hostname**, then click **Next**.
7. From the Device type field, select **Web Services Device**.
8. In the Hostname or IP address field, enter the printer IP address, then click **Next**.
9. Click **Close**.
More Information

You can obtain more information about your printer from these sources:

<table>
<thead>
<tr>
<th>Resource</th>
<th>Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>Installation Guide</td>
<td>Packaged with the printer.</td>
</tr>
<tr>
<td>Other documentation for your printer</td>
<td><a href="http://www.xerox.com/office/VLC600docs">www.xerox.com/office/VLC600docs</a></td>
</tr>
<tr>
<td>Technical support information for your printer; including online technical support, Online Support Assistant, and print driver downloads.</td>
<td><a href="http://www.xerox.com/office/VLC600support">www.xerox.com/office/VLC600support</a></td>
</tr>
<tr>
<td>Information Pages</td>
<td>Print from the control panel. For details, refer to Information Pages.</td>
</tr>
<tr>
<td>Order supplies for your printer</td>
<td><a href="http://www.xerox.com/supplies">www.xerox.com/supplies</a></td>
</tr>
<tr>
<td>Local sales and Technical Customer Support</td>
<td><a href="http://www.xerox.com/office/worldcontacts">www.xerox.com/office/worldcontacts</a></td>
</tr>
<tr>
<td>Printer registration</td>
<td><a href="http://www.xerox.com/register">www.xerox.com/register</a></td>
</tr>
<tr>
<td>Xerox® Direct online store</td>
<td><a href="http://www.direct.xerox.com/">www.direct.xerox.com/</a></td>
</tr>
</tbody>
</table>
Customize and Personalize

This chapter contains:

- Customize and Personalize Overview ................................................................. 54
- Customizing or Personalizing the Home Screen ................................................... 55
- Customizing or Personalizing the Apps ............................................................... 56
Customize and Personalize Overview

This chapter provides information on how to customize and personalize your device to meet the specific demands of your workflows.

You can customize your apps, hide, or show apps on the Home screen, and rearrange the order to suit your job priorities. For each app, you can hide or show individual features and configure default settings to meet the needs of your workgroup. You can save job settings for repeated use. Customization enables users to work more productively.

When individual user accounts are configured on the device, you can personalize the device to meet specific user needs. You can configure your personal Home page to hide or show only the apps you use. Each of the feature lists can be tailored to your job requirements. Default settings for each app can be specified, and settings for regular jobs can be saved for your use. Personalization options ensure that the features and functions displayed meet individual user needs, improving efficiency.
Customizing or Personalizing the Home Screen

Hiding or Showing an App on the Home Screen
1. At the printer control panel, press the Home button.
2. Touch Customize.
3. To display an installed app that is hidden initially:
   a. Touch the Plus (+) icon.
   b. Touch the app that you want to appear on the control panel.
   c. Touch Done.
4. To hide an installed app:
   a. For the app, touch X.
   b. Touch Done.
5. Verify that only the selected apps appear on the Home screen.

Rearranging Apps on the Home Screen
1. At the printer control panel, press the Home button.
2. Touch Customize.
3. Touch and hold the required app.
4. Drag the app to the new location.
5. Release the app.
6. Touch Done.
7. Verify that the apps appear in the correct location on the Home screen.
Customizing or Personalizing the Apps

Customization enables you to modify the features available, delete a saved preset, or remove customized settings applied to an app.

Customizing or Personalizing the Feature List

To customize the Features list for an app:

1. At the printer control panel, press the **Home** button.
2. Touch the app required.
3. Scroll to the bottom, then touch **Customize**.
4. Touch **Feature List**.
   
   **Note:** For logged-in administrators, a window appears that asks you to confirm if the changes are for a Guest or for you.

5. Touch the particular option.
   - To hide a feature, for the required feature, touch the **Eye** icon. To signify that the feature is hidden, the Eye icon appears with a line across it.
   - To show a feature, for the required feature, touch the **Eye** icon. To signify a feature is visible, the Eye icon appears with no line across it.

6. To reorder the menu features, touch and drag the features into the appropriate order.
7. To save the current configuration, touch **Done**.

Saving Presets

You can use this feature to save a particular combination of app settings for future jobs. You can save the settings with a name and retrieve them for later use.

To save the current app settings:

1. At the printer control panel, press the **Home** button.
2. Touch the app required.
3. Select the job settings.
4. Scroll to the bottom, then touch **Save**.
5. Touch **Save as New Preset**.
6. Touch **Enter Preset Name**, then to enter a preset name, use the keypad.
7. Touch **Next**.
8. Select an icon that best suits the preset that you are creating.
9. Touch **Done**.

**Note:** The preset is stored within the Preset feature.
Deleting a Saved Preset

To delete a saved preset:
1. At the printer control panel, press the Home button.
2. Touch the app required.
3. Scroll to the bottom, then touch Customize.
4. Touch Presets.
5. Touch the Trash icon that corresponds with the preset that you want to delete.
6. At the prompt, touch Delete.
7. Touch Done.

Removing App Customization using the Control Panel

To remove the current app customization settings:
1. At the printer control panel, press the Home button.
2. Touch the app required.
3. Scroll to the bottom, then touch Customize.
4. Touch Remove App Customization.
5. At the prompt, touch OK.
Xerox® Apps

This chapter contains:

- Xerox® App Gallery ................................................................. 60
- Device .................................................................................. 63
- Jobs ..................................................................................... 67
- USB ....................................................................................... 72
- @PrintByXerox ..................................................................... 74

Xerox® Apps are a gateway to the features and functions of your device. There are standard apps already installed and displayed on the Home screen. There are also apps that are installed as standard but are hidden when your device is used for the first time.

For more information about customizing the Home screen and the apps features, refer to Customize and Personalize.

A range of apps is available for download and installation from the Xerox® App Gallery. These include Xerox® Extensible Interface Platform (EIP) Apps. EIP Apps enable you to install secure, signed apps on compatible printers.
Xerox® App Gallery

Xerox® App Gallery Overview

Use the Xerox® App Gallery to find apps that provide new features or capabilities for your device. The Xerox® App Gallery provides direct access to apps that can improve your productivity, simplify workflows, and enhance your user experience.

The Xerox® App Gallery enables you to browse and update apps easily. You can browse through the app library without logging in. The moving banner provides an active display of apps, or you can scroll the full list of apps. To get more details on an app, touch the app name in the list.

To use the Xerox® App Gallery App, ensure that your device uses either the wireless or the wired network connection.

Note: If a local server inside a firewall hosts your device and a proxy is enabled, set a proxy exception at the device.

For more information and instructions on using the Xerox® App Gallery, refer to the Xerox® App Gallery User Guide available at www.xerox.com/XeroxAppGallery.

Creating a Xerox® App Gallery Account

With an App Gallery account, you have direct access to all the available Apps for your device. An App Gallery account allows you to view and acquire Apps, install Apps on your device, and manage your Apps and licenses.

You can set up an App Gallery account using the control panel or from the Xerox® App Gallery website. To set up an App Gallery account from the website, go to https://appgallery.services.xerox.com/#/home, select Login → Create Account, and follow the instructions.

Note: If you have an existing Xerox App Gallery Account, refer to Logging into your Xerox® App Gallery Account.

To create an App Gallery account using the control panel:

1. At the printer control panel, press the Home button.
2. Touch Xerox® App Gallery.
3. To request a new account, minimize the on-screen keyboard, and touch Request an Account.
   
   Note: For detailed information and instructions on using the Xerox® App Gallery, refer to the Xerox® App Gallery User Guide available at www.xerox.com/XeroxAppGallery.

4. Touch the Enter your email address. Enter a valid email address using the touch screen keypad, then touch Enter.
5. Touch OK. A message is displayed stating completion instructions have been sent to the email address entered.
6. Touch Close.
7. Access your email account for the email address that you provided to Xerox® App Gallery.
8. Open the Xerox® App Gallery Account Request email, then click the URL link to access the create account page.

9. Review and accept the Terms of Use. To continue creating an account, click the Agree button.

10. Enter the information required into the appropriate fields:
   - User ID
   - Password
   - Confirm Password
   - First and Last Name
   - Company Name
   - Address (Street, City, State/Province, Postal)
   - Country

11. Click OK.

12. After the account is created, a confirmation message appears.

13. At the printer control panel, log in to your App Gallery Account.

Logging into your Xerox® App Gallery Account

When you are logged in to the App Gallery, you can browse available apps, and install and update apps.

To log in to your App Gallery Account:

1. At the printer control panel, press the Home button.
2. Touch Xerox® App Gallery.
3. Enter your User Name using the touch screen keypad, then touch Enter.
4. Enter your Password using the touch screen keypad, then touch Enter.
5. Touch Log In. The Xerox® App Gallery appears.

Installing or Updating an App from the Xerox® App Gallery

Xerox® Apps add, extend, or customize the functionality of your device. You can use the Xerox® App Gallery App to browse and install Apps at your device control panel.

Installing an App from the App Gallery

1. At the printer control panel, press the Home button.
2. Touch Xerox® App Gallery.

   Note: You can browse the App Gallery and view app descriptions without being logged in. To download or update apps, you must be logged in to the App Gallery.

3. Enter your User Name using the touch screen keypad, then touch Enter.
4. Enter your Password using the touch screen keypad, then touch Enter.
5. Touch Log In. The Xerox® App Gallery appears.
Xerox® Apps

6. Touch the app required, then touch Install. The License Agreement screen appears.

   Note: If the app was installed previously and a new version is available, the button is labeled as Update.

7. Touch Agree. The installation process begins.
   If the app is not successfully installed, to attempt the installation process again, touch Install.

8. To exit the Xerox® App Gallery, touch Exit.

Updating an App from the App Gallery

1. At the printer control panel, press the Home button.
2. Touch Xerox® App Gallery.
3. Enter your User Name using the touch screen keypad, then touch Enter.
4. Enter your Password using the touch screen keypad, then touch Enter.
5. Touch Log In. The Xerox® App Gallery appears.
6. Touch the app required, then touch Update. The License Agreement screen appears.
7. Touch Agree.
8. When the update is complete, the Update button is labeled as Installed.
9. To exit the Xerox® App Gallery App, touch Exit.
Device

Device Overview

The Device App gives you access to information about your printer, including the serial number and model. You can view the status of the paper trays, billing and supplies information, and print Information Pages.

You can configure many Device options to meet your individual needs. For details about configuring all Device settings, refer to the System Administrator Guide at www.xerox.com/office/VLC600support.

Device Options

The following Device options are available:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Language</td>
<td>Language allows you to set the language that appears on the control panel.</td>
</tr>
<tr>
<td>About</td>
<td>The About option provides an overview of your device and its current settings and status. You can access Information Pages and reports using this option.</td>
</tr>
<tr>
<td>Software Update</td>
<td>Use this option to check for software updates and configure update settings.</td>
</tr>
<tr>
<td>Notifications</td>
<td>Use the Notifications option to see details of current alerts or faults on the device. A History button displays fault codes and the date that the fault occurred on the device.</td>
</tr>
<tr>
<td>Paper Trays</td>
<td>Use the Paper Trays option to see the paper size, type, and color set for each paper tray and the tray-capacity status.</td>
</tr>
<tr>
<td>Supplies</td>
<td>Use the Supplies option to monitor the status of the components you can replace. The supply level and estimated number of impressions or days left for each unit is displayed.</td>
</tr>
<tr>
<td>Billing/Usage</td>
<td>Use the Billing/Usage option to view the serial number and the total number of impressions made by your device.</td>
</tr>
<tr>
<td>General</td>
<td>Use the General option to customize settings such as the power-saver modes, date and time, and control panel brightness. You can configure the General settings using the device control panel, or by using the Embedded Web Server.</td>
</tr>
</tbody>
</table>
### Option Description

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Apps</td>
<td>Use Apps to select settings for the apps installed on your device.</td>
</tr>
<tr>
<td>Connectivity</td>
<td>Use the Connectivity option to configure network settings at the control panel, or join another wireless network.</td>
</tr>
<tr>
<td>Support</td>
<td>Use this option to access and print the Support Pages to assist with troubleshooting errors.</td>
</tr>
<tr>
<td>Resets</td>
<td>Use the Resets option to reset device settings and font, forms, and macros to the factory-default settings.</td>
</tr>
</tbody>
</table>

For details on configuring the printer settings, refer to the *System Administrator Guide* at www.xerox.com/office/VLC600docs.

### About

The About option provides an overview of your device and current settings and status. You can access Information Pages and reports using this option.

### Supply Status

You can check the status and percentage of life remaining for your printer supplies at the control panel or from the Embedded Web Server. When printer supplies near their replacement time, warning alerts appear on the control panel. You can customize the alerts that appear on the control panel and configure email alert notifications.

To check the supplies status and set up alerts using the Embedded Web Server, refer to the *System Administrator Guide* at www.xerox.com/office/VLC600docs.

### Checking the Supplies Status at the Control Panel

1. To view status information for the printer supplies, touch **Device → Supplies**.
2. To view details about a specific item, including part numbers for reordering, touch the specific item.
3. To return to the Supplies screen, touch X.
4. To return to the Device screen, touch the back arrow.

### Customizing Supplies Alert Settings

1. To customize the alerts that appear for printer supplies, touch **Device → Supplies → Alerts Setup**.
2. To enable supplies alerts that appear on the control panel, touch the **Enable Alerts** toggle button.
3. To configure the printer to display an alert when an item reaches a specific usage percentage level, touch the item, then select the percentage.
4. To customize the alerts for each supply item, or to enable or disable an alert, touch the toggle button.
5. To return to the Supplies screen, touch X.
6. To return to the Device screen, touch the back arrow.

### Setting Up Email Alerts

To check the supplies status and set up alerts using the Embedded Web Server, refer to the System Administrator Guide at [www.xerox.com/office/VLC600docs](http://www.xerox.com/office/VLC600docs).

1. To set up alerts to send to an email address, touch **Device → Supplies → Email Alerts**.
2. To enter an email address, touch **Add Email**, then touch **Enter Email Address**.
3. Use the touch screen keyboard to enter an email address, or select an entry from the Address Book, then touch **OK**.
4. Add more email addresses if necessary.
5. To customize the alerts for each supply item, or to enable or disable an alert, touch the toggle button.
6. To exit the menu, touch **OK**.
7. To return to the Device screen, touch the back arrow.

### Billing and Usage Counters

The Billing/Usage menu displays the total number of impressions that the printer generated or printed during its lifetime. You cannot reset the counters. A page is counted as one side of a sheet of paper. For example, a sheet of paper that is printed on two sides counts as two impressions.

To view the Billing and Usage Counters:

1. At the printer control panel, press the **Home** button.
2. Touch **Device → Billing/Usage**.
3. To view more details, touch **Usage Counters**, then select an option.
   - **Impression Counters**: This option provides the number of impressions made by the printer. The number of impressions cannot equal the number of sheets counted, depending on the printer setup. If your printer counts large sheets as large impressions or as multiple smaller impressions, the number of impressions can differ.
   - **Sheet Counters**: This option provides the number of impressions made by the printer. Impressions for 2-sided sheets are listed on a separate line from 1-sided sheets.
   - **All Usage Counters**: This option provides all printer usage information.
4. To return to the Billing/Usage screen, touch the back arrow.
5. To return to the Device screen, touch the back arrow.
Reset to Factory Defaults

**Caution:** The Reset to Factory Defaults feature erases all settings and returns the printer to the original factory state. All jobs, presets, apps, and device settings are reset. If the printer includes a hard disk, the disk is reinitialized.

The non-volatile memory (NVRAM) stores printer settings, even after the power is turned off. When complete, the printer restarts, then displays the Install Wizard.

To reset the printer to factory defaults:

1. At the printer control panel, press the **Home** button.
2. Touch **Device → Resets → Reset to Factory Defaults**.
3. At the prompt, touch **Reset**.
4. When the process is complete, the printer restarts automatically.

Remote Services

You can use the Remote Services option in the Embedded Web Server to send error and usage information to the Xerox support team to help them resolve problems quickly.

For information about enabling Remote Services and uploading information to Xerox, refer to the System Administrator Guide at www.xerox.com/office/VLC600docs.
Jobs

Jobs Overview

Use Jobs to view current jobs, print saved, personal, and secure jobs, and view details of completed jobs. You can pause, delete, print, or view job progress or job details for a selected job.

Managing Jobs

From the control panel Jobs menu, you can view lists of active jobs, secure jobs, or completed jobs. You can pause, delete, print, or view job progress or job details for a selected job. From the Jobs window in the Embedded Web Server, you can view a list of active and completed print jobs. For more information, refer to Managing Jobs Using the Embedded Web Server.

A print job can be held by the printer when it is unable to complete a print job. For example, when the printer needs attention, paper, or supplies. When the condition is resolved, the printer automatically resumes printing. When you send a Secure Print job, the job is held until you release it by typing a passcode at the control panel. For more information, refer to Printing Special Job Types.

Pausing the Print Job with the Option to Delete It

1. At the printer control panel, press the Home button.
2. Touch Jobs, then touch the name of the print job.
3. Do one of the following:
   - To pause the print job, touch Pause. To resume the print job, touch Resume.
   - To delete the print job, touch Delete. At the prompt, touch Delete.

   Note: If you do not make a selection within 60 seconds, the job resumes automatically.

4. To return to the Home screen, press the Home button.

Viewing, Printing, or Deleting Saved and Secure Jobs

Note:

- The system administrator can restrict users from deleting jobs. If a system administrator has restricted job deletion, you can view the jobs, but not delete them.
- Only the user that sent the job or the system administrator can delete a Secure Print job.

1. At the printer control panel, press the Home button.
2. To view a list of active and completed jobs, touch Jobs.
3. To view a list of specific job types, touch an option.
To view Saved Jobs, touch Saved Jobs. To print the job, touch the job, enter the quantity, then touch OK. To delete the job, touch the Trash icon, then touch Delete.

To view Personal jobs, touch Personal & Secure Jobs. To print the jobs, touch the folder, then touch Print All, or Delete All.

For Secure Jobs, touch Personal & Secure Jobs. Touch the folder, enter the passcode number, then touch OK. To print a Secure Job, touch the job. To print or delete all the jobs in the folder, touch Print All, or Delete All.

4. To view details about a job, touch the job.
5. To return to the Home screen, press the Home button.

Printing a Job Held for Resources

1. At the printer control panel, press the Home button.
2. Touch Jobs.
3. From the jobs list, touch the held job name. The resources required for the job appear on the control panel.
4. Do one of the following:
   - To print the job, replenish the resources required. The job resumes automatically when the required resources are available. If the job does not print automatically, touch Resume.
   - To delete the print job, touch Delete. At the prompt, touch Delete.
5. To return to the Home screen, press the Home button.

Managing Special Job Types

Special job types allow you to send a print job from your computer, then print it from the printer control panel. Select special job types in the print driver, Printing Options tab, under Job Type.

Saved Jobs

Saved Jobs are documents sent to the printer and, unless deleted, are stored there for future use. Any user can print or delete a Saved Job. To print a Saved Job, refer to Printing a Saved Job.

Releasing a Saved Job

1. At the printer control panel, press the Home button.
2. Touch Jobs.
3. To view Saved Jobs, touch Saved Jobs.
4. To print a Saved Job, touch the job name, enter the quantity, then touch OK.
5. To delete the document after printing, for that job, touch the Trash icon, then at the prompt, touch Delete.
6. To return to the Home screen, press the Home button.
Secure Print

Use Secure Print to print sensitive or confidential information. After you send the job, it is held at the printer until you enter your passcode at the printer control panel.
To print a Secure Print job, refer to Printing a Secure Print Job.

Releasing a Secure Print job
1. At the printer control panel, press the Home button.
2. Touch Jobs.
3. To view Secure Print jobs, touch Personal & Secure Jobs.
4. Touch your folder.
5. Enter the passcode number, then touch OK.
6. Select an option:
   • To print a Secure Print job, touch the job.
   • To print all the jobs in the folder, touch Print All.
   • To delete a Secure Print job, touch the Trash icon. At the prompt, touch Delete.
   • To delete all the jobs in the folder, touch Delete All.

   Note: After a Secure Print job is printed, it is deleted automatically.
7. To return to the Home screen, press the Home button.

Personal Print

Personal Print allows you to store a document in the printer, then print it from the control panel.

Note: The Personal Print feature is only available on a Windows computer printing to a network printer.

Personal Print is a type of saved job with these features:
• A Personal Print job appears in a folder named after the user ID associated with the print job.
• A Personal Print job does not use a passcode.
• Any user can print or delete a Personal Print job.
• You can print all jobs in the list at once, delete an individual job, or delete all jobs in the list.
• After a Personal Print job is printed, it is deleted automatically.
To print a Personal Print job, refer to Printing a Personal Print Job.

Releasing a Personal Print Job
1. At the printer control panel, press the Home button.
2. Touch Jobs.
3. To view Personal Print jobs, touch Personal & Secure Jobs.
4. Touch your folder.
5. If prompted for a passcode, touch Skip.

   Note: When your folder contains Secure Print jobs and Personal Print jobs, the passcode prompt prompt appears.
6. Select an option.
   • To print a Personal Print job, touch the job.
   • To print all the jobs in the folder, touch Print All.
   • To delete all the jobs in the folder, touch Delete All.

7. To return to the Home screen, press the Home button.

**Sample Set**

The Sample Set job type prints one copy of a multiple-copy print job before printing the remaining copies. After reviewing the sample set, you can either print the remaining copies or delete them at the printer control panel.

Sample Set is a type of saved job with these features:

- A Sample Set job appears in a folder named after the user ID associated with the print job.
- A Sample Set job does not use a passcode.
- Any user can print or delete a Sample Set job.
- A Sample Set prints one copy of a job to allow you to proofread the job before printing any remaining copies.

After a Sample Set job is printed, it is deleted automatically.

To print a Sample Set, refer to Printing a Sample Set.

**Releasing a Sample Set**

1. At the printer control panel, press the Home button.
2. To view available jobs, touch Jobs.
3. Touch the Sample Set job.

   ![Note: The Sample Set file description shows the job as Held for Future Printing, and shows the number of remaining copies of the job.]

4. Select an option.
   • To print the remaining copies of the job, touch Release.
   • To delete the remaining copies of the job, touch Delete.
5. To return to the Home screen, press the Home button.

**Managing Jobs Using the Embedded Web Server**

You can view a list of active jobs and delete print jobs from the Active Jobs list in the Embedded Web Server. You can use the Embedded Web Server to submit jobs for printing at the device. You can print .pdf, .ps, .pcl, .prn, .xps, .jpg, .tif and .txt files directly from the Embedded Web Server without opening another application or the print driver. The files can be stored on a local computer hard drive, mass storage device, or network drive.

1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then press Enter or Return.
2. In the Embedded Web Server, click Jobs.
3. Click the job name.
4. Do one of the following:
• To pause the print job, click Pause. To resume the print job, click Resume.
• To delete the print job, click Delete. At the prompt, click Delete.

5. To return to the Home screen, click Home.

**Submitting Jobs for Printing Using the Embedded Web Server**

1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then press Enter or Return.
2. In the Embedded Web Server, click Home.
3. In the Quick Links area, click Submit File.
4. Click the Submit field.
5. In the selection window, select a file to print, then click Open.
6. To print the document, click Submit.
USB

USB Overview

Use the Print from USB feature to print jobs already stored on a USB drive. Jobs in a print-ready format, such as PDF, TIFF, or JPEG, can be printed.

To create a print-ready file, select the Print to File option when you print your documents from programs such as Microsoft Word. From advanced publishing programs, there may be several methods to create print-ready files.

Printing from a USB Flash Drive

You can print a file stored on a USB Flash drive. The USB port is on the front of the printer.

Note:

- If the device is in Power Saver mode, before proceeding with the Print job, to wake the device, press the Power/Wake button.
- Only USB Flash drives formatted to the typical FAT32 file system are supported.

1. Insert the USB Flash drive into the USB memory port on the printer.
2. At the USB Drive has been detected screen, touch Print from USB.

Note: If this feature does not appear, enable the feature or contact the system administrator. For more information, see the System Administrator Guide at www.xerox.com/office/VLC600docs.

3. Add files using the Browse USB screen.
   - To print a group of print-ready files, for the USB drive or folder, touch the Select All icon. Verify that your files are selected.
   - To print a specific file, browse to that file, then touch the file name or icon.
4. Touch OK.
5. Confirm that the required files are listed.
   - To select more files, touch Add Documents, then touch OK.
   - To remove a file name from the list, touch the file name, then touch Remove.
6. Select the paper supply, quantity, output color, and 2-sided printing options.
7. Touch Print.
8. When you are finished, remove the USB Flash drive.
Printing from a USB Flash Drive Already Inserted in the Printer

1. If the USB Flash drive is already in the USB memory port, press the **Home** button.

2. Touch **Print from USB**.
   - **Note:** If this feature does not appear, enable the feature or contact the system administrator. For more information, see the *System Administrator Guide* at [www.xerox.com/office/VLC600docs](http://www.xerox.com/office/VLC600docs).

3. Add files using the Browse USB screen.
   - To print a group of print-ready files, for the USB drive or folder, touch the **Select All** icon. Verify that your files are selected.
   - To print a specific file, browse to that file, then touch the file name or icon.

4. Touch **OK**.

5. Confirm that the desired documents appear. If the documents do not appear, touch **Add Documents**, select additional documents, then touch **OK**.

6. Select the paper supply, quantity, output color, and 2-sided printing options.

7. Touch **Print**.
You can use the Xerox® @PrintByXerox App to print email attachments and documents sent to your printer from mobile devices. When your Xerox device is connected to the Internet, the @PrintByXerox App works with the Xerox® Workplace Cloud for simple email-based printing.

Note: The @PrintByXerox App and Xerox® Workplace Cloud software require specific licenses, configuration settings, and minimum system specifications. For details, refer to the Xerox® @PrintByXerox App Quick Start Guide available at www.xerox.com/XeroxAppGallery.

Printing with the @PrintByXerox App

1. Send an email with an attachment containing a supported file type to Print@printbyxerox.com. First-time users receive a response email with a user ID and password.

2. At the Xerox device control panel, press the Home button.

3. Touch @PrintByXerox.

4. Enter your email address, then touch Save.

5. On the Enter password screen, use the onscreen keyboard to enter your password, then touch Save.

6. Select the documents that you want to print.

7. Touch Print Settings, then touch OK.

8. Touch Print.
   - The Submitting Jobs to Print message and conversion state appears.
   - When the documents begin to print, a green check mark appears.
Printing

This chapter contains:

- Printing Overview ................................................................. 76
- Selecting Printing Options .................................................. 77
- Printing Features ................................................................... 83
- Using Custom Paper Sizes .................................................... 93
Printing Overview

Before printing, your computer and the printer must be plugged in, powered on, and connected. Ensure that you have the correct print driver software installed on your computer.

1. Select the appropriate paper.
2. Load paper in the appropriate tray. On the printer control panel, specify the size, color, and type.
3. Access the print settings in your software application. For most software applications, press CTRL +P for Windows, or CMD+P for Macintosh.
4. Select your printer.
5. To access the print driver settings:
   • For Windows, select Properties or Preferences.
   • For Macintosh, select Xerox® Features.
     The title of the button can vary depending on your application.
6. Modify the print driver settings as necessary, then click OK.
7. To send the job to the printer, click Print.
Selecting Printing Options

Printing options, also called print driver software options, are specified as Printing preferences in Windows and Xerox® Features in Macintosh. Printing options include settings for 2-sided printing, page layout, and print quality. Printing options that are set from Printing preferences within the Devices and Printers window become the default setting. Printing options that are set from within the software application are temporary. The application and the computer do not save the settings after the application is closed.

Print Driver Help

Xerox® print driver software Help information is available from the Printing Preferences window. Click the Help button (?) in the bottom, left corner of the Printing Preferences window to see the Help.

Information about Printing Preferences appears in the Help window. From there, you can select by topic or use the search field to enter the topic or function for which you need information.

Windows Printing Options

Selecting Printing Options for an Individual Job for Windows

To use special printing options for a particular job, you can change the Printing Preferences before sending the job to the printer.

1. With the document open in your software application, access the print settings. For most software applications, click File → Print or press CTRL+P.
2. Select your printer and click the Properties or Preferences button to open the Printing Preferences window. The title of the button can vary depending on your application.
3. Click a tab in the Printing Preferences window, then make selections.
4. To save and close the Printing Preferences window, click OK.
5. To send the job to the printer, click Print.
Setting Default Printing Options for Windows

When you print from any software application, the printer uses the print job settings specified in the Printing Preferences window. You can specify your most common printing options and save them so that you do not have to change the settings every time you print.

For example, if you want to print on both sides of the paper for most jobs, specify 2-sided printing in Printing Preferences.

1. Navigate to the list of printers on your computer:
   - For Windows Server 2008 and later, click Start → Settings → Printers.
   - For Windows 7, click Start → Devices and Printers.
   - For Windows 8.1 and Windows 10, right-click the Start icon → Control Panel → Devices and Printers.

   Note: If you are using a custom Start menu application, it can change the navigation path to your list of printers.

2. In the list of printers, right-click the icon for your printer, then click Printing preferences.

3. In the Printing Preferences window, click a tab, then select the options. To save the settings, click OK.

   Note: For more information about Windows print driver options, click the Help button (?) in the Printing Preferences window.

Selecting Printing Defaults in Windows for a Shared Network Printer

1. Navigate to the list of printers on your computer:
   - For Windows Server 2008 and later, click Start → Settings → Printers.
   - For Windows 7, click Start → Devices and Printers.
   - For Windows 8.1 and Windows 10, right-click the Start icon → Control Panel → Devices and Printers.

   Note: If you are using a custom Start menu application, it can change the navigation path to your list of printers.

2. In the list of printers, right-click the icon for your printer, then select Printer properties.

3. In the printer Properties dialog box, click the Advanced tab.

4. On the Advanced tab, click Printing Defaults.

5. Make your selections on the Print Driver tabs as needed, then click Apply.

6. To save the settings, click OK.

Saving a Set of Commonly Used Printing Options for Windows

You can define and save a set of options, so that you can apply them to future print jobs. In Xerox® App Gallery, you can save an app as default, so you can have app-by-app default settings for printing.

To save a set of printing options:

1. With the document open in your application, click File → Print.

2. To open the Printing Preferences window, select your printer, then click Properties or Preferences.

3. In the Printing Properties window, click the tabs, then select the required settings.
4. In the Printing Properties window, click **Saved Settings**, then click **Save As**.

5. To save the set of options in the Saved Settings list, type a name for the set of printing options, then click **OK**.

### Macintosh Printing Options

#### Selecting Printing Options for Macintosh

To use specific printing options, change the settings before sending the job to the printer.

1. With the document open in your application, click **File**→**Print**.
2. Select your printer.
3. In the Print Options menu, select **Xerox Features**.
   
   **Note:** To see all printing options, click **Show Details**.

4. Select any other required printing options from the lists.
5. To send the job to the printer, click **Print**.

#### Saving a Set of Commonly Used Printing Options for Macintosh

You can define and save a set of options, so that you can apply them to future print jobs.

To save a set of printing options:

1. With the document open in your application, click **File**→**Print**.
2. Select your printer from the Printers list.
3. Select the required printing options from the lists in the Print dialog box.
   
   **Note:** To see all printing options, click **Show Details**.

4. Click **Presets**→**Save Current Settings as Preset**.
5. Type a name for the printing options. To save the set of options in the Presets list, click **OK**.
6. To print using these options, select the name from the Presets list.

### UNIX and Linux Printing

The Xerox® Print Driver package provides tools for you to manage printers connected in UNIX and Linux environments.

The Xerox® print drivers provide a GUI-based (Graphical User Interface) driver dialog for printer feature selections. You can select print drivers based on your operating system.

#### Xerox® Printer Manager

Xerox® Printer Manager is an application that allows you to manage and print to multiple printers in UNIX and Linux environments.

Xerox® Printer Manager allows you to:
• Configure and check the status of network connected printers.
• Set up a printer on your network and monitor the operation of the printer once installed.
• Perform maintenance checks and view supplies status at any time.
• Provide a common look and feel across the many different suppliers of UNIX and Linux operating systems.

Installing Xerox® Printer Manager

Before you begin, ensure that you have root or superuser privileges to install Xerox® Printer Manager. To install Xerox® Printer Manager:

1. Download the appropriate package for your operating system. To locate print drivers for your printer, go to www.xerox.com/office/VLC600drivers.
2. On the print driver website, navigate to your printer model.
3. For your printer model, click Drivers & Downloads.
4. From the Operating System menu, select your operating system.
5. To identify the print driver for your printer model, review the list of available print drivers.

   Note: For additional information on each driver, click Description.

6. To select the print driver for your printer model and operating system, click the print driver name.
7. To begin the download, read the End User License Agreement, then click Accept.

   The file automatically downloads to the default location for your computer file downloads.
8. To install the Xerox® Print Driver package:
   a. Open the package with your OS package manager.
   b. To install using a command-line utility, change to the directory where you downloaded the file. To run the installer, type the appropriate command-line utility for your operating system. For example:

      • Red Hat: rpm -U <filename>.rpm
      • Debian-based Linux: dpkg -i <filename>.deb
      • AIX: rpm -U <filename>.rpm
      • HPUX: <filename>.depot.gz
      • Solaris: pkgadd -d <filename>.pkg

   Note: Most installations create a Xerox directory in /opt/Xerox/prtsys. For additional information about utilities included in the OS package manager, refer to the manual included with the package. For example, man xeroxprtmgr.

Launching Xerox® Printer Manager

To launch Xerox® Printer Manager, do one of the following tasks.

• For UNIX, log in as root. From a terminal window, type xosdprtmgr, then press Enter or Return.
• For Linux, type sudo xeroxprtmgr, then press Enter or Return.
Printing with xeroxprint

Xerox has its own print command. You can use the following command:

```
xeroxprint -d<Some_Queue> -o[Options] <Somefile
```

Printing from a Linux Workstation

To print from a Linux workstation, install either a Xerox® print driver for Linux or a CUPS (Common UNIX Printing System) print driver. You do not need both drivers. Xerox recommends that you install one of the full-featured custom print drivers for Linux. To locate drivers for your printer, go to www.xerox.com/drivers. If you use CUPS, ensure that CUPS is installed and running on your workstation. The instructions for installing and building CUPS are contained in the CUPS Software Administrators Manual, written and copyrighted by Easy Software Products. For complete information on CUPS printing capabilities, refer to the CUPS Software Users Manual available from www.cups.org/documentation.php.

Installing the PPD File on the Workstation

1. If available, download the Xerox® PPD for CUPS (Common UNIX Printing System) from the Drivers and Downloads page on the Xerox Support website.
2. Copy the PPD file into the CUPS ppd/Xerox folder on your workstation. If you are unsure of the location of the folder, use the Find command to locate the PPD files.
3. Follow the instructions that are included with the PPD file.

Adding the Printer

1. Verify that the CUPS (Common UNIX Printing System) daemon is running.
2. Open a Web browser and type `http://localhost:631/admin`, then click Enter or Return.
3. For User ID, type root. For password, type the root password.
4. Click Add Printer, then follow the onscreen prompts to add the printer to the CUPS printer list.

Printing with CUPS (Common UNIX Printing System)

CUPS supports the use of both the System V (lp) and Berkeley (lpr) printing commands.

1. To print to a specific printer in System V, type `lp -dprinter filename`, then click Enter.
2. To print to a specific printer in Berkeley, type `lpr -Pprinter filename`, then click Enter.

Mobile Printing Options

This printer can print from iOS and Android mobile devices. For more information, refer to Configuring Google Cloud Print.

Printing with Wi-Fi Direct

You can connect to your printer from a Wi-Fi mobile device, such as a tablet, computer, or smartphone, using Wi-Fi Direct. For details, refer to Connecting to Wi-Fi Direct. For details on using Wi-Fi Direct, refer to the documentation provided with your mobile device.

Note: Depending on which mobile device you are using, the printing procedure varies.
Printing with AirPrint

You can print directly from your iPhone, iPad, iPod touch, or Mac using AirPrint®. To enable AirPrint® for your printer, refer to Configuring AirPrint. To use AirPrint®, ensure that your mobile device is connected to the same wireless network as the printer.

To print with AirPrint®:

1. Open the email, photograph, website page, or document that you want to print.
2. Tap the Action icon.
3. Tap Print.
4. Select your printer, then set the printer options.
5. Tap Print.

Printing from a MOPRIA-Enabled Mobile Device

MOPRIA™ is a software feature that enables users to print from mobile devices without requiring a print driver. You can use MOPRIA™ to print from your mobile device to MOPRIA™-enabled printers.

**Note:****

- MOPRIA™ and all of its required protocols are enabled by default.
- Ensure that you have the latest version of the MOPRIA™ Print Service installed on your mobile device. You can obtain a free download from the Google Play Store.
- Wireless devices must join the same wireless network as the printer.
- The name and location of your printer appears in a list of MOPRIA™-enabled printers on connected devices.

To print using MOPRIA™, follow the directions provided with your mobile device.
Printing Features

Viewing, Printing, or Deleting Jobs

1. At the printer control panel, press the Home button.
2. To view a list of active and completed jobs, touch Jobs.
3. To view a list of specific job types, touch an option.
   - To view Saved Jobs, touch Saved Jobs. To print the job, touch the job, enter the quantity, then touch OK. To delete the job, touch the Trash icon, then touch Delete.
   - To view Personal Jobs, touch Personal & Secure Jobs. To print the jobs, touch the folder, then touch Print All, or Delete All.
   - For Secure Jobs, touch Personal & Secure Jobs. Touch the folder, enter the passcode number, then touch OK. To print a Secure Job, touch the job. To print or delete all the jobs in the folder, touch Print All, or Delete All.
4. To view details about a job, touch the job.
5. To return to the Home screen, press the Home button.

Note:
- The system administrator can restrict users from deleting jobs. If a system administrator has restricted job deletion, you can view the jobs, but not delete them.
- Only the user that sent the job or the system administrator can delete a Secure Print job.

Printing Special Job Types

Special job types allow you to send a print job from your computer, then print it from the printer control panel. To select special job types from the print driver, select Printing Options — Job Type.

Printing a Saved Job

1. In your software application, access the print settings. For most software applications, press CTRL +P for Windows or CMD+P for Macintosh.
2. Select your printer, then open the print driver.
   - For Windows, click Printer Properties. Depending on your application, the title of the button can vary.
   - For Macintosh, in the Print window, click Print Options, then select Xerox Features.
3. For Job Type, select Saved Job.
4. Type a job name or select a name from the list, then click OK.
5. Select any other required printing options.
   - For Windows, click OK, then click Print.
   - For Macintosh, click Print.
Printing

Printing a Secure Print Job
1. In your software application, access the print settings. For most software applications, press CTRL +P for Windows or CMD+P for Macintosh.
2. Select your printer, then open the print driver.
   • For Windows, click Printer Properties. Depending on your application, the title of the button varies.
   • For Macintosh, in the Print window, click Preview, then select Xerox Features.
3. For Job Type, select Secure Print.
4. Type the passcode, confirm the passcode, then click OK.
5. Select any other required printing options.
   • For Windows, click OK, then click Print.
   • For Macintosh, click Print.

Printing a Personal Print Job
1. In your software application, access the print settings. For most software applications, click File→Print or for Windows, press CTRL+P.
2. Select your printer, then click Printer Properties. Depending on your application, the title of the button varies.
3. For Job Type, select Personal Print.
4. Select any other required printing options, then click OK.
5. To send the job to the printer, click Print.

Printing a Sample Set
1. In your software application, access the print settings. For most software applications, press CTRL +P for Windows or CMD+P for Macintosh.
2. Select your printer, then open the print driver.
   • For Windows, click Printer Properties. Depending on your application, the title of the button varies.
   • For Macintosh, in the Print window, click Preview, then select Xerox Features.
3. For Job Type, select Sample Set.
4. Select any other required printing options.
   • For Windows, click OK, then click Print.
   • For Macintosh, click Print.

Selecting Paper Options for Printing
There are two ways to select the paper for your print job. You can let the printer select which paper to use based on the document size, paper type, and paper color you specify. You can also select a specific tray loaded with the desired paper.

• For Windows, paper options are in the Paper field on the Printing Options tab.
• For Macintosh, in the Print window, in Xerox Features, paper options are in the Paper field for Paper/Output.
Scaling

Scaling reduces or enlarges the original document to match the selected output paper size.

- For Windows, the scale options are on the Printing Options tab, in the Paper field.
- For Macintosh, the scale options are in the Print window. To view more printing options, click Show Details.

The following scaling options are available:

- **Automatically Scale** scales the document to fit the selected Output Paper Size. The scaling amount appears in the percentage box below the sample image.

- **No Scaling** does not change the size of the page image printed on the output paper, and 100% appears in the percentage box. If the original size is larger than the output size, the page image is cropped. If the original size is smaller than the output size, extra space appears around the page image.

- **Manually Scale** scales the document by the amount entered in the percentage box below the preview image.

Printing on Both Sides of the Paper

Printing a 2-Sided Document

If your printer supports Automatic 2-Sided Printing, the options are specified in the print driver. The print driver uses the settings for portrait or landscape orientation from the application for printing the document.

>Note: Ensure that the paper size and weight are supported. For more information, refer to Supported Paper Types and Weights for Automatic 2-Sided Printing.

2-Sided Page Layout Options

You can specify the page layout for 2-sided printing, which determines how the printed pages turn. These settings override the application page orientation settings.

- **1-Sided Print**: This option prints on one side of the media. Use this option when printing on envelopes, labels, or other media that cannot be printed on both sides.

- **2-Sided Print**: This option prints the job on both sides of the paper to allow binding on the long edge of the paper. The following illustrations show the result for documents with portrait and landscape orientations, respectively:

- **2-Sided Print, Flip on Short Edge**: This option prints on both sides of the paper. The images print to allow binding on the short edge of the paper. The following illustrations show the result for documents with portrait and landscape orientations, respectively:
Note: 2-Sided Printing is part of the Earth Smart settings.
To change your default print driver settings, see Setting Default Printing Options for Windows.

Print Quality

Print-quality modes:
- Standard print-quality mode: 600 x 600 dpi
- Enhanced print-quality mode: 600 x 600 dpi, 8-bit depth

Image Options

Image options control how the printer uses color to produce your document. The Windows PostScript print driver and the Macintosh print drivers provide the widest range of color controls and corrections on the Image Options tab.
- For Windows, Color Corrections, and Color Adjustment are on the Image Options tab.
- For Macintosh, in the Print window, in Xerox Features, Color Options is on the Paper/Output list.

Note: This option is not available in PCL/PCL6.

The following options are available:
- Xerox Black and White: This feature converts all color in the document to black and white or shades of gray.
- Xerox Automatic Color: This option applies the best color correction to text, graphics, and images. Xerox recommends this setting.
- Vivid RGB: This setting produces brighter and more saturated colors using red, green, and blue color.
- Commercial: This option applies color for printing on a commercial printing press.
- LCD: This option approximately matches the colors in the print job to the colors used by your computer monitor display screen.
- Euroscales Press: This option matches the European FOGRA glossy paper specification.
- None: This option provides no color correction.
- sRGB: This option approximates the colors in the print job to the red, green, and blue (RGB) configuration of your computer monitor display screen.

Image Shift

Image Shift allows you to modify the location of the image on the page. You can shift the printed image along the X and Y axes of each sheet of paper.

Color Adjustments

Use Color Adjustments to adjust particular characteristics of the printed color. Characteristics include lightness, contrast, saturation, and color cast.
Note: Not all options listed are supported on all printers. Some options apply only to a specific printer model, configuration, operating system, or driver type.

Lightness
The Lightness feature allows you to adjust the overall lightness or darkness of the text and images in your printed job.

Contrast
You can use the Contrast feature to adjust the variation between light and dark areas of the print job.

Saturation
Saturation allows you to adjust the color strength and the amount of gray in the color.

Color Cast
Use Color Cast settings to adjust the amount of a selected color in the print job while preserving lightness.

The following options are available:

- The Cyan to Red option allows you to adjust the color balance between cyan and red. For example, when you increase the cyan levels, the red levels decrease.
- The Magenta to Green option allows you to adjust the color balance between magenta and green. For example, when you increase the magenta levels, the green levels decrease.
- The Yellow to Blue option allows you to adjust the color balance between yellow and blue. For example, when you increase the yellow levels, the blue levels decrease.

Printing Mirror Images
If the PostScript driver is installed, you can print pages as a mirror image. Images mirror left to right when printed.

Printing Multiple Pages to a Single Sheet
When printing a multiple-page document, you can print more than one page on a single sheet of paper.

To print 1, 2, 4, 6, 9, or 16 pages per side, select Pages Per Sheet on the Pages Per Sheet Page Layout tab.

- For Windows, Page Layout is on the Document Options tab.
- For Macintosh, in the Print window, Layout is on the Preview list.
To print a border around each page, select **Page Borders**.

**Printing Booklets**

With 2-sided printing, you can print a document in the form of a small booklet. You can create booklets from any paper size that is supported for 2-sided printing. The print driver automatically reduces each page image and prints four page images per sheet of paper, two page images on each side. The pages are printed in the correct order so that you can fold and staple the pages to create the booklet.

- For Windows, Booklet Layout is on the Page Layout tab. Page Layout is on the Document Options tab.
- For Macintosh, in the Print window, in Xerox Features, Booklet Layout is on the Paper/Output list.

When you print booklets using the Windows PostScript or Macintosh driver, you can specify the gutter and creep.

- **Gutter**: Specifies the horizontal distance in points between the page images. A point is 0.35 mm (1/72 in.).
- **Creep**: Specifies how much the page images shift outward in tenths of a point. Shifting compensates for the thickness of the folded paper, which can cause the page images to shift outward slightly when folded. You can select a value from zero to 1 point.

**Selecting Finisher Options**

With the optional finisher option installed on the printer, you can request stapled documents right from your desktop computer. The stapler can staple up to 30 sheets of 105 g/m².

1. From the **Printing Options** tab, locate the **Finishing** option, then select **1 Staple**.
2. Click **OK**.
   
   The stapled prints are delivered to the finisher unit.
Selecting Mailbox Options
With the optional mailbox option installed on the printer, you can send prints to a specific mailbox bin right from your desktop computer.

1. From the Printing Options tab, locate the Output Destination option, then select one of the mailbox bins.
2. Click OK.
   The prints are delivered to the selected mailbox bin.

Using Special Pages
The Special Pages options control how covers, inserts, and exception pages are added to your printed document.

- For Windows, the Special Pages tab is on the Document Options tab.
- For Macintosh, in the Print window, in Xerox Features, Special Pages is in the Paper field for Paper/Output.

Printing Cover Pages
A cover page is the first or last page of a document. You can select paper sources for the cover pages that are different from the source used for the body of a document. For example, you can use your company letterhead for the first page of a document. You can also use heavyweight paper for the first and last pages of a report. You can use any applicable paper tray as the source for printing cover pages.

Select one of these options for printing cover pages:

- **No Covers**: This option does not print cover pages. No cover pages are added to the document.
- **Front Only**: This option prints the first page on paper from the specified tray.
- **Back Only**: This option prints the back page on paper from the specified tray.
- **Front and Back: Same** prints the front and back cover pages from the same tray.
- **Front and Back: Different** prints the front and back cover pages from different trays.

After making a selection for printing the cover pages, you can select the paper for the front and back covers by size, color, or type. You can also use blank or pre-printed paper, and you can print side one, side two, or both sides of the cover pages.

Printing Insert Pages
You can add blank or pre-printed insert pages before page one of each document or after designated pages within a document. Adding an insert after designated pages within a document separates sections, or acts as a marker or placeholder. Ensure that you specify the paper to use for the insert pages.

- **Insert Options** provides the options to place an insert After Page X, where X is the specified page, or Before Page 1.
- **Insert Quantity** specifies the number of pages to insert at each location.
Printing

- **Pages**: Specifies the page or range of pages that use the exception page characteristics. Separate individual pages or page ranges with commas. Specify pages within a range with a hyphen. For example, to specify pages 1, 6, 9, 10, and 11, type `1,6,9-11`.
- **Paper**: Displays the default size, color, and type of paper selected in Use Job Settings.
- **Job Setting**: Displays the attributes of the paper for the remainder of the job.

### Printing Exception Pages

Exception pages have different settings from the rest of the pages in the job. You can specify differences such as page size, page type, and page color. You can also change the side of the paper on which to print as your job requires. A print job can contain multiple exceptions.

For example, your print job contains 30 pages. You want five pages to print on only one side of a special paper, and the remainder of the pages printed 2-sided on regular paper. You can use exception pages to print the job.

In the Add Exceptions window, you can set the characteristics of the exception pages and select the alternate paper source:

- **Pages**: Specifies the page or range of pages that use the exception page characteristics. Separate individual pages or page ranges with commas. Specify pages within a range with a hyphen. For example, to specify pages 1, 6, 9, 10, and 11, type `1,6,9-11`.
- **Paper**: Displays the default size, color, and type of paper selected in Use Job Settings.
- **2-Sided Printing** allows you to select 2-sided printing options. Click the **Down** arrow to select an option:
  - **1-Sided Print** prints the exception pages on one side only.
  - **2-Sided Print** prints the exception pages on both sides of the paper and flips the pages on the long edge. The job then can be bound on the long edge of the pages.
  - **2-Sided Print, Flip on Short Edge** prints the exception pages on both sides of the paper and flips the pages on the short edge. The job then can be bound on the short edge of the pages.
  - **Use Job Setting** prints the job using the attributes shown in the Job Settings box.
- **Job Setting**: Displays the attributes of the paper for the remainder of the job.

Note: Some combinations of 2-sided printing with certain paper types and sizes can produce unexpected results.

### Printing Watermarks for Windows

A watermark is special-purpose text that can be printed across one or more pages. For example, you can add a word like Copy, Draft, or Confidential as a watermark instead of stamping it on a document before distribution.

Note:

- This feature is available only on a Windows computer printing to a network printer.
- Not all options listed are supported on all printers. Some options apply only to a specific printer model, configuration, operating system, or print driver type.
• Watermarks are not supported for some print drivers when booklet is selected or when more than one page is printed on a sheet of paper.

To print a watermark:
1. In the print driver, click the **Document Options** tab.
2. Click the **Watermark** tab.
3. From the Watermark menu, select the watermark. You can choose from preset watermarks, or create a customized watermark. You can also manage watermarks from this menu.
4. Under Text, select an option:
   • **Text**: Enter the text in the field, then specify the font.
   • **Time Stamp**: Specify the date and time options, then specify the font.
   • **Picture**: To locate the picture, click the **Browse** icon.
5. Specify the scaling angle and position of the watermark:
   • Select the scaling option that specifies the size of the picture in relation to the original image. Use the arrows to scale the image in increments of 1%.
   • To define the angle of the image on the page, specify the position option or to rotate the image left or right by increments of 1, use the arrows.
   • To define the location of the image on the page, specify the position option, or to move the image in each direction in increments of 1, use the arrows.
6. Under Layering, select how to print the watermark:
   • **Print in Background**: This option prints the watermark behind the text and graphics in the document.
   • **Blend**: This option combines the watermark with the text and graphics in the document. A blended watermark is translucent, so you can see both the watermark and the document content.
   • **Print in Foreground**: This option prints the watermark over the text and graphics in the document.
7. Click **Pages**, then select the pages to print the watermark:
   • **Print on All Pages**: This option prints the watermark on all pages of your document.
   • **Print on Page 1 Only**: This option prints the watermark only on the first page of the document.
8. If you select a picture as a watermark, specify the lightness settings for the image.
9. Click **OK**.

**Orientation**

Orientation allows you to select the direction that the page prints.

• For Windows, the Orientation tab is on the Document Options tab.

  **Note**: The orientation setting in your application print dialog box may override the orientation options in the print driver.

• For Macintosh, Orientation options are in the Print window.

The following options are available:

• **Portrait**: Orients the paper so that the text and images print across the short dimension of the paper.
Printing

- **Landscape**: Orient the paper so that the text and images print across the long dimension of the paper.

- **Rotated Landscape**: Orient the paper so that the content is rotated 180 degrees and with the long bottom side up.

  > Note: For Macintosh, to print portrait text and images in landscape orientation, clear the Auto Rotate check box.

**Printing Banner Pages**

To enable or disable Banner Pages, contact your system administrator, or see the *System Administrator Guide* at www.xerox.com/office/VLC600docs.

**Selecting Job Completion Notification for Windows**

You can select to be notified when your job finishes printing. A message appears on your computer screen with the name of the job and the name of the printer where it was printed.

> Note: This feature is only available on a Windows computer printing to a network printer.

To select job completion notification from the Advanced tab:

1. Click **Notifications**.
2. Click **Notify for Completed Jobs**, then select an option.
   - **Enabled**: This option turns on notifications.
   - **Disabled**: This option turns off the Notification feature.
3. Click **OK**.
Using Custom Paper Sizes

You can print on custom paper sizes that are within the minimum and maximum size range supported by the printer. For more information, refer to Supported Custom Paper Sizes.

Printing on Custom Paper Sizes

Note: Before printing on a custom paper size, use the Custom Paper Sizes feature in Printer Properties to define the custom size. For more information, refer to Defining Custom Paper Sizes.

Printing on Custom Paper Size from Windows

Note: Before printing on custom-size paper, define the custom size in the Printer Properties.

1. Load the custom-size paper in the tray.
2. In the application, click File→Print, then select your printer.
3. In the Print dialog box, click Printer Properties.
4. On the Printing Options tab, from the Paper list, select the required custom paper size and type.
5. Select any other required options, then click OK.
6. In the Print dialog box, click Print.

Printing on Custom-Size Paper from a Macintosh Computer

1. Load the custom-size paper.
2. In the application, click File→Print.
3. From the Paper Size list, select the custom paper size.
4. Click Print.

Defining Custom Paper Sizes

To print custom paper sizes, define the custom width and length of the paper in the print driver software and on the printer control panel. When setting the paper size, ensure that you specify the same size as the paper in the tray. Setting the wrong size paper can cause a printer error. Print driver settings override control panel settings when you print using the print driver software on your computer.

Creating and Saving Custom Paper Sizes in the Print Driver

You can print custom-size paper from any paper tray. Custom-size paper settings are saved in the print driver and are available for you to select in all your applications. For more information on supported paper sizes for each tray, refer to Supported Custom Paper Sizes.
Creating and Saving Custom Sizes for Windows

1. In the print driver, click the Printing Options tab.
2. For Paper, click the arrow, then select Other Size → Advanced Paper Size → Output Paper Size → New.
3. In the New Custom Paper Size window, enter the height and width of the new paper size.
4. To specify the units of measurement, at the bottom of the window, click the Measurements button, then select Inches or Millimeters.
5. To save, in the Name field, type a title for the new size, then click OK.

Creating and Saving Custom Sizes for Macintosh

1. In the application, click File → Print.
2. Click Paper Size, then select Manage Custom Sizes.
3. To add a new size, in the Manage Paper Sizes window, click the Plus icon (+).
4. Double-click Untitled, then type a name for the new custom paper size.
5. Enter the height and width of the new custom paper size.
6. Click the arrow for the Non-Printable Area field, then select the printer from the list. Or, for User Defined margins, set the top, bottom, right, and left margins.
7. To save the settings, click OK.

Defining a Custom Paper Size at the Control Panel

You can print custom-size paper from any paper tray. Custom-size paper settings are saved in the print driver and are available for you to select in all your applications.

1. At the printer control panel, press the Home button.
2. Touch Device → Paper Trays.
3. Touch the desired tray for your custom-size paper.
4. Touch the current paper size setting, then from the list, touch Custom.
5. In the Custom Paper Size screen, enter the height and width of the new paper size.
6. To save the setting, touch OK.
7. To return to the Home screen, press the Home button.
Paper and Media

This chapter contains:

- Paper and Media Overview ................................................................. 96
- Supported Paper .................................................................................. 97
- Loading Paper ...................................................................................... 102
- Printing on Special Paper ................................................................. 114
Paper and Media Overview

Your printer is designed to use various paper and other media types. Follow the guidelines in this section for the best print quality and to avoid jams:

- Use only Xerox approved paper. For details, refer to Supported Paper.
- Use only dry, undamaged paper.
- Some paper and other media types can cause poor output quality, increased paper jams, or damage your printer. Refer to Paper That Can Damage Your Printer.
- Ensure that the paper type selected in your print driver matches the paper type on which you are printing.
- If you have the same size paper loaded in more than one tray, ensure that the proper tray is selected in the print driver.
- Store your paper and other media properly for optimum print quality. For details, refer to Paper Storage Guidelines.
Supported Paper

Your printer is designed to use various paper and other media types. To ensure the best print quality and to avoid jams, follow the guidelines in this section. For best results, use Xerox paper and media recommended for your printer.

Recommended Media

A list of paper and media recommended for your printer is available at:

- [www.xerox.com/rmlna](http://www.xerox.com/rmlna) Recommended Media List (United States)
- [www.xerox.com/rmleu](http://www.xerox.com/rmleu) Recommended Media List (Europe)

Ordering Paper

To order paper or other media, contact your local reseller or visit [www.xerox.com/supplies](http://www.xerox.com/supplies).

General Paper Loading Guidelines

- Do not overfill the paper trays. Do not load paper above the maximum fill line in the tray.
- Adjust the paper guides to fit the paper size.
- Fan paper before loading it in the paper tray.
- If excessive jams occur, use paper or other approved media from a new package.
- Do not print on label media after a label has been removed from a sheet.
- Use only paper envelopes. Print envelopes 1-sided only.

Paper That Can Damage Your Printer

Some paper and other media types can cause poor output quality, increased paper jams, or damage your printer. Do not use the following:

- Rough or porous paper
- Inkjet paper
- Non-laser glossy or coated paper
- Paper that has been photocopied
- Paper that has been folded or wrinkled
- Paper with cutouts or perforations
- Stapled paper
- Envelopes with windows, metal clasps, side seams, or adhesives with release strips
- Padded envelopes
- Plastic media
- Transparencies
Paper Storage Guidelines

Storing your paper and other media properly contributes to optimum print quality.

- Store paper in dark, cool, relatively dry locations. Most paper is susceptible to damage from ultraviolet and visible light. Ultraviolet light, from the sun and fluorescent bulbs, is particularly damaging to paper.
- Reduce the exposure of paper to strong lights for long periods of time.
- Maintain constant temperatures and relative humidity.
- Avoid storing paper in attics, kitchens, garages, or basements. These spaces are more likely to collect moisture.
- Store paper flat, either on pallets, cartons, shelves, or in cabinets.
- Avoid food or drinks in the area where paper is stored or handled.
- Do not open sealed packages of paper until you are ready to load the paper into the printer. Leave stored paper in the original packaging. The paper wrapper protects the paper from moisture loss or gain.
- Some special media is packaged inside resealable plastic bags. Store the media inside the bag until you are ready to use it. Keep unused media in the bag and reseal it for protection.

Supported Paper Types and Weights

<table>
<thead>
<tr>
<th>Trays</th>
<th>Paper Types</th>
<th>Weights</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tray 1 and Trays 2–5</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ByPass Tray</td>
<td>Recycled</td>
<td>60–80 g/m²</td>
</tr>
<tr>
<td></td>
<td>Custom</td>
<td>60–90 g/m²</td>
</tr>
<tr>
<td></td>
<td>Bond</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Hole-Punched</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Letterhead</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Plain</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Pre-Printed</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Lightweight Cardstock</td>
<td>75–105 g/m²</td>
</tr>
<tr>
<td></td>
<td>Lightweight Glossy Cardstock</td>
<td>106–176 g/m²</td>
</tr>
<tr>
<td></td>
<td>Cardstock</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Glossy Cardstock</td>
<td>177–220 g/m²</td>
</tr>
<tr>
<td></td>
<td>Labels</td>
<td></td>
</tr>
<tr>
<td>High Capacity Feeder (HCF)</td>
<td>Recycled</td>
<td>60–80 g/m²</td>
</tr>
</tbody>
</table>
## Supported Paper Types and Weights for Automatic 2-Sided Printing

<table>
<thead>
<tr>
<th>Paper Type</th>
<th>Weight</th>
</tr>
</thead>
<tbody>
<tr>
<td>Recycled</td>
<td>60–80 g/m²</td>
</tr>
<tr>
<td>Custom</td>
<td>60–90 g/m²</td>
</tr>
<tr>
<td>Bond</td>
<td>75–105 g/m²</td>
</tr>
<tr>
<td>Hole-Punched</td>
<td></td>
</tr>
<tr>
<td>Letterhead</td>
<td></td>
</tr>
<tr>
<td>Plain</td>
<td></td>
</tr>
<tr>
<td>Pre-Printed</td>
<td></td>
</tr>
<tr>
<td>Lightweight Cardstock</td>
<td>106–176 g/m²</td>
</tr>
<tr>
<td>Lightweight Glossy Cardstock</td>
<td></td>
</tr>
</tbody>
</table>

## Supported Standard Paper Sizes

The paper sizes below are automatically detected in the paper trays and are available as a size selection.
### Paper and Media

<table>
<thead>
<tr>
<th>Tray</th>
<th>European Standard Sizes</th>
<th>North American Standard Sizes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bypass Tray</td>
<td>A6 (105 x 148 mm, 4.1 x 5.8 in.) A5 (148 x 210 mm, 5.8 x 8.3 in.) A4 (210 x 297 mm, 8.3 x 11.7 in.) 215 x 315 mm DL Envelope (110 x 220 mm, 4.33 x 8.66 in.) C5 Envelope (162 x 229 mm, 6.4 x 9 in.) B5 ISO (176 x 250 mm, 6.9 x 9.8 in.)</td>
<td>Postcard (102 x 152 mm, 4 x 6 in.) 127 x 178 mm, 5 x 7 in. Statement (140 x 216 mm, 5.5 x 8.5 in.) Executive (184 x 267 mm, 7.25 x 10.5 in.) 203 x 254 mm, 8 x 10 in. Letter (216 x 279 mm, 8.5 x 11 in.) Folio (216 x 330 mm, 8.5 x 13 in.) Legal (216 x 356 mm, 8.5 x 14 in.) Monarch Envelope (98 x 190 mm, 3.9 x 7.5 in.) No. 10 Envelope (241 x 105 mm, 4.1 x 9.5 in.)</td>
</tr>
<tr>
<td>Tray 1 and Trays 2–5</td>
<td>A5 (148 x 210 mm, 5.8 x 8.3 in.) A4 (210 x 297 mm, 8.3 x 11.7 in.) B5 ISO (176 x 250 mm, 6.9 x 9.8 in.)</td>
<td>Executive (184 x 267 mm, 7.25 x 10.5 in.) Letter (216 x 279 mm, 8.5 x 11 in.) Legal (216 x 356 mm, 8.5 x 14 in.) Folio (216 x 330 mm, 8.5 x 13 in.)</td>
</tr>
<tr>
<td>High Capacity Feeder (HCF)</td>
<td>A4 (210 x 297 mm, 8.3 x 11.7 in.)</td>
<td>Letter (216 x 279 mm, 8.5 x 11 in.)</td>
</tr>
</tbody>
</table>

#### Supported Standard Paper Sizes for Automatic 2-Sided Printing

<table>
<thead>
<tr>
<th>European Standard Sizes</th>
<th>North American Standard Sizes</th>
</tr>
</thead>
<tbody>
<tr>
<td>A4 (210 x 297 mm, 8.3 x 11.7 in.) A5 (148 x 210 mm, 5.8 x 8.3 in.) 215 x 315 mm, 8.5 x 12.4 in. B5 ISO (176 x 250 mm, 6.9 x 9.8 in.)</td>
<td>Legal (216 x 356 mm, 8.5 x 14 in.) Letter (216 x 279 mm, 8.5 x 11 in.) Folio (216 x 330 mm, 8.5 x 13 in.) Executive (184 x 267 mm, 7.25 x 10.5 in.) 203 x 254 mm, 8 x 10 in.</td>
</tr>
</tbody>
</table>

#### Supported Custom Paper Sizes

<table>
<thead>
<tr>
<th>Tray Number</th>
<th>Paper Sizes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tray 1</td>
<td>Minimum: 76 x 190 mm (3 x 7.5 in.) Maximum: 216 x 356 mm (8.5 x 14 in.)</td>
</tr>
<tr>
<td>Trays 2–5</td>
<td>Minimum: 76 x 190 mm (3 x 7.5 in.) Maximum: 216 x 356 mm (8.5 x 14 in.)</td>
</tr>
<tr>
<td>Bypass Tray</td>
<td>Minimum: 76 x 127 mm (3 x 5 in.) Maximum: 216 x 356 mm (8.5 x 14 in.)</td>
</tr>
<tr>
<td>Tray Number</td>
<td>Paper Sizes</td>
</tr>
<tr>
<td>------------------------------------------------</td>
<td>--------------------------------------------</td>
</tr>
<tr>
<td>High Capacity Feeder (HCF)</td>
<td>A4 or Letter only</td>
</tr>
<tr>
<td>2-Sided Printing, not available on the N model</td>
<td>Minimum: 140 x 203 mm (5.5 x 8.0 in.)</td>
</tr>
<tr>
<td></td>
<td>Maximum: 216 x 356 mm (8.5 x 14 in.)</td>
</tr>
</tbody>
</table>

**Changing Paper Settings**

When you load paper into a tray, you can change the tray settings. The following options are available:

- **Fully Adjustable**: If you select this paper setting, you can change the paper size, type, and color when you load paper into the tray.

- **Dedicated**: If you select this paper setting, you cannot change the paper size, type, and color when you load paper into the tray.

- **Bypass**: When paper is present in this tray, it is used for print jobs where you did not specify a particular tray.

For more information on how to change the paper setting when loading paper in trays 1-5, refer to [Loading Paper in Trays 1–5](#). For more information on how to change the paper setting when loading paper in the bypass tray, refer to [Loading Paper in the Bypass Tray](#).
Loading Paper

Loading Paper in the Bypass Tray

To load paper in the Bypass Tray:

1. Open the Bypass Tray. If the Bypass Tray is loaded with paper already, remove any paper that is a different size or type.

2. Pull out the extension tray for larger sizes.

3. Move the width guides to the edges of the tray.
4. Flex the sheets back and forth and fan them, then align the edges of the stack on a level surface. This procedure separates any sheets that are stuck together and reduces the possibility of jams.

Note: To avoid jams and misfeeds, do not remove paper from its packaging until you are ready to use the paper.
5. Load the paper in the tray.

Note: Do not load paper above the maximum fill line on the width guides. Overfilling the tray can cause the printer to jam.

- Load hole-punched paper with the holes to the left.

- For 1-sided printing, load letterhead or pre-printed paper face up with the top edge going into the printer.

- For 2-sided printing, load letterhead and pre-printed paper face down with the top edge going into the printer.
6. Adjust the width guides until they touch the edges of the paper.

7. The printer prompts you to verify the paper type, size and color.
   a. If the paper type, size and color are correct, touch **OK**.
   b. If the paper type, size or color are incorrect, change the settings.
      • To select a paper type, touch the current paper type, then from the list, select the type.
      • To select a sheet size, touch the current size setting, then from the list, select the size.
      • To select a different paper color, touch the current paper color, then from the list, select the color.
   c. To save the settings, touch **OK**.
Configuring Tray 1 and Trays 2–5 for the Paper Length

You can adjust the length of the trays to accommodate A4, Letter (8.5 x 11 in.), and Legal (8.5 x 14 in.) paper sizes. When you use the Legal-length paper setting, the paper tray protrudes from the front of the printer.

To change the trays to match the paper length:

1. To remove the tray from the printer, pull out the tray until it stops. Lift the front of the tray slightly, then pull it out.

2. Remove all paper from the tray.

3. To compress the tray for shorter paper, hold the back of the tray with one hand. With the other hand, press the release latch at the front of the tray, then push the ends inward until they latch.

4. To extend the tray for longer paper, hold the back of the tray with one hand. With the other hand, press the release latch at the front of the tray, then pull the ends outward until they latch.
5. To protect the paper when the tray is extended, place the tray cover over the extended section of the paper tray.

6. Load paper into the tray before inserting it back into the printer.
Loading Paper in Trays 1–5

To load paper in Tray 1 and optional Trays 2–5:

1. To remove the tray from the printer, pull out the tray until it stops. Lift the front of the tray slightly and then pull out the tray completely.

2. Adjust the paper length and width guides as illustrated.

3. For Legal-size paper, to extend the front of the tray, press the green release latch, then pull the tray out.
4. Flex the sheets back and forth and fan them, then align the edges of the stack on a level surface. This procedure separates any sheets that are stuck together and reduces the possibility of jams.

5. Load paper into the tray with the print-side face up.
   - Load hole-punched paper with the holes to the left.
   - Load label-sheets in the tray face up.
   - For 1-sided printing, load letterhead paper face up with the top of the paper toward the back of the tray.
   - For 2-sided printing, load letterhead and pre-printed paper face down with the top edge feeding into the printer.

   **Note:** Do not load paper above the maximum fill line. Overfilling the tray can cause the printer to jam.

6. Adjust the length and width guides to fit the paper.
7. Insert the tray into the printer.

![Inserting tray into printer](image)

> **Note:** To avoid paper jams, do not remove the paper cover while printing is in progress.

8. If the tray is extended for Legal-size paper, the tray protrudes when it is fully inserted into the printer. You can place a cover over the area protruding out of the tray.

![Tray protruding](image)

9. If the Tray Mode is set to Fully Adjustable, the printer prompts you to set the paper type, size, and color.
   
a. If the paper type, size and color are correct, touch **OK**.
   
b. If the paper type, size or color are incorrect, change the settings.
   
   - To select a paper type, touch the current paper type, then from the list, select the type.
   
   - To select a sheet size, touch the current size setting, then from the list, select the size.
   
   - To select a different paper color, touch the current paper color, then from the list, select the color.
   
   c. To save the settings, touch **OK**.

10. To change a paper tray to Dedicated mode:
   
a. At the printer control panel, press the **Home** button.
   
b. Touch **Device → Paper Trays**.
   
c. Touch the appropriate tray.
   
d. To dedicate the tray for a paper size, type, or color, touch **Tray Mode**, then touch **Dedicated**.
   
   - To select a paper size, touch the current size setting, then select a size.
   
   - To select a paper type, touch the current paper type, then select a paper type.
To select a paper color, touch the current paper color, then select a paper color.

e. To save the settings, touch **OK**.

f. To return to the Home screen, press the **Home** button.

## Loading Paper in the High Capacity Feeder (HCF)

The High Capacity Feeder (HCF) tray accommodates 8.5 x 11 in. / A4 paper only and is loaded in the short-edge feed (SEF) direction.

1. Pull out the tray slowly until it stops.

2. Flex the sheets back and forth and fan the sheets before loading them into the tray.
3. Load the paper into the tray.

Note: Do not load paper above the maximum fill line. Overfilling the tray can cause the printer to jam.

4. Push in the tray until it stops.

5. If the Tray Mode is set to Fully Adjustable, the printer prompts you to set the paper type, size and color.
   a. If the paper type, size and color are correct, touch OK.
   b. If the paper type, size or color are incorrect, change the settings.
      - To select a paper type, touch the current paper type, then from the list, select the type.
      - To select a paper size, touch the current paper size, then from the list, select the size.
      - To select a different paper color, touch the current paper color, then from the list, select the color.
   c. To save the settings, touch OK.
Setting the Tray Mode

Tray Mode determines if you are prompted to confirm or modify paper settings when you load paper in the tray. Tray Mode defines how the printer behaves when a paper conflict or mismatch occurs.

To configure the Bypass Tray Mode:

1. At the printer control panel, press the **Home** button.
2. Touch **Device** → **Paper Trays**.
3. Touch the **Bypass Tray** icon. It is displayed in the top position, before the numbered trays.
4. Touch **Tray Mode**.
5. Touch the desired mode:
   - **Bypass** prompts you to confirm or modify paper tray settings when paper is loaded in the Bypass Tray. The Bypass Tray Mode sets the Bypass Tray as the default tray for all print jobs without a specified tray.
   - **Fully Adjustable** prompts you to confirm or modify paper tray settings when paper is loaded in the Bypass Tray.
6. To save the setting, touch **OK**.
7. To return to the Home screen, press the **Home** button.

Configuring the Tray Mode for Trays 1–5

1. At the printer control panel, press the **Home** button.
2. Touch **Device** → **Paper Trays**.
3. Touch the desired tray.
4. Touch **Tray Mode**.
5. Touch the desired mode:
   - **Fully Adjustable** prompts you to confirm or modify paper tray settings when paper is loaded in a tray.
   - **Dedicated** uses the current paper size and type settings and does not prompt you to confirm or modify the settings. Select this setting to use a tray for printing on a specific paper type and size, such as letter-size or hole-punched paper.
6. To save the setting, touch **OK**.
7. To return to the Home screen, press the **Home** button.
Printing on Special Paper

To order paper or other media, contact your local reseller or visit www.xerox.com/supplies.

For reference:
- www.xerox.com/rmlna Recommended Media List (United States)
- www.xerox.com/rmleu Recommended Media List (Europe)

Envelopes

You can print envelopes from Tray 1 or the Bypass Tray.

Guidelines for Printing Envelopes

- Use only paper envelopes.
- Do not use envelopes with windows or metal clasps.
- Print quality depends on the quality and construction of the envelopes. If you do not get the desired results, try another envelope brand.
- Maintain constant temperatures and relative humidity.
- Store unused envelopes in their packaging to avoid excess moisture and dryness which can affect print quality and cause wrinkling. Excessive moisture can cause the envelopes to seal before or during printing.
- Remove air bubbles from the envelopes before loading them into the tray by setting a heavy book on top of the envelopes.
- In the print driver software, select Envelope as the paper type.
- Do not use padded envelopes. Use envelopes that lie flat on a surface.
- Do not use envelopes with heat-activated glue.
- Do not use envelopes with press-and-seal flaps.
Loading Envelopes in the Bypass Tray

1. Open the Bypass Tray.

2. Pull out the extension tray for larger sizes.
3. Move the width guides to the edges of the tray.

![Image of printer tray with width guides moved to edges]

**Note:**

- To prevent jams, ensure that the leading edge of the envelopes are flat or have only a slight upward curl, less than 5 mm (.19 in.), before loading into the tray. If the edge is curled or swollen, fold it over to decurl. The length of the curl must be within 8–10 mm (.31–.39 in.). Downward curl at the leading edge of envelopes is not acceptable and can cause a jam or misfeed.
- Load envelopes up to 16.5 mm (.65 in.) in height. This is approximately 10–20 envelopes, depending on brand, size, and texture.
- If you do not load envelopes in the Bypass Tray right after you have removed the envelopes from the packaging, the envelopes can bulge. To avoid jams, flatten the envelopes before loading them into the tray.

4. To load the envelopes, select an option:
• For Number 10 envelopes, load the envelopes with the short edge going into the printer, flaps down, and flaps to the right.

• For Monarch or DL envelopes, perform one of the following steps. If the envelopes wrinkle, try another option.
  • Load envelopes with the short edge going into the printer, flaps down, and flaps to the right.
  • Load envelopes with the print-side up, flaps open and down, and the bottom of the envelope going into the printer.
• Load envelopes with the print-side up, flaps closed and down, and flaps going into the printer.

• For C5 envelopes, perform one of the following steps. If the envelopes wrinkle, try the other option.
  • Load envelopes with the print-side up, flaps open and down, and the bottom of the envelope going into the printer.

• Load envelopes with the print-side up, flaps closed and down, and short edge going into the printer.

Note: For envelopes to print correctly, when you load envelopes with the flaps open, in the print driver, set the orientation as needed. To flip the images, in the print driver, select **Rotate Image 180 Degrees**.

5. Adjust the width guides until they touch the edges of the envelopes.
6. The printer prompts you to verify the paper type, size and color.
a. If the paper type, size and color are correct, touch **OK**.
b. If the paper type, size or color are incorrect, change the settings.
   • To select a paper type, touch the current paper type, then from the list, select **Envelope**.
   • To select a size, touch the current size setting, then from the list, select the size.
   • To select an envelope color, touch the current paper color, then from the list, select the color.
c. To save the settings, touch **OK**.

### Loading Envelopes in Tray 1

1. To remove the tray from the printer, pull out the tray until it stops. Lift the front of the tray slightly, then pull it out.

2. Remove any paper in the tray.

3. Adjust the paper length and width guides as illustrated.

4. Load envelopes in the trays with the flaps closed, flap-side down, and the short edge leading into the printer.
   
   **Note:** Do not load more than 50 envelopes into the tray, up to 45 mm (1.8 in.) in height.

5. Adjust the width guides until they touch the edges of the envelopes.

6. Slide the tray all the way into the printer.
7. If the Tray Mode is set to Fully Adjustable, the printer prompts you to set the paper type, size and color.
   a. If the paper type, size and color are correct, touch **OK**.
   b. If the paper type, size or color are incorrect, change the settings.
      • To select a paper type, touch the current paper type, then from the list, select **Envelope**.
      • To select a size, touch the current size setting, then from the list, select **Custom**. Touch the Length field and select a number value. Touch the Width field and select a number value. Select **OK**.
      • To select a different color, touch the current paper color, then from the list, select the color.
   c. To save the settings, touch **OK**.
8. From the Print dialog at your workstation, select the paper setting values and click **OK**. To feed and print the envelopes, click **Print**.

Labels

You can print labels from the Bypass Tray or Tray 1.

Guidelines for Printing Labels

- Use labels designed for laser printing.
- Do not use vinyl labels.
- Do not feed a sheet of labels through the printer more than once.
- Do not use dry gum labels.
- Print only on one side of the sheet of labels. Use full-sheet labels only.
- Store unused labels flat in their original packaging. Leave the label sheets inside the original packaging until ready to use. Return any unused label sheets to the original packaging and reseal it.
- Do not store labels in extremely dry or humid conditions or extremely hot or cold conditions. Storing labels in extreme conditions can cause print-quality problems or cause labels to jam in the printer.
- Rotate stock frequently. Long periods of storage in extreme conditions can cause labels to curl and jam in the printer.
• In the print driver software, select Label as the paper type.
• Before loading labels, remove all other paper from the tray.

**WARNING:**

Do not use any sheet where labels are missing, curled, or pulled away from the backing sheet. It could damage the printer.

**Loading Labels in the Bypass Tray**

1. Open the Bypass Tray. If the tray is already open, remove all paper from the tray.

2. Pull out the extension tray for larger sizes.
3. Move the width guides to the edges of the tray.

4. Load sheet-labels in the Bypass Tray, face up, with the top edge of the page feeding into the printer first.

5. Adjust the width guides until they touch the edges of the paper.

6. The printer prompts you to verify the type, size and color of the label sheets.
   a. If the type, size and color are correct, touch **OK**.
   b. If the type, size or color are incorrect, change the settings.
      - To select the type, touch the current paper type, then from the list, select **Labels**.
      - To select a size, touch the current size setting, then from the list, select a size.
      - To select the color, touch the current paper color, then from the list, select a color.
   c. To save the settings, touch **OK**.
Loading Labels in Tray 1

1. To remove the tray from the printer, pull out the tray until it stops. Lift the front of the tray slightly, then pull it out.

2. Adjust the paper length and width guides.

3. Load the label sheets in the tray, face up.

   **Note:** Do not load paper above the maximum fill line. Overfilling can cause paper jams.

4. Slide the tray back into the printer.

5. Push the tray in all the way.

6. If the Tray Mode is set to Fully Adjustable, the printer prompts you to set the label sheet size, type and color.
   a. If the paper size, type and color are correct, touch **OK**.
Paper and Media

b. If the paper size, type or color are incorrect, change the settings.
   - To select a sheet size, touch the current size setting, then from the list, select the size.
   - To select the paper type, touch the current paper type, then from the list, select Labels.
   - To select a different color, touch the current color, then from the list, select the color.

c. To save the settings, touch OK.

Glossy Cardstock

You can print Cardstock and Glossy Cardstock up to 220 g/m² from the Bypass tray and Trays 1-5. For types and weights of supported Cardstock, refer to Supported Paper Types and Weights.

Guidelines for Printing on Glossy Cardstock

- Do not open sealed packages of glossy cardstock until you are ready to load paper into the printer.
- Leave glossy cardstock in the original wrapper, and leave the packages in the shipping carton until ready to use.
- Remove all other paper from the tray before loading glossy cardstock.
- Load only the amount of glossy cardstock you are planning to use. When you are finished printing, remove the cardstock from the paper tray. Replace unused cardstock in the original wrapper and seal.
- Rotate stock frequently. Long periods of storage in extreme conditions can cause glossy cardstock to curl and jam in the printer.
- In the print driver software, select the glossy cardstock type, or select the tray loaded with the required paper.
Maintenance

This chapter contains:

- General Precautions ................................................................. 126
- Cleaning the Printer .................................................................. 127
- Adjustments and Maintenance Procedures ............................ 135
- Supplies .................................................................................. 139
- Managing the Printer ............................................................... 142
- Moving the Printer .................................................................... 143
General Precautions

**WARNING:**

- Internal parts of the printer can be hot. Use caution when doors and covers are open.
- Keep all cleaning materials out of the reach of children.
- Do not use pressurized spray cleaning aids on or in the printer. Some pressurized sprays contain explosive mixtures and are not suitable for use in electrical applications. Use of pressurized spray cleaners increases the risk of fire and explosion.
- Do not remove the covers or guards that are fastened with screws. You cannot maintain or service any parts that are behind these covers and guards. Do not attempt any maintenance procedure that is not described in the documentation supplied with your printer.

**Caution:**

- When cleaning your printer do not use organic or strong chemical solvents or aerosol cleaners. Do not pour fluids directly into any area. Use supplies and cleaning materials only as directed in this documentation.
- Do not place anything on top of the printer.
- Do not leave the covers and doors open for any length of time, especially in well-lighted places. Light exposure can damage the drum cartridges.
- Do not open covers and doors during printing.
- Do not tilt the printer while it is in use.
- Do not touch the electrical contacts or gears. Doing so could damage the printer and cause the print quality to deteriorate.
- Ensure that any parts removed during cleaning are replaced before you plug in the printer.
Cleaning the Printer

Cleaning the Exterior

Clean the exterior of the printer once a month.

- Wipe the paper tray, output tray, control panel, and other parts with a damp, soft cloth.
- After cleaning, wipe with a dry, soft cloth.
- For stubborn stains, apply a small amount of mild detergent to the cloth and gently wipe the stain off.

⚠️ Caution: Do not spray detergent directly on the printer. Liquid detergent could enter the printer through a gap and cause problems. Never use cleaning agents other than water or mild detergent.

Cleaning the Interior

⚠️ WARNING: Never touch a labeled area on or near the heat roller in the fuser. You can get burned. If a sheet of paper is wrapped around the heat roller, do not try to remove it immediately. Power off the printer immediately and wait 40 minutes for the fuser to cool. Try to remove the paper jam after the printer has cooled.

To prevent stains inside the printer that can deteriorate print quality, clean the interior of the printer regularly. Clean the printer interior whenever you replace a drum cartridge. After clearing paper jams or replacing a toner cartridge, inspect inside the printer before closing the printer covers and doors.

- Remove any remaining pieces of paper or debris.
- Remove any dust or stains with a clean, dry, lint-free cloth.
Cleaning the LED Lenses

If prints have voids or light streaks through one or more colors, use the following instructions to clean the LED lenses.

⚠️ **WARNING:** If you accidentally get toner on your clothes, lightly dust them off as best as you can. If some toner remains on your clothes, use cool water, not hot, to rinse off the toner. If toner gets on your skin, wash it off with cool water and a mild soap. If you get toner in your eyes, wash it out immediately with cool water and consult a doctor.

1. Power off the printer.

2. Open the right-side door.

3. To unlock the waste cartridge, pinch the latch.
4. To remove the waste cartridge, lower the top of the cartridge and lift it away from the printer. To prevent toner spills, keep the openings facing up.

Note:

- Be careful not to spill toner when handling the waste cartridge.
- After removing the waste cartridge, do not touch the area shown in the illustration.
5. Place the removed waste cartridge on a level surface, with the openings facing up.

Note: To avoid toner spills or malfunction, do not lay the waste cartridge on its side, or with the openings facing down.

6. Remove the cleaning rod from inside the printer.
7. Insert the cleaning rod into one of the four cleaning holes until it stops, then pull out the rod. Repeat this two more times.

8. Repeat the procedure for the holes in the other three slots.

9. Return the cleaning rod to its original location.
10. To reinsert the waste cartridge, lower the bottom of the cartridge into position. To lock the cartridge into place, push the top forward until the latch clicks into place.

11. Close the right-side door.
Cleaning the Color-Density Sensors

If the print or color density is too light, missing, or the background is foggy, clean the color-density sensors.

1. Power off the printer.

2. Lift the rear door release and pull open the door.
3. Use a dry cotton swab to clean the color-density sensors.

4. Close the rear door.
Adjustments and Maintenance Procedures

Color Registration
The printer automatically adjusts the color registration when automatic adjustment is enabled. You can also adjust color registration manually any time the printer is idle. You must adjust the color registration any time the printer is moved. If you are having printing problems, adjust the color registration.

Performing a Color Registration Adjustment
A color-registration adjustment occurs every time a new toner cartridge is installed. You can run this adjustment at other times as needed.
To perform a color-registration adjustment:
1. At the printer control panel, press the Home button.
2. Touch Device → Support → Color Registration.
3. To perform an Automatic Color Registration adjustment, touch Start.
4. At the successfully completed prompt, touch Close.
5. To exit the menu, touch X.
6. To return to the Home screen, press the Home button.

Adjusting Paper Registration
Use Adjust Paper Registration to adjust the placement of the printed image on the page. The adjustment allows you to place the top, bottom, left, and right margins exactly where you want. You can specify the image position on both the front and back sides of the paper, for each installed paper tray.

Verifying Paper Registration
1. At the printer control panel, press the Home button.
4. Select the source paper tray for the registration print.
   b. Touch the desired tray.
5. If your printer has automatic 2-sided printing, select the sides that you want to optimize.
   • To select a sample registration page for adjusting side 1, touch Adjusted Side, then touch Side 1.
   • To select a sample registration page for adjusting both sides, touch Adjusted Side, then touch Side 2.
6. Specify the consecutive number of sample pages to print.
a. Touch Print Settings.
b. To increase or decrease the number of sample pages, for Quantity, touch the Plus icon (+) or the Minus icon (-), then touch OK.

7. To print the sample pages, touch Print Sample.
8. When printing is completed, touch Close.
9. On the sample pages, for Side 1, use a ruler to measure the distance of the printed image from the top, bottom, left, and right edges.

   Note: For identification, a single dot is printed on Side 1, and two dots are printed on Side 2.

10. For Side 2, measure the distance of the printed image from the top, bottom, left, and right edges.
11. If the image is centered, no adjustment is required. If the image is not centered, adjust the paper registration. For more information, refer to Performing a Paper Registration Adjustment.

Performing a Paper Registration Adjustment

1. At the control panel, press the Home button.
4. To adjust registration, select the source paper tray.
   b. Touch the desired tray.
5. Using the chart printed in Verifying Paper Registration, select the side for registration.
   a. For adjusting Side 1, touch Adjusted Side, then touch Side 1.
   b. For adjusting Side 2, touch Adjusted Side, then touch Side 2.
6. To adjust the registration, touch Lead/Side Registration.
   a. To adjust the side-to-side registration, for Side Registration, touch the Plus icon (+) or the Minus icon (-).
   b. To adjust the top-to-bottom registration, for Lead Registration, touch the Plus icon (+) or the Minus icon (-).
      For reference, position the chart so that Side-1 or Side-2 dots are at the bottom of the page.
• For Lead Registration, a positive value shifts the image down the page.
• For Side Registration, a positive value shifts the image to the left.

7. To save your settings, touch OK.
8. As needed, to enter additional values, repeat the previous steps.
9. Print another sample page, then repeat the process until you complete the registration corrections.
10. To return to the Home screen, press the Home button.

Transfer Voltage Adjustment
Use Transfer Voltage Adjustment to specify the bias transfer roller voltage for printing on the selected paper type. If the printed image is too light, increase the voltage for the paper you are using. If the printed image is mottled or blotchy-looking, decrease the voltage for the paper you are using.

To adjust the transfer voltage:
1. At the printer control panel, press the Home button.
2. Touch Device → Support → Transfer Voltage Adjustment.
3. To select the paper type for the adjustment, touch Paper Type, then touch the required paper type.
4. To adjust the transfer voltage, for Voltage Level, touch the Plus icon (+) or the Minus icon (-).
5. Touch Adjust.
6. To exit the menu, touch X.
7. To return to the Home screen, press the Home button.

Adjusting the Fuser
Use Adjust Fuser for optimum print quality across a wide range of paper types. If the toner on a print is smeared or can be rubbed off the paper, increase the temperature for the paper you are using. If the toner is blistered or mottled, decrease the temperature for the paper you are using.

To adjust the fuser:
1. At the printer control panel, press the Home button.
2. Touch Device → Support → Fuser Temperature Adjustment.
3. To select the paper type, touch Paper Type, then touch the name of the paper type in the list.
4. To increase or decrease the fusing temperature, touch the arrow buttons, then touch Adjust.
5. To adjust the Fuser for another paper type, select it from the list, then repeat steps 3 and 4.
6. To exit the menu, touch X.
7. To return to the Home screen, press the Home button.

**Adjusting the Altitude**

Use Adjust Altitude to adjust the altitude to match that of the location where the printer is installed. If the altitude setting is incorrect, it can cause print-quality problems.
To adjust the altitude:
1. At the printer control panel, press the Home button.
2. Touch Device → Support → Altitude Adjustment.
3. Touch the altitude of the location of the printer, then touch OK.
4. To return to the Home screen, press the Home button.

**Performing a Developer and Transfer Roller Cleaning Procedure**

When a printer sits idle for an extended time, visible background toner can potentially appear on prints. Use the Developer and Transfer Roller Cleaning procedure to reduce background toner on prints.
To perform a Developer and Transfer Roller Cleaning procedure:
1. At the printer control panel, press the Home button.
2. Touch Device → Support → Developer & Transfer Roller Cleaning.
3. To perform a Developer and Transfer Roller Cleaning procedure, touch Start.
4. At the successfully completed prompt, touch Close.
5. To exit the menu, touch X.
6. To return to the Home screen, press the Home button.

**Performing a Transfer Belt Cleaning Mode Procedure**

Debris on the transfer belt can cause vertical black or color-streaks and lines to appear on prints. To remove black or color-streaks and lines on prints, use the Belt Cleaning Mode procedure.
To perform a Belt Cleaning Mode procedure:
1. At the printer control panel, press the Home button.
2. Touch Device → Support → Belt Cleaning Mode.
3. To perform a Belt Cleaning Mode procedure, touch Start.
4. At the successfully completed prompt, touch Close.
5. To exit the menu, touch X.
6. To return to the Home screen, press the Home button.
Supplies

Consumables

Consumables are printer supplies that are depleted during the operation of the printer. Consumable supplies for this printer are the Genuine Xerox® Toner Cartridges in cyan, magenta, yellow, and black.

Note:

- Each consumable includes installation instructions.
- Install only new cartridges in your printer. If a used toner cartridge is installed, then the toner-remaining amount displayed could be inaccurate.
- To ensure print quality, the toner cartridge was designed to cease functioning at a predetermined point.

Caution: Use of toner other than genuine Xerox® Toner can affect print quality and printer reliability. Xerox® Toner is the only toner designed and manufactured under strict quality controls by Xerox for specific use with this printer.

Routine Maintenance Items

Routine maintenance items are printer parts that have a limited life and require periodic replacement. Replacements can be parts or kits. Routine maintenance items are typically customer replaceable parts.

Note: Each routine maintenance item includes installation instructions.

Routine maintenance items for this printer include the following:

- Drum Cartridge Kit
- Waste Cartridge
- Maintenance Kit, which includes a Transfer Belt, Transfer Roller, and Feed Roller
- Fuser

Ordering Supplies

When to Order Supplies

A warning appears on the control panel when supplies near their replacement time. Verify that you have replacements on hand. It is important to order these items when the messages first appear to avoid interruptions to your printing. An error message appears on the control panel when supplies must be replaced.

Order supplies from your local reseller or go to www.xerox.com/supplies.
Maintenance

⚠️ **Caution:** Use of non-Xerox supplies is not recommended. The Xerox Warranty, Service Agreement, and Total Satisfaction Guarantee do not cover damage, malfunction, or degradation of performance caused by use of non-Xerox supplies, or the use of Xerox supplies not specified for this printer. The Total Satisfaction Guarantee is available in the United States and Canada. Coverage could vary outside these areas. Please contact your Xerox representative for details.

**Supply Status Information**

You can check the supplies status, customize the alerts that appear on the control panel, and configure email alert notifications. For more information, refer to the *Supply Status*.

**Supplies Usage Report**

The Supplies Usage Report provides coverage information and part numbers for reordering supplies. The date a supply item was installed appears on the report.

To print the Supplies Usage Report:

1. At the printer control panel, press the **Home** button.
2. Touch **Device** → **About** → **Information Pages**.
3. Touch **Supplies Usage Report**.
4. To return to the Home screen, press the **Home** button.

**Toner Cartridges**

**General Precautions**

⚠️ **WARNING:**

- When replacing a toner cartridge, be careful not to spill the toner. If any toner spills, avoid contact with clothes, skin, eyes, and mouth. Do not inhale the toner dust.
- Keep toner cartridges out of the reach of children. If a child accidentally swallows toner, have the child spit out the toner, and rinse the mouth with water. Consult a physician immediately.
- Use a damp cloth to wipe off spilled toner. Never use a vacuum cleaner to remove spills. Electric sparks inside the vacuum cleaner can cause a fire or explosion. If you spill a large volume of toner, contact your local Xerox representative.
- Never throw a toner cartridge into an open flame. Remaining toner in the cartridge can catch fire and cause burn injuries or an explosion.

**Replacing a Toner Cartridge**

A message appears on the control panel when a toner cartridge must be replaced.

📝 **Note:** Each toner cartridge includes installation instructions.
### Printer Status Message

<table>
<thead>
<tr>
<th>Printer Status Message</th>
<th>Cause and Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reorder Toner</td>
<td>The toner cartridge is low. Order a new toner cartridge.</td>
</tr>
<tr>
<td>Out of Toner</td>
<td>The toner cartridge is empty. Replace the toner cartridge with a new one.</td>
</tr>
</tbody>
</table>

### Recycling Supplies

For more information on the Xerox® supplies recycling program, go to [www.xerox.com/gwa](http://www.xerox.com/gwa).
Managing the Printer

Viewing the Meter Reading

The Billing/Usage menu displays the total number of impressions that the printer generated or printed during its lifetime. You cannot reset the counters. A page is counted as one side of a sheet of paper. For example, a sheet of paper that is printed on two sides counts as two impressions.

Note: If you provide regular billing information for your device, you can use the Remote Services Upload feature to simplify the process. You can enable Remote Services to send billing meter readings to Xerox automatically so that you do not have to collect the readings manually. For more information, refer to the System Administrator Guide at www.xerox.com/office/VLC600docs.

To view the billing information for your printer:
1. At the printer control panel, press the Home button.
3. To view more details, touch Usage Counters, then select an option.
4. After viewing the usage readings, to return to the Home screen, press the Home button.

Printing the Billing Summary Report

The Billing Summary Report provides information about the device and a detailed listing of the billing meters and sheet counts.

To print the Billing Summary Report:
1. At the printer control panel, press the Home button.
2. Touch Device → About → Information Pages.
4. To return to the Home screen, press the Home button.
Moving the Printer

**WARNING:**

- To lift the printer, always use at least two people to grasp the hand holds on each side of the printer.
- To prevent you from dropping the printer or injury, lift the printer firmly by gripping the recessed areas on both sides of the printer. Never lift the printer by gripping any other areas.
- If the optional 550-Sheet Feeder is installed, uninstall it before you move the printer. If the optional 550-Sheet Feeder is not fixed to the printer securely, it could fall to the ground and cause injury.

Follow these instructions when moving the printer:

1. Power off the printer, then disconnect the power cord and other cables from the back of the printer.

   **Note:** To prevent electric shock, never touch the power plug with wet hands. When removing the power cord, ensure that you pull the plug and not the cord. Pulling the cord can damage it, which can lead to fire or electric shock.

2. Remove any paper from the Bypass Tray.
3. Close the Bypass Tray.

4. Remove any paper or other media from the Output Tray.

5. If the Output Tray Extension is extended, close it.

6. Remove any paper from Tray 1, then close the tray.
7. Keep the paper wrapped and stored away from humidity and dirt.
8. If the optional 550-Sheet Feeder is installed, unlock, then uninstall it before you move the printer.

9. Lift and carry the printer as shown in the illustration.

Note:

- When moving the printer, do not tilt it more than 10 degrees in any direction.
- Repack the printer and its options using the original packing material and boxes or a Xerox Repackaging Kit.
- Failure to repack the printer properly for shipment can result in damage not covered by the Xerox® Warranty, Service Agreement, or Total Satisfaction Guarantee. The Xerox® Warranty, Service Agreement, or Total Satisfaction Guarantee do not cover damage to the printer caused by improper moving.

After moving the printer:
1. Reinstall any parts that you removed.
2. Reconnect the printer to the cables and power cord.
3. Plug in and power on the printer.
Troubleshooting

This chapter contains:

- General Troubleshooting ................................................................. 148
- Paper Jams .................................................................................. 153
- Print-Quality Problems ................................................................. 165
- Getting Help .................................................................................. 172
General Troubleshooting

This section contains procedures to help you locate and resolve problems. Resolve some problems by simply restarting the printer.

Printer Does Not Power On

⚠️ **Caution:** Plug the three-wire cord with grounding prong directly into a grounded AC outlet.

<table>
<thead>
<tr>
<th>Probable Causes</th>
<th>Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>The power switch is not turned on.</td>
<td>At the printer control panel, press the Power/Wake button. For more information, refer to Power Options.</td>
</tr>
<tr>
<td>The power cord is not plugged into the outlet</td>
<td>Power off the printer, then plug the power cord securely into the outlet.</td>
</tr>
<tr>
<td>correctly.</td>
<td></td>
</tr>
<tr>
<td>The printer requires a full reset.</td>
<td>Power off the printer, then unplug the power cord and wait 30 seconds. Plug the power cord into the outlet securely, then press the Power/Wake button.</td>
</tr>
<tr>
<td>Something is wrong with the outlet connected to the printer.</td>
<td>Plug another electrical appliance into the outlet, then check if it operates properly. Try a different outlet.</td>
</tr>
<tr>
<td>The printer is connected to an outlet with a voltage or frequency that does not match the printer specifications.</td>
<td>Use a power source with the specifications listed in the Electrical Specifications.</td>
</tr>
</tbody>
</table>

Printer Resets or Powers Off Frequently

<table>
<thead>
<tr>
<th>Probable Causes</th>
<th>Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>The power cord is not plugged into the outlet</td>
<td>Power off the printer, confirm that the power cord is plugged in correctly to the printer and the outlet, then power on the printer.</td>
</tr>
<tr>
<td>correctly.</td>
<td></td>
</tr>
<tr>
<td>A system error occurred.</td>
<td>Power off the printer, then power on again. For more information, refer to Printing the Error History Report. If the error persists, contact your Xerox representative.</td>
</tr>
<tr>
<td>The printer is connected to an uninterruptible power supply.</td>
<td>Power off the printer, then connect the power cord to a suitable outlet.</td>
</tr>
</tbody>
</table>
### Probable Causes & Solutions

<table>
<thead>
<tr>
<th>Probable Causes</th>
<th>Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>The printer is connected to a power strip shared with other high-power devices.</td>
<td>Plug the printer directly into the outlet or into a power strip that is not shared with other devices.</td>
</tr>
<tr>
<td>The <strong>Auto Power Off</strong> feature is enabled to save power.</td>
<td>Increase the <strong>Auto Power Off</strong> timer setting or disable the <strong>Auto Power Off</strong> feature. For more information, refer to the <em>System Administrator Guide</em> at <a href="http://www.xerox.com/office/VLC600docs">www.xerox.com/office/VLC600docs</a>.</td>
</tr>
</tbody>
</table>

### Printer Does Not Print

<table>
<thead>
<tr>
<th>Probable Causes</th>
<th>Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>The printer is in Power Saver mode.</td>
<td>On the control panel, press the <strong>Power/Wake</strong> button.</td>
</tr>
<tr>
<td>The printer has an error.</td>
<td>If the Status LED is blinking amber, follow the instructions on the control panel to clear the error. If the error persists, contact your Xerox representative.</td>
</tr>
<tr>
<td>The printer is out of paper.</td>
<td>Load paper into the tray.</td>
</tr>
<tr>
<td>The incorrect paper is loaded for the print job.</td>
<td>Load the correct paper in the appropriate tray. At the printer control panel, specify the correct paper size, type and color.</td>
</tr>
<tr>
<td>The paper settings for the print job do not match any paper loaded in the paper trays at the printer.</td>
<td>From the print driver, select a paper tray containing the correct paper.</td>
</tr>
<tr>
<td>A toner cartridge is empty.</td>
<td>Replace the empty toner cartridge.</td>
</tr>
<tr>
<td>No control panel indicators are lighted.</td>
<td>Power off the printer, confirm that the power cord is plugged in correctly to the printer and the outlet, then power on the printer. If the error persists, contact your Xerox representative.</td>
</tr>
</tbody>
</table>
| The printer is busy.                                                          | • If the Status LED is flashing blue, a previous print job could be the problem.  
  1 In the print driver, use the Printer Properties to delete all print jobs in the print queue.  
  2 At the control panel, touch **Jobs**, then delete all pending print jobs.  
  • Load the paper in the tray.  
  • If the Status LED does not flash once after you send a print job, check the connection between the printer and the computer. Power off the printer, then power on the printer. |
### Troubleshooting

<table>
<thead>
<tr>
<th>Probable Causes</th>
<th>Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>The printer cable is disconnected.</td>
<td>If the Status LED does not flash once after you send a print job, check the connection between the printer and the computer.</td>
</tr>
</tbody>
</table>
| There is a network-connectivity issue.               | If the printer is connected to a network:  
1. Verify that the Ethernet cable is connected to the printer.  
2. On the printer Ethernet connector, verify that the green LED is On. If the green LED is not lit, reseat both ends of the Ethernet cable.  
3. Examine the TCP/IP address in the Communication section of the Configuration Report. For more information, refer to Printing the Configuration Report.  
4. If the TCP/IP address is 0.0.0.0, the printer needs more time to acquire an IP address from the DHCP server. Wait 2 minutes, then print the Configuration Report again.  
5. If the TCP/IP address is unchanged, or begins with 169, contact your network administrator. |
| There is a wireless network setup or connectivity issue. | Verify that the Wireless Network Adapter is installed and properly configured. For more information, refer to Connecting to a Wireless Network. |

### Printing Takes Too Long

<table>
<thead>
<tr>
<th>Probable Causes</th>
<th>Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>The printer is set to a slower printing mode. For example, the printer could be set to print on Heavyweight paper.</td>
<td>It takes more time to print on certain types of special paper. Ensure that the paper type is set properly in the driver and at the printer control panel. For details, refer to Print Speed.</td>
</tr>
<tr>
<td>The printer is in Power Saver mode.</td>
<td>It takes time for printing to start when the printer is exiting Power Saver mode.</td>
</tr>
<tr>
<td>The way the printer was installed on the network could be an issue.</td>
<td>Determine if a print spooler or a computer sharing the printer is buffering all print jobs and then spooling them to the printer. Spooling can slow print speeds. To test the speed of the printer, print some Information Pages such as the Office Demo Page. If the page prints at the rated speed of the printer, you could have a network or printer installation issue. For additional help, contact the system administrator.</td>
</tr>
</tbody>
</table>
### Probable Causes and Solutions

<table>
<thead>
<tr>
<th>Probable Causes</th>
<th>Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>The job is complex.</td>
<td>Wait. No action needed.</td>
</tr>
<tr>
<td>The print-quality mode in the driver is set to Enhanced.</td>
<td>Change the print-quality mode in the print driver to <strong>Standard</strong>.</td>
</tr>
</tbody>
</table>

### Document Prints from Wrong Tray

<table>
<thead>
<tr>
<th>Probable Causes</th>
<th>Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application and print driver have conflicting tray selections.</td>
<td>1. Check the tray selected in the print driver.</td>
</tr>
<tr>
<td></td>
<td>2. Access the page setup or printer settings of the application from which you are printing.</td>
</tr>
<tr>
<td></td>
<td>3. Set the paper source to match the tray selected in the print driver or set the paper source to <strong>Automatically Select</strong>.</td>
</tr>
<tr>
<td></td>
<td>4. Check that you have the latest print driver installed. For details, go to <a href="http://www.xerox.com/office/VLC600support">www.xerox.com/office/VLC600support</a>.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> To have the print driver select the tray, set the tray used as the paper source to <strong>Auto Selection Enabled</strong>.</td>
</tr>
</tbody>
</table>

### Automatic 2-Sided Printing Problems

<table>
<thead>
<tr>
<th>Probable Causes</th>
<th>Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unsupported or incorrect paper.</td>
<td>Ensure that you are using a supported paper size and weight for 2-sided printing. Envelopes, cardstock, and labels cannot be used for 2-sided printing. For more information, refer to <a href="#">Supported Paper Types and Weights for Automatic 2-Sided Printing</a>.</td>
</tr>
<tr>
<td>Your printer model is not configured with automatic 2-sided printing.</td>
<td>Ensure that your printer supports automatic 2-sided printing. For more information, refer to <a href="#">Configurations and Options</a>.</td>
</tr>
<tr>
<td>Incorrect setting.</td>
<td>In the print driver <strong>Printing Options</strong> tab, select <strong>2-Sided Print</strong>.</td>
</tr>
</tbody>
</table>
## Troubleshooting

### Printer is Making Unusual Noises

<table>
<thead>
<tr>
<th>Probable Causes</th>
<th>Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>There is an obstruction or debris inside the printer.</td>
<td>Power off the printer, then remove the obstruction or debris. If you cannot remove the obstruction, contact your Xerox representative.</td>
</tr>
</tbody>
</table>

### Paper Tray Will Not Close

<table>
<thead>
<tr>
<th>Probable Causes</th>
<th>Solutions</th>
</tr>
</thead>
</table>
| The paper tray does not fully close.                          | • If the tray is extended for legal-size paper, the tray protrudes when it is inserted into the printer. For more information, refer to Configuring Tray 1 and Trays 2–5 for the Paper Length.  
• Some debris or an object is blocking the tray.  
• The tray is blocked by the table or shelf on which it is located.  
• If the paper lift plate at the back of the tray is not locked down, replace the tray. |

### Condensation Has Formed Inside the Printer

Moisture can condense in the printer when room humidity exceeds 85% or when a cold printer is located in a warm room. Condensation can form in a printer after it has been sitting in a cold room that is heated quickly.

<table>
<thead>
<tr>
<th>Probable Causes</th>
<th>Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>The printer has been sitting in a cold room.</td>
<td>Allow the printer to operate for several hours at room temperature.</td>
</tr>
</tbody>
</table>
| The relative humidity of the room is too high.                | • Reduce the humidity in the room.  
• Move the printer to a location where the temperature and relative humidity are within the operating specifications. For more information, refer to Environmental Specifications. |
Paper Jams

Locating Paper Jams

**WARNING:** Never touch a labeled area on or near the heat roller in the fuser. You can get burned. If a sheet of paper is wrapped around the heat roller, do not try to remove it immediately. Power off the printer immediately and wait 40 minutes for the fuser to cool. Try to remove the jam after the printer has cooled. If the error persists, contact your Xerox representative.

**Caution:**

Do not attempt to clear any paper jams using tools or instruments. This can permanently damage the printer.

The following illustration shows where paper jams can occur along the paper path:

1. Tray 2
2. Optional Mailbox or Finisher
3. Fuser
4. Bypass Tray
5. Tray 1

Minimizing Paper Jams

The printer is designed to function with minimal paper jams using Xerox-supported paper. Other paper types can cause jams. If supported paper is jamming frequently in one area, clean that area of the paper path.

The following can cause paper jams:

- Selecting the incorrect paper type in the print driver
- Using damaged paper
- Using unsupported paper
- Loading paper incorrectly
- Overfilling the tray
Troubleshooting

- Adjusting the paper guides improperly

Most jams can be prevented by following a simple set of rules:
- Use only supported paper. For more information, refer to Supported Paper.
- Follow proper paper handling and loading techniques.
- Always use clean, undamaged paper.
- Avoid paper that is curled, torn, moist, creased, or folded.
- To separate the sheets before loading into the tray, fan the paper.
- Do not load paper above the maximum fill line.
- After loading paper in the trays, adjust the paper guides in all trays. A guide that is not properly adjusted can cause poor print quality, misfeeds, skewed prints, and printer damage.
- After loading paper in the trays, at the control panel, select the correct paper type and size.
- Before printing, select the correct paper type and size in the print driver.
- Store paper in a dry location.

The following can cause paper jams:
- Polyester-coated paper that is designed especially for inkjet printers
- Paper that is folded, wrinkled, or excessively curled
- Loading more than one type, size, or weight of paper in a tray at the same time
- Loading paper above the maximum fill line in the paper tray
- Allowing the output tray to become overfilled

For a detailed list of supported paper, refer to Supported Paper.
Clearing Paper Jams

Clearing Paper Jams from the Bypass Tray

To resolve the error displayed on the control panel, you must clear all paper from the paper path.

1. Remove any paper from the Bypass Tray.

2. Grasp both sides of the Bypass Tray, then pull it straight out of the printer.

3. Remove Tray 1 from the printer.
4. Remove the jammed paper.

5. Insert Tray 1 into the printer, then push it all the way in.

   **Note:** If the tray is extended for legal-size paper, the tray protrudes when it is inserted into the printer. If removed in a previous step, replace the tray cover.

6. Insert the Bypass Tray completely into the printer.

7. When paper trays are set to Fully Adjustable, you are prompted to verify or change the paper settings.
   a. To confirm the same paper size, type, or color, touch **OK**.
   b. To select a new paper size, type, or color, touch the current setting, then select a new setting. When finished, touch **OK**.

8. To return to the Home menu, press the **Home** button.
Clearing Paper Jams from the Tray 1 Area

To resolve the error displayed on the control panel, you must clear all paper from the paper path.

1. Remove any paper from the Bypass Tray.

2. Grasp both sides of the Bypass Tray, then pull it straight out of the printer.

3. Remove Tray 1 from the printer.
Troubleshooting

4. Remove any crumpled paper from the tray and any remaining paper jammed in the printer.

5. Insert Tray 1 into the printer, then push it all the way in.
   
   Note: If the tray is extended for legal-size paper, the tray protrudes when it is inserted into the printer. If removed in a previous step, replace the tray cover.

6. Insert the Bypass Tray completely into the printer.

7. When paper trays are set to Fully Adjustable, you are prompted to verify or change the paper settings.
   
   a. To confirm the same paper size, type, or color, touch OK.
   
   b. To select a new paper size, type, or color, touch the current setting, then select a new setting. When finished, touch OK.

8. To return to the Home menu, press the Home button.
Clearing Paper Jams from the Trays 2–5 Areas

To resolve the error displayed on the control panel, clear all paper from the paper path.

1. For the tray reported on the Touch Screen Display, pull out the tray until it stops.

2. To remove the tray, lift the front of it slightly, then pull it out of the printer.

3. Remove any crumpled paper from the tray and any remaining paper jammed at the front of the printer.
4. For the same tray, at the back of the printer, locate the jam-access door. Open the door, then remove any jammed paper.

5. Re-insert the paper tray into the printer, then push the tray in until it stops.

   Note: If the tray is extended for legal-size paper, the tray protrudes when it is inserted into the printer. If removed in a previous step, replace the tray cover.

6. When paper trays are set to Fully Adjustable, you are prompted to verify or change the paper settings.
   a. To confirm the same paper size, type, or color, touch OK.
   b. To select a new paper size, type, or color, touch the current setting, then select a new setting. When finished, touch OK.
Clearing Paper Jams from the Fuser Area

To resolve the error displayed on the control panel, clear all paper from the paper path.

1. Lift the rear door release and pull open the door.

2. To open the paper guide on the top of the fuser, lift the paper guide tab.

3. Remove any jammed paper from the back of the printer.
Troubleshooting

4. Close the paper guide on the fuser.

5. Close the rear door.

Troubleshooting Paper Jams

Multiple Sheets Pulled Together

<table>
<thead>
<tr>
<th>Probable Causes</th>
<th>Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>The paper tray is too full.</td>
<td>Remove some of the paper. Do not load paper above the maximum fill line.</td>
</tr>
<tr>
<td>The edges of the paper are not</td>
<td>Remove the paper, align the edges, and then reload the paper.</td>
</tr>
<tr>
<td>even.</td>
<td></td>
</tr>
<tr>
<td>The paper is moist from humidity.</td>
<td>Remove the paper from the paper tray. Load new, dry paper into the tray.</td>
</tr>
<tr>
<td>Too much static electricity is</td>
<td>Load a new ream of paper.</td>
</tr>
<tr>
<td>present.</td>
<td></td>
</tr>
<tr>
<td>Using unsupported paper.</td>
<td>Use only Xerox®-approved paper. For details, refer to Supported Paper.</td>
</tr>
</tbody>
</table>
### Probable Causes

<table>
<thead>
<tr>
<th>Probable Causes</th>
<th>Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Humidity is too high for coated paper.</td>
<td>• Feed paper one sheet at a time.</td>
</tr>
<tr>
<td></td>
<td>• Try loading paper in the Bypass tray.</td>
</tr>
<tr>
<td>The feed rollers are dirty.</td>
<td>With a clean, lint-free cloth moistened with water, wipe the feed rollers until they are clean. For details, refer to Cleaning the Printer.</td>
</tr>
<tr>
<td>Tray is loaded with mixed paper.</td>
<td>Load the tray with only one type and size of paper.</td>
</tr>
</tbody>
</table>

### Paper Misfeeds

<table>
<thead>
<tr>
<th>Probable Causes</th>
<th>Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>The paper is not correctly positioned in the tray.</td>
<td>• Remove the misfed paper and reposition it properly in the tray.</td>
</tr>
<tr>
<td></td>
<td>• Adjust the paper guides in the tray to match the size of the paper.</td>
</tr>
<tr>
<td>The paper tray is too full.</td>
<td>Remove some of the paper. Do not load paper past the fill line.</td>
</tr>
<tr>
<td>The paper guides are not correctly adjusted to the paper size.</td>
<td>Adjust the paper guides in the tray to match the size of the paper.</td>
</tr>
<tr>
<td>The tray contains warped or wrinkled paper.</td>
<td>Remove the paper, smooth it out, and reload it. If it still misfeeds, do not use that paper.</td>
</tr>
<tr>
<td>The paper is moist from humidity.</td>
<td>Remove the moist paper and replace it with new, dry paper.</td>
</tr>
<tr>
<td>Using paper of the wrong size, thickness, or type.</td>
<td>Use only Xerox approved paper. For more information, refer to Supported Paper.</td>
</tr>
<tr>
<td>The feed rollers are dirty.</td>
<td>With a clean, lint-free cloth moistened with water, wipe the feed rollers until they are clean. For more information, refer to Cleaning the Printer.</td>
</tr>
</tbody>
</table>

### Label and Envelope Misfeeds

<table>
<thead>
<tr>
<th>Probable Causes</th>
<th>Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>The label sheet is facing the wrong way in the tray.</td>
<td>• Load label sheets according to the instructions from the manufacturer.</td>
</tr>
<tr>
<td></td>
<td>• Load labels in the tray, face up.</td>
</tr>
<tr>
<td></td>
<td>• For more information, refer to Labels.</td>
</tr>
<tr>
<td>Labels are missing, curled, or pulled away from the backing sheet.</td>
<td>Do not use any sheet where labels are missing, curled, or pulled away from the backing sheet.</td>
</tr>
</tbody>
</table>
## Troubleshooting

### Probable Causes | Solutions
--- | ---
Envelopes are loaded incorrectly. | You can print envelopes from the Bypass Tray or Tray 1. For more information, refer to Envelopes.

### Envelopes are wrinkling.
- The heat and pressure of the laser printing process can cause wrinkling.
- Use supported envelopes. For more information, refer to Guidelines for Printing Envelopes.

- **Note:** When you load envelopes long-edge feed, ensure that you specify landscape orientation in the print driver.

### Paper Jam Message Stays On

- **Note:** Check for, and remove, torn pieces of paper in the paper path.

| Probable Causes | Solutions |
--- | --- |
Some paper remains jammed in the printer. | Recheck the paper path and make sure that you have removed all of the jammed paper. |
One of the printer doors is open. | Check the doors on the printer. Close any door that is open. |

### Jams During Automatic 2-Sided Printing

| Probable Causes | Solutions |
--- | --- |
Using paper of the wrong size, thickness, or type. | Use paper of the correct size, thickness, or type. For more information, refer to Supported Paper Types and Weights for Automatic 2-Sided Printing. |
Paper is loaded in the wrong tray. | Ensure that paper is loaded into the correct tray. For more information, refer to Supported Paper. |
Tray is loaded with mixed paper. | Load the tray with only one type and size of paper. |
Print-Quality Problems

Your printer is designed to produce consistently high-quality prints. If you observe print-quality problems, use the information in this section to troubleshoot the problem. For more information, go to www.xerox.com/office/VLC600support.

⚠️ Caution: The Xerox Warranty, Service Agreement, or Xerox Total Satisfaction Guarantee does not cover damage caused by using unsupported paper or specialty media. The Xerox Total Satisfaction Guarantee is available in the United States and Canada. Coverage could vary outside these areas. Contact your local Xerox representative for details.

✍ Note:

- To ensure consistent print quality, the toner, print, and drum cartridges for many devices are designed to cease functioning at a predetermined point.
- Grayscale images printed with the composite black setting increment the color pages counter, because color consumables are used. Composite black is the default setting on most printers.

Controlling Print Quality

Various factors can affect the quality of the output of your printer. For consistent and optimum print quality, use paper designed for your printer, and correctly set the Print-Quality Mode and Color Adjustments. Follow the guidelines in this section to maintain optimum print quality from your printer.

Temperature and humidity affect the quality of the printed output. The range for optimal print quality is 15–28°C (59–82°F) and 20–70% relative humidity. However, print quality can be affected when operating near the limits for both temperature and humidity.

Paper and Media

Your printer is designed to use various paper and other media types. Follow the guidelines in this section for the best print quality and to avoid jams:

- Use only Xerox-approved paper. For more information, refer to Supported Paper.
- Use only dry, undamaged paper.
Troubleshooting

**Caution:** Some paper and other media types can cause poor output quality, increased paper jams, or damage your printer. Do not use the following:

- Rough or porous paper
- Inkjet paper
- Non-laser glossy or coated paper
- Paper that is photocopied
- Paper that is folded or wrinkled
- Paper with cutouts or perforations
- Stapled paper
- Envelopes with windows, metal clasps, side seams, or adhesives with release strips
- Padded envelopes
- Plastic media
- Transparencies

- Ensure that the paper type selected in your print driver matches the paper type on which you are printing.
- If you have the same size paper loaded in more than one tray, ensure that the proper tray is selected in the print driver.
- Store your paper and other media properly for optimum print quality. For more information, refer to Paper Storage Guidelines.

### Solving Print-Quality Problems

When the print quality is poor, select the closest symptom from the following table and refer to the corresponding solution to correct the problem. You can also print a Demonstration Print page to more precisely determine the print-quality problem. For details, refer to Information Pages.

If the print quality does not improve after performing the appropriate action, contact your Xerox representative.

**Note:**

- To maintain print quality, the toner, print, and drum cartridges for many models of equipment are designed to stop functioning at a predetermined point.
- Grayscale images printed with the composite black setting increment the color-pages counter, because color consumables are used. Composite black is the default setting on most printers.
### Troubleshooting

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Probable Causes</th>
<th>Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Page Margins Are Inconsistent.</td>
<td>A paper registration adjustment is needed.</td>
<td>Use the paper registration procedure to adjust the image position on the page. For details, refer to Adjusting Paper Registration.</td>
</tr>
<tr>
<td>The image is not centered on the page or the margins are not consistent.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Faded printouts with multiple colors faded.</td>
<td>The toner cartridges are not Xerox® toner cartridges.</td>
<td>Verify that the toner cartridges meet specifications. Replace the cartridges if necessary.</td>
</tr>
<tr>
<td>The paper being used is outside the recommended specification range.</td>
<td>Replace the paper with a recommended size and type, then confirm that your control panel and print driver settings are correct. For details, refer to Supported Paper.</td>
<td></td>
</tr>
<tr>
<td>The paper type is heavier or thicker than the paper type selection.</td>
<td>Ensure that the proper paper is loaded in the paper tray. Choose a heavier paper type at the control panel and in the print driver. Use a lighter paper or paper type.</td>
<td></td>
</tr>
<tr>
<td>The bias transfer voltage is not properly adjusted for the paper type.</td>
<td>Verify that the paper types set in the control panel and the print driver match the paper loaded in the tray.</td>
<td></td>
</tr>
<tr>
<td>The settings in the application or print driver are incorrect.</td>
<td>Print the Demonstration Print from the Information Pages menu. For details, refer to Information Pages. If the Demo Print looks correct, the printer is printing properly. Verify that the application and the print driver selections are correct for your print job.</td>
<td></td>
</tr>
<tr>
<td>The paper is damp.</td>
<td></td>
<td>Replace the paper.</td>
</tr>
<tr>
<td>The high-voltage supply is defective.</td>
<td>For assistance, go to the Xerox® Support website at <a href="http://www.xerox.com/office/VL_C600support">www.xerox.com/office/VL_C600support</a>.</td>
<td></td>
</tr>
<tr>
<td>Symptom</td>
<td>Probable Causes</td>
<td>Solutions</td>
</tr>
<tr>
<td>---------------------------------------------------------------------------------------------</td>
<td>------------------------------------------</td>
<td>---------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Only one color is faded.</td>
<td>Toner cartridge is empty or damaged.</td>
<td>Check the condition of the toner cartridge, then replace it if necessary.</td>
</tr>
<tr>
<td>Color around the edge of printing is incorrect.</td>
<td>The color registration is incorrect.</td>
<td>Adjust the color registration. For details, see details, refer to Color Registration.</td>
</tr>
<tr>
<td>Stray black dots or white areas (dropouts).</td>
<td>The paper is outside the recommended specification range.</td>
<td>Replace the paper with a recommended size and type, then confirm that your control panel and print driver settings are correct. For details, refer to Supported Paper.</td>
</tr>
<tr>
<td>There is debris on the rollers.</td>
<td></td>
<td>Wipe the feed rollers with a clean damp cloth to remove debris from the rollers.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note:</strong> Do not touch the transfer roller or the exposed end of the transfer belt. Fingerprints can cause print-quality issues.</td>
</tr>
<tr>
<td>The toner cartridges are not Xerox® toner cartridges.</td>
<td></td>
<td>Ensure that the toner cartridges meet specifications. Replace the cartridges if necessary. For details, refer to Consumables.</td>
</tr>
<tr>
<td>• Vertical black or color streaks or multiple colored streaks or lines.</td>
<td>The toner cartridges are not Xerox® toner cartridges.</td>
<td>Ensure that the toner cartridges meet specifications. Replace the cartridges if necessary. For details, refer to Consumables.</td>
</tr>
<tr>
<td>• Streaks in only one color.</td>
<td></td>
<td>Debris in the printer is dragging against the toner before it is fused.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Remove any debris or paper scraps from the paper path under the rear cover.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>There is a problem with the toner cartridge for that color.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Check the toner cartridge for damage, then replace if necessary. For assistance, go to the Xerox®Support website at <a href="http://www.xerox.com/office/VLC600support">www.xerox.com/office/VLC600support</a>.</td>
</tr>
<tr>
<td>Symptom</td>
<td>Probable Causes</td>
<td>Solutions</td>
</tr>
<tr>
<td>---------</td>
<td>----------------</td>
<td>-----------</td>
</tr>
<tr>
<td>There is debris on the transfer belt.</td>
<td>At the printer control panel, perform a transfer belt cleaning procedure. For details, refer to Performing a Transfer Belt Cleaning Mode Procedure.</td>
<td></td>
</tr>
<tr>
<td>Partial blanks, creased paper, or blotted printing.</td>
<td>The paper is damp.</td>
<td>Replace the paper.</td>
</tr>
<tr>
<td>The paper is outside the recommended specification range.</td>
<td>Replace the paper with a recommended size and type. For details, refer to Supported Paper.</td>
<td></td>
</tr>
<tr>
<td>A printer part is worn or damaged.</td>
<td>For assistance, go to the Xerox®Support website at <a href="http://www.xerox.com/office/VLC600support">www.xerox.com/office/VLC600support</a>.</td>
<td></td>
</tr>
<tr>
<td>The toner cartridges are not Xerox®toner cartridges.</td>
<td>Verify that the toner cartridges meet specifications and replace if necessary. For details, refer to Consumables.</td>
<td></td>
</tr>
<tr>
<td>The paper is impeded in the paper path.</td>
<td>• Remove any paper or debris from the paper path. • Ensure that the trays are pushed in all the way. • Ensure that the rear cover is closed and locked.</td>
<td></td>
</tr>
<tr>
<td>Condensation inside the printer causes partial blanks or creased paper.</td>
<td>Power on the printer and leave it on for at least 1 hour to get rid of the condensation. For assistance, go to the Xerox® Support website at <a href="http://www.xerox.com/office/VLC600support">www.xerox.com/office/VLC600support</a>.</td>
<td></td>
</tr>
<tr>
<td>Vertical blanks appear.</td>
<td>The laser lenses are blocked.</td>
<td>Clean the laser lenses. For details, refer to Cleaning the LED Lenses.</td>
</tr>
<tr>
<td>The laser lenses are blocked.</td>
<td>Clean the laser lenses. For details, refer to Cleaning the LED Lenses.</td>
<td></td>
</tr>
<tr>
<td>A printer part is worn or damaged.</td>
<td>For assistance, go to the Xerox®Support website at <a href="http://www.xerox.com/office/VLC600support">www.xerox.com/office/VLC600support</a>.</td>
<td></td>
</tr>
<tr>
<td>The toner cartridges are not Xerox®toner cartridges.</td>
<td>Ensure that the toner cartridges meet specifications and replace if necessary.</td>
<td></td>
</tr>
<tr>
<td>White lines or streaks running through only one color.</td>
<td>Something is blocking the lens for the affected color.</td>
<td>Clean the lens for the affected color. For details, refer to Cleaning the LED Lenses.</td>
</tr>
<tr>
<td>Symptom</td>
<td>Probable Causes</td>
<td>Solutions</td>
</tr>
<tr>
<td>------------------------------------------------</td>
<td>------------------------------------------------------</td>
<td>---------------------------------------------------------------------------</td>
</tr>
<tr>
<td>White line or lines running through all colors.</td>
<td>Paper or debris is dragging the bottom of the transfer belt.</td>
<td>• Remove the paper or debris from the printer.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Replace the Transfer Belt, which is included in the Maintenance Kit.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• For assistance, go to the Xerox® Support website at <a href="http://www.xerox.com/office/VLC600support">www.xerox.com/office/VLC600support</a>.</td>
</tr>
<tr>
<td>Slanted printing.</td>
<td>The paper guides in the trays are not set correctly.</td>
<td>Reset the paper tray guides. For details, refer to <a href="#">Loading Paper</a>.</td>
</tr>
<tr>
<td>Symptom</td>
<td>Probable Causes</td>
<td>Solutions</td>
</tr>
<tr>
<td>-------------------------------------</td>
<td>------------------------------------------------------</td>
<td>---------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Blotchy or mottled images.</td>
<td>The paper is too light or too thin.</td>
<td>Choose a different paper type at the control panel, in the application, and in the print driver.</td>
</tr>
<tr>
<td></td>
<td>The paper is damp.</td>
<td>Replace the paper.</td>
</tr>
<tr>
<td></td>
<td>The humidity is too high.</td>
<td>Reduce the humidity in the room or move the printer to a new location.</td>
</tr>
</tbody>
</table>
| Spots or lines appear at regular intervals on the prints. | One or more of the components in the paper path is marking the paper. | 1 Print the Repeating Defects Pages. At the control panel, touch Device > Support > Support Pages > Repeating Defects.  
2 To determine the cause, measure the distance between the print defects.  
   - 27.8 mm (1.1 in.): Drum Cartridge  
   - 52.0 mm (2.1 in.): Drum Cartridge  
   - 94.2 mm (3.7 in.): Drum Cartridge  
   - 82.4 mm (3.24 in.): Fuser  
   - 94.2 mm (3.7 in.): Fuser  
   - 18.8 mm (0.74 in.): Transfer Belt  
   - 63.5 mm (2.5 in.): Transfer Belt  
   - 56.5 mm (2.2 in.): Transfer Roller  
3 If the repeating defects match one of these distances, replace that item. |
Getting Help

Your printer includes utilities and resources to help you troubleshoot printing problems.

Viewing Warning Messages on the Control Panel

When a warning condition occurs, the printer alerts you of the problem. A message appears on the control panel and the LED status light on the control panel flashes amber or red. Warning alerts inform you about printer conditions, such as low supplies or open doors, that require your attention. If more than one warning condition occurs, only one warning message appears on the control panel at a time.

Viewing Current Errors on the Control Panel

When an error condition occurs, a message appears on the control panel to inform you of the problem. Error messages warn you about printer conditions that prevent the printer from printing or degrade printing performance. If more than one error occurs, only one is displayed on the control panel.

Using the Integrated Troubleshooting Tools

Your printer has a set of reports that you can print. These reports include the Demonstration Print page and the Error History report that can assist you in troubleshooting certain problems. The Demonstration Print page prints an image to show print quality. You can use this page to troubleshoot print-quality issues with the printer. The Error History report prints information on the most recent printer errors.

For more information, refer to Printing Information Pages.

Printing the Error History Report

1. At the printer control panel, press the Home button.
3. To return to the Home screen, press the Home button.

Online Support Assistant

The Online Support Assistant is a knowledge base that provides instructions and troubleshooting help to solve your printer problems. You can find solutions for print-quality problems, paper jams, software installation issues, and more.

To access the Online Support Assistant, go to www.xerox.com/office/VLC600support.

Helpful Information Pages

To assist with troubleshooting, your printer has a set of Information Pages that you can print. These pages include configuration and font information, demonstration pages, and more. For more information, refer to Information Pages.
More Information about Your Printer

To obtain more information about your printer, refer to More Information.
Specifications

This appendix contains:

- Configurations and Options ................................................................. 176
- Physical Specifications ........................................................................ 178
- Environmental Specifications ............................................................... 185
- Electrical Specifications ...................................................................... 186
- Performance Specifications ................................................................. 187
Specifications

Configurations and Options

Available Configurations

Standard Configurations with Models C600N, C600DN, C600DT, C600DXF, and C600DXP

<table>
<thead>
<tr>
<th>Option</th>
<th>C600N</th>
<th>C600DN</th>
<th>C600DT</th>
<th>C600DX</th>
<th>C600DXF</th>
<th>C600DXP</th>
</tr>
</thead>
<tbody>
<tr>
<td>550-Sheet Feeder (Up to 4 Trays)</td>
<td>Option</td>
<td>Option</td>
<td>Option</td>
<td>Option</td>
<td>Option</td>
<td>Option</td>
</tr>
<tr>
<td>Finisher</td>
<td>Option</td>
<td>Option</td>
<td>Option</td>
<td>Option</td>
<td>Standard</td>
<td>Option</td>
</tr>
<tr>
<td>4-Bin Mailbox</td>
<td>Option</td>
<td>Option</td>
<td>Option</td>
<td>Option</td>
<td>Option</td>
<td>Standard</td>
</tr>
<tr>
<td>2000-Sheet High-Capacity Feeder with Casters</td>
<td>Option</td>
<td>Option</td>
<td>Option</td>
<td>Standard</td>
<td>Standard</td>
<td>Standard</td>
</tr>
<tr>
<td>Cabinet with Casters</td>
<td>Option</td>
<td>Option</td>
<td>Option</td>
<td>Not Applicable</td>
<td>Not Applicable</td>
<td>Not Applicable</td>
</tr>
<tr>
<td>Productivity Kit with 250-GB hard drive</td>
<td>Option</td>
<td>Option</td>
<td>Option</td>
<td>Option</td>
<td>Option</td>
<td>Option</td>
</tr>
<tr>
<td>Wireless Network Adapter</td>
<td>Option</td>
<td>Option</td>
<td>Option</td>
<td>Option</td>
<td>Option</td>
<td>Option</td>
</tr>
<tr>
<td>CAC Kit/Card Reader</td>
<td>Option</td>
<td>Option</td>
<td>Option</td>
<td>Option</td>
<td>Option</td>
<td>Option</td>
</tr>
</tbody>
</table>

Standard Features

<table>
<thead>
<tr>
<th>Features</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Print Speed</td>
<td>Standard and Enhanced modes up to 45 ppm</td>
</tr>
<tr>
<td>2-Sided Print Speed</td>
<td>Up to 52 ppm</td>
</tr>
<tr>
<td>Print Resolution</td>
<td>1200 x 2400 dpi</td>
</tr>
<tr>
<td>Paper Capacity</td>
<td></td>
</tr>
<tr>
<td>• Bypass Tray</td>
<td>• 150 sheets</td>
</tr>
<tr>
<td>• Tray 1</td>
<td>• 550 sheets</td>
</tr>
<tr>
<td>• Optional 550-Sheet Feeder</td>
<td>• 550 sheets, up to 4 feeders</td>
</tr>
<tr>
<td>• Optional High-Capacity Feeder</td>
<td>• 2000 sheets</td>
</tr>
<tr>
<td>• Output Tray</td>
<td>• 500 sheets</td>
</tr>
<tr>
<td></td>
<td>• 400 sheets</td>
</tr>
</tbody>
</table>
### Specifications

<table>
<thead>
<tr>
<th>Features</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Optional 4-Bin Mailbox</td>
<td>• 500 sheets</td>
</tr>
<tr>
<td>• Optional Finisher</td>
<td></td>
</tr>
<tr>
<td>Maximum Print Size</td>
<td>Legal (216 x 356 mm, 8.5 x 14 in.)</td>
</tr>
<tr>
<td>2-Sided Printing</td>
<td>Capacity for 2-Sided Printing models is up to 176 g/m² from any tray</td>
</tr>
<tr>
<td>Control Panel</td>
<td>5-inch LCD touch screen with Home and Power/Wake buttons</td>
</tr>
<tr>
<td>Connectivity</td>
<td>• 3 USB 2.0 (Type A) Ports</td>
</tr>
<tr>
<td></td>
<td>• USB 3.0 (Type B) Port</td>
</tr>
<tr>
<td></td>
<td>• Ethernet 10/100/1000 Base-TX</td>
</tr>
<tr>
<td></td>
<td>• Optional wireless network connectivity with an IEEE 802.11 n/g/b-compliant Wireless Network Adapter</td>
</tr>
<tr>
<td></td>
<td>• Near Field Communication (NFC)</td>
</tr>
<tr>
<td></td>
<td>• AirPrint®</td>
</tr>
<tr>
<td></td>
<td>• MOPRIA™</td>
</tr>
<tr>
<td></td>
<td>• IC Card Reader support</td>
</tr>
<tr>
<td></td>
<td>• Foreign Device Interface (FDI)</td>
</tr>
<tr>
<td>Remote Access</td>
<td>Embedded Web Server</td>
</tr>
</tbody>
</table>

### Options and Upgrades

- Wireless Network Adapter: IEEE 802.11 b/g/n-compliant, and supports 2.4-GHz and 5-GHz frequencies.
- 550-Sheet Feeder, depending on configuration, up to 4 feeders
- 2000-Sheet High-Capacity Feeder with Casters
- Finisher
- 4-Bin Mailbox
- Productivity Kit with 250-GB hard drive
- Cabinet with Casters
- Xerox® Common Access Card Enablement Kit
Physical Specifications

Weights and Dimensions

<table>
<thead>
<tr>
<th>Dimension</th>
<th>Configurations without Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Width</td>
<td>427.4 mm (16.8 in.)</td>
</tr>
<tr>
<td>Depth</td>
<td>465.5 mm (18.3 in.)</td>
</tr>
<tr>
<td>Height</td>
<td>443.5 mm (17.3 in.)</td>
</tr>
<tr>
<td>Weight</td>
<td>29.4 kg (64.8 lb.)</td>
</tr>
</tbody>
</table>

Standard Configuration

Configuration with Optional Finisher
Configuration with Optional 4-Bin Mailbox

Height Measurements for Configurations

Height Configurations for Optional Feeders

<table>
<thead>
<tr>
<th>Item</th>
<th>Base Configuration</th>
<th>1 Optional Feeder</th>
<th>2 Optional Feeders</th>
<th>3 Optional Feeders</th>
<th>4 Optional Feeders</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuration View</td>
<td><img src="image1" alt="Configuration View" /></td>
<td><img src="image2" alt="Configuration View" /></td>
<td><img src="image3" alt="Configuration View" /></td>
<td><img src="image4" alt="Configuration View" /></td>
<td><img src="image5" alt="Configuration View" /></td>
</tr>
<tr>
<td>Height</td>
<td>443.4 mm (17.5 in.)</td>
<td>566.4 mm (22.3 in.)</td>
<td>689.4 mm (27.1 in.)</td>
<td>812.4 mm (32.0 in.)</td>
<td>935.4 mm (36.8 in.)</td>
</tr>
</tbody>
</table>

Height Configurations for Optional Feeders with Casters

<table>
<thead>
<tr>
<th>Item</th>
<th>No Optional Feeders</th>
<th>1 Optional Feeder</th>
<th>2 Optional Feeders</th>
<th>3 Optional Feeders</th>
<th>4 Optional Feeders</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuration View</td>
<td><img src="image1" alt="Configuration View" /></td>
<td><img src="image2" alt="Configuration View" /></td>
<td><img src="image3" alt="Configuration View" /></td>
<td><img src="image4" alt="Configuration View" /></td>
<td><img src="image5" alt="Configuration View" /></td>
</tr>
<tr>
<td>Height</td>
<td>533.4 mm (21.0 in.)</td>
<td>656.4 mm (25.8 in.)</td>
<td>779.4 mm (30.7 in.)</td>
<td>902.4 mm (35.5 in.)</td>
<td>1025.4 mm (40.4 in.)</td>
</tr>
</tbody>
</table>
### Height Configurations for Optional Feeders with Cabinet and Casters

<table>
<thead>
<tr>
<th>Item</th>
<th>No Optional Feeders</th>
<th>1 Optional Feeder</th>
<th>2 Optional Feeders</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuration View</td>
<td><img src="image1" alt="Diagram" /></td>
<td><img src="image2" alt="Diagram" /></td>
<td><img src="image3" alt="Diagram" /></td>
</tr>
<tr>
<td>Height</td>
<td>779.4 mm (30.7 in.)</td>
<td>902.4 mm (35.5 in.)</td>
<td>1025.4 mm (40.4 in.)</td>
</tr>
</tbody>
</table>

### Height Configurations for the Optional High-Capacity Feeder (HCF) with Casters

<table>
<thead>
<tr>
<th>Item</th>
<th>No Optional Feeders</th>
<th>1 Optional Feeder</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuration View</td>
<td><img src="image1" alt="Diagram" /></td>
<td><img src="image2" alt="Diagram" /></td>
</tr>
<tr>
<td>Height</td>
<td>902.4 mm (35.5 in.)</td>
<td>1025.4 mm (40.4 in.)</td>
</tr>
</tbody>
</table>

### Height Configurations for Optional Feeders with Finisher or Mailbox

<table>
<thead>
<tr>
<th>Item</th>
<th>No Optional Feeders</th>
<th>1 Optional Feeder</th>
<th>2 Optional Feeders</th>
<th>3 Optional Feeders</th>
<th>4 Optional Feeders</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuration View</td>
<td><img src="image1" alt="Diagram" /></td>
<td><img src="image2" alt="Diagram" /></td>
<td><img src="image3" alt="Diagram" /></td>
<td><img src="image4" alt="Diagram" /></td>
<td><img src="image5" alt="Diagram" /></td>
</tr>
<tr>
<td>Height</td>
<td>662 mm (26.1 in.)</td>
<td>785 mm (30.9 in.)</td>
<td>908 mm (35.8 in.)</td>
<td>1031 mm (40.6 in.)</td>
<td>1154 mm (45.5 in.)</td>
</tr>
</tbody>
</table>
Height Configurations for Optional Feeders with Casters and Finisher or Mailbox

<table>
<thead>
<tr>
<th>Item</th>
<th>No Optional Feeders</th>
<th>1 Optional Feeder</th>
<th>2 Optional Feeders</th>
<th>3 Optional Feeders</th>
<th>4 Optional Feeders</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuration View</td>
<td><img src="image1" alt="Diagram" /></td>
<td><img src="image2" alt="Diagram" /></td>
<td><img src="image3" alt="Diagram" /></td>
<td><img src="image4" alt="Diagram" /></td>
<td><img src="image5" alt="Diagram" /></td>
</tr>
<tr>
<td>Height</td>
<td>751 mm (29.6 in.)</td>
<td>874 mm (34.4 in.)</td>
<td>997 mm (39.3 in.)</td>
<td>1120 mm (44.1 in.)</td>
<td>1243 mm (49.0 in.)</td>
</tr>
</tbody>
</table>

Height Configurations for Optional Feeders with Cabinet, Casters, and Finisher or Mailbox

<table>
<thead>
<tr>
<th>Item</th>
<th>No Optional Feeders</th>
<th>1 Optional Feeder</th>
<th>2 Optional Feeders</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuration View</td>
<td><img src="image1" alt="Diagram" /></td>
<td><img src="image2" alt="Diagram" /></td>
<td><img src="image3" alt="Diagram" /></td>
</tr>
<tr>
<td>Height</td>
<td>997.6 mm (39.3 in.)</td>
<td>1120.6 mm (44.2 in.)</td>
<td>1243.6 mm (49.0 in.)</td>
</tr>
</tbody>
</table>

Height Configurations for the Optional High Capacity Feeder (HCF) with Casters and Finisher or Mailbox

<table>
<thead>
<tr>
<th>Item</th>
<th>No Optional Feeders</th>
<th>1 Optional Feeder</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuration View</td>
<td><img src="image1" alt="Diagram" /></td>
<td><img src="image2" alt="Diagram" /></td>
</tr>
<tr>
<td>Height</td>
<td>1121 mm (44.2 in.)</td>
<td>1244 mm (49.0 in.)</td>
</tr>
</tbody>
</table>
Specifications

Total Space Requirements without Options

<table>
<thead>
<tr>
<th>Dimension</th>
<th>Configurations without Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Width</td>
<td>87.0 cm (34.3 in.)</td>
</tr>
<tr>
<td>Depth</td>
<td>132.2 cm (52.0 in.)</td>
</tr>
<tr>
<td>Height</td>
<td>55.3 cm (21.8 in.)</td>
</tr>
</tbody>
</table>

Clearance Requirements

Clearance Requirements for Base Configuration

Clearance Requirements for Base Configuration with Optional Finisher
Clearance Requirements for Base Configuration with Optional 4-Bin Mailbox

Clearance Requirements for Optional 550-Sheet Feeder

Clearance Requirements for Optional Cabinet with Casters
Clearance Requirements for Optional High-Capacity Feeder with Casters
Environmental Specifications

Temperature
- Operating Temperature Range: 10–32°C (50–90°F)
- Optimal Temperature Range: 15–28°C (59–82°F)

Relative Humidity
- Operating Humidity Range: 10–85%
- Optimal Humidity Range: 20–70% relative humidity at 28°C (82°F)

Note: Under extreme environmental conditions, such as 10°C and 85% relative humidity, printing defects can occur due to condensation inside the printer.

Elevation
For optimum performance, use the printer at elevations below 3100 m (10,170 ft.).
Electrical Specifications

Power Supply Voltage and Frequency

<table>
<thead>
<tr>
<th>Power Supply Voltage</th>
<th>Frequency</th>
<th>Current Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>120 VAC +/-10% (108–132 VAC)</td>
<td>60 Hz +/-3 Hz</td>
<td>12 A</td>
</tr>
<tr>
<td>220–240 VAC +/-10% (198–264 VAC)</td>
<td>50 Hz +/-3 Hz</td>
<td>8 A</td>
</tr>
</tbody>
</table>

Power Consumption

- Power Saver Mode (Sleep): 0.7 W
- Ready: 85 W
- Continuous printing: 800 W
Performance Specifications

<table>
<thead>
<tr>
<th>Feature</th>
<th>Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Printer warm-up time</td>
<td>Power on: As fast as 52 seconds. Recovery from sleep mode: As fast as 11 seconds.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Warm-up time assumes an ambient temperature of 20°C (68°F) at 60% relative humidity.</td>
</tr>
</tbody>
</table>

Print Speed

Print speeds for continuous printing are up to 55 ppm. Print speeds are the same for color or black and white printing. Several factors affect print speed:

- Print mode: The fastest print modes are Standard and Enhanced.
- Paper size: Letter (8.5 x 11 in.) size prints slightly faster than A4 (210 x 297 mm) size. Larger sizes reduce print speeds.
- Paper type and weights: For faster printing, use paper weights of 105 g/m² or less.

The maximum print speed for 1-sided printing is 55 ppm on Letter-size paper, and 52 ppm on A4-size paper.

The maximum print speed for 2-sided printing is 52 ppm on Letter-size paper and 50 ppm on A4-size paper.

The maximum print speed for heavy paper weights is 32 ppm.
Regulatory Information

This appendix contains:

- Basic Regulations .................................................................................................................. 190
- Material Safety Data Sheets .................................................................................................. 195
Basic Regulations

Xerox has tested this printer to electromagnetic emission and immunity standards. These standards are designed to mitigate interference caused or received by this printer in a typical office environment.

United States FCC Regulations

This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to Part 15 and Part 18 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is operated in a commercial environment. This equipment generates, uses, and can radiate radio frequency energy. If the equipment is not installed and used in accordance with these instructions, it can cause harmful interference to radio communications. Operation of this equipment in a residential area is likely to cause harmful interference. Users are required to correct the interference at their own expense. If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

- Reorient or relocate the receiving antenna.
- Increase the separation between the equipment and receiver.
- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
- Consult the dealer or an experienced radio/TV technician for help.

Changes or modifications to this equipment not approved by Xerox can void the authority of the user to operate this equipment.

WARNING: To ensure compliance with Part 15 and Part 18 of the FCC rules, use shielded interface cables.

Canada

This Class A digital apparatus complies with Canadian ICES-003 and ICES-001. Cet appareil numérique de la classe A est conforme à la norme NMB-003 et NMB-001 du Canada.

Certifications in Europe

The CE mark applied to this product symbolizes a declaration of conformity by Xerox with the following applicable Directives of the European Union as of the date indicated:


Hereby, Xerox declares that the radio equipment model VersaLink C600 is in compliance with Directive 2014/53/EU. The full text of the EU declaration of conformity can be found at the following internet address: www.xerox.com/environment_europe

This printer, if used properly in accordance with the instructions, is not dangerous for the consumer or for the environment.
WARNING:

- Changes or modifications to this equipment not specifically approved by the Xerox Corporation may void the user’s authority to operate this equipment.
- External radiation from Industrial, Scientific, and Medical (ISM) equipment can interfere with the operation of this Xerox device. If external radiation from ISM equipment interferes with this device, contact your Xerox representative for assistance.
- This is a class A product. In a domestic environment, this product can cause radio frequency interference, in which case the user can be required to take adequate measures.
- To ensure compliance with European Union regulations, use shielded interface cables.

Eurasian Economic Community Certification

Russia, Belarus, and Kazakhstan are working to establish a common customs union, the Eurasian Economic Community, or EurAsEC. The Eurasian Economic Community members anticipate sharing a common regulatory scheme and common EurAsEC certification mark, the EAC Mark.

European Union Lot 4 Imaging Equipment Agreement Environmental Information

Environmental Information Providing Environmental Solutions and Reducing Cost

The following information has been developed to assist users and has been issued in relation to the European Union (EU) Energy Related Products Directive, specifically the Lot 4 study on Imaging Equipment. This requires manufacturers to improve environmental performance of in scope products and supports the EU action plan on energy efficiency.

In scope products are Household and Office equipment that meet the following criteria:

- Standard monochrome format products with a maximum speed less than 66 A4 images per minute
- Standard color format products with a maximum speed less than 51 A4 images per minute

Environmental Benefits of Duplex Printing

Most Xerox products have duplex printing, also known as 2-sided printing, capability. This enables you to print on both sides of the paper automatically, and therefore helps to reduce the use of valuable resources by reducing your paper consumption. The Lot 4 Imaging Equipment agreement requires that on models greater than or equal to 40 ppm color or greater than or equal to 45 ppm monochrome the duplex function has been auto-enabled, during the setup and driver installation. Some Xerox models below these speed bands may also be enabled with 2-sided printing settings defaulted on at the time of install. Continuing to use the duplex function will reduce the environmental impact of your work. However, should you require simplex/1-sided printing, you may change the print settings in the print driver.
Paper Types

This product can be used to print on both recycled and virgin paper, approved to an environmental stewardship scheme, which complies with EN12281 or a similar quality standard. Lighter weight paper (60 g/m²), which contains less raw material and thus saves resources per print, may be used in certain applications. We encourage you to check if this is suitable for your printing needs.

ENERGY STAR

The ENERGY STAR program is a voluntary scheme to promote the development and purchase of energy-efficient models, which help to reduce environmental impact. Details on the ENERGY STAR program and models qualified to ENERGY STAR can be found at the following website: www.energystar.gov.

The ENERGY STAR and ENERGY STAR mark are registered United States trademarks.

The ENERGY STAR Imaging Equipment Program is a team effort between United States, European Union, Japanese governments, and the office equipment industry to promote energy-efficient copiers, printers, fax, multifunction printers, personal computers, and monitors. Reducing product energy consumption helps combat smog, acid rain, and long-term changes to the climate by decreasing the emissions that result from generating electricity.

For more information on energy or other related topics, go to www.xerox.com/environment or www.xerox.com/environment_europe.

Power Consumption and Activation Time

The amount of electricity that a device consumes depends on the way the device is used. This device is designed and configured to enable you to reduce your electricity usage.

Power Saver modes are enabled on your device to reduce energy consumption. After the last print, the device transitions to Ready mode. In this mode, the device can print again immediately. If the device is not used for a specified period, the device transitions to Low Power mode, then to Sleep mode. In these modes, to enable reduced-power consumption, only essential functions remain active. The device takes longer to produce the first print after it exits the Power Saver modes than it takes to print in Ready mode. This delay is the result of the system waking up and is typical of most imaging devices on the market.

To save power, you can enable Auto Power Off mode on your device. If Auto Power Off mode is enabled, you can configure the mode as follows:

- **Always Allowed**: The device powers off automatically after the specified time, and the cumulative Low Power mode and Sleep mode timeouts have elapsed.

- **Allowed ONLY When Conditions are Met**: The device automatically powers off only after timeouts have elapsed. The device also powers off if Fax, USB Drive, and Wired and Non-Wired Network have not been activated.

To change the Power Saver settings, refer to the User Guide at www.xerox.com/office/VLC600docs. For further assistance, contact your System Administrator or refer to the System Administrator Guide.

To enable Auto Power Off mode, contact your System Administrator. For details, refer to the System Administrator Guide at www.xerox.com/office/VLC600docs.

To learn more about Xerox participation in sustainability initiatives, go to: www.xerox.com/environment.

Note: Changing the default Power Saver activation times can result in an overall higher energy consumption of the device. Before you turn off Power Saver modes or set a long activation time, consider the increase in device power consumption.
Default Power Saver Settings

This device is ENERGY STAR®-qualified under the ENERGY STAR Program Requirements for Imaging Equipment. The transition time from Ready mode to Low-Power mode can be set up to 60 minutes. The default value is 5 minutes. The transition time from Low-Power mode to Sleep mode can be set up to 60 minutes. The default value is set at 1 minute. The total transition time from Ready mode to Sleep mode can take up to 60 minutes.

To change the Power Saver settings, contact your System Administrator, or refer to the System Administrator Guide at www.xerox.com/office/VLC600docs.

EcoLogo Certified to Office Machines CCD-035

This product is certified to EcoLogo standard for office machines, meeting all requirements for reduced environmental impact. As part of achieving certification, Xerox Corporation has proven this product meets the EcoLogo criteria for energy efficiency. Certified copier, printer, multifunctional device, and fax products must also meet criteria such as reduced chemical emissions and demonstrate compatibility with recycled supplies. EcoLogo was established in 1988 to help consumers find products and services with reduced environmental impacts. EcoLogo is a voluntary, multi-attribute, and lifecycle-based environmental certification. This certification indicates that a product has undergone rigorous scientific testing, exhaustive auditing, or both, to prove its compliance with stringent, third-party, environmental performance standards.

Germany

Germany - Blue Angel

RAL, the German Institute for Quality Assurance and Labeling, has awarded this device the Blue Angel Environmental Label. This label distinguishes it as a device that satisfies Blue Angel criteria for environmental acceptability in terms of device design, manufacture, and operation. For more information, go to: www.blauer-engel.de.

Blendschutz

Das Gerät ist nicht für die Benutzung im unmittelbaren Gesichtsfeld am Bildschirmarbeitsplatz vorgesehen. Um störende Reflexionen am Bildschirmarbeitsplatz zu vermeiden, darf dieses Produkt nicht im unmittelbaren Gesichtsfeld platziert werden.

Lärmemission

Maschinenlärminformations-Verordnung 3. GPSGV: Der höchste Schalldruckpegel beträgt 70 dB(A) oder weniger gemäß EN ISO 7779.

Importeur

Xerox GmbH
Hellersbergstraße 2-4
Turkey RoHS Regulation

In compliance with Article 7 (d), we hereby certify “it is in compliance with the EEE regulation.”
“EEE yönetmeliğine uygundur.”

Regulatory Information for 2.4-GHz and 5-GHz Wireless Network Adapters

This product contains a 2.4-GHz and 5-GHz Wireless LAN radio transmitter module that complies with the requirements specified in FCC Part 15, Industry Canada RSS-210, and European Council Directive 2014/53/EU. Radio Frequency (RF) output power of this device will not exceed 20 dBm in either frequency band.
Operation of this device is subject to the following two conditions:

1. This device may not cause harmful interference, and
2. This device must accept any interference received, including interference that may cause undesired operation.

Changes or modifications to this device not specifically approved by the Xerox Corporation may void the user’s authority to operate this equipment.
Material Safety Data Sheets

For Material Safety Data information regarding your printer, go to:

- North America: www.xerox.com/msds
- European Union: www.xerox.com/environment_europe

For the Customer Support Center phone numbers, go to www.xerox.com/office/worldcontacts.
Recycling and Disposal

This appendix contains:

- All Countries.................................................................................................................. 198
- North America ..................................................................................................................... 199
- European Union .................................................................................................................. 200
- Other Countries ................................................................................................................... 202
All Countries

If you are managing the disposal of your Xerox product, please note that the printer may contain lead, mercury, perchlorate, and other materials whose disposal may be regulated due to environmental considerations. The presence of these materials is fully consistent with global regulations applicable at the time that the product was placed on the market. For recycling and disposal information, contact your local authorities. Perchlorate Material: This product may contain one or more Perchlorate-containing devices, such as batteries. Special handling may apply. For more information, go to www.dtsc.ca.gov/hazardouswaste/perchlorate.
North America

Xerox operates an equipment take-back and reuse/recycle program. Contact your Xerox representative (1-800-ASK-XEROX) to determine if this Xerox product is part of the program. For more information about Xerox environmental programs, visit www.xerox.com/environment, or for recycling and disposal information, contact your local authorities.
European Union

Some equipment may be used in both a domestic/household and a professional/business application.

Domestic/Household Environment

Application of this symbol on your equipment is confirmation that you should not dispose of the equipment in the normal household waste stream.

In accordance with European legislation, end of life electrical and electronic equipment subject to disposal must be segregated from household waste. Private households within EU member states may return used electrical and electronic equipment to designated collection facilities free of charge. Please contact your local disposal authority for information. In some member states, when you purchase new equipment, your local retailer may be required to take back your old equipment free of charge. Please ask your retailer for information.

Professional/Business Environment

Application of this symbol on your equipment is confirmation that you must dispose of this equipment in compliance with agreed national procedures.

In accordance with European legislation, end of life electrical and electronic equipment subject to disposal must be managed within agreed procedures. Prior to disposal, please contact your local reseller or Xerox representative for end of life take-back information.

Collection and Disposal of Equipment and Batteries

These symbols on the products and/or accompanying documents mean that used electrical and electronic products and batteries should not be mixed with general household waste. For proper treatment, recovery, and recycling of old products and used batteries, please take them to applicable collection points, in accordance with your national legislation and the Directive 2002/96/EC and 2006/66/EC. By disposing of these products and batteries correctly, you will help to save valuable resources and prevent any potential negative effects on human health and the environment which could otherwise arise from inappropriate waste handling. For more information about collection and recycling of old products and batteries, please contact your local municipality, your waste disposal service or the point of sale where you purchased the items. Penalties may be applicable for incorrect disposal of this waste, in accordance with national legislation.
Business Users in the European Union
If you wish to discard electrical and electronic equipment, please contact your dealer or supplier for further information.

Disposal Outside of the European Union
These symbols are only valid in the European Union. If you wish to discard these items, please contact your local authorities or dealer and ask for the correct method of disposal.

Battery Symbol Note

This wheeled bin symbol may be used in combination with a chemical symbol. This establishes compliance with the requirements set out by the Directive.

Battery Removal
Batteries should only be replaced by a manufacturer-approved service facility.
Other Countries

Please contact your local waste management authority to request disposal guidance.